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1 Contact NECS

· Please visit our website at www.necs.com to learn about our other add-on modules, products
and services. 

· Contact our NECS Sales Department at sales@necs.com for more information. 

· Contact the Tech Support Department at tech@necs.com for assistance.

· For information about current NECS software training classes use this link:
necs.com/training.php

NECS, Inc. 

322 East Main Street, Third Floor 

Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS)   Phone: 475.221.8200   Fax: 203.208.0889

  

©2010 - 2018 NECS, Inc. All Rights Reserved.

https://necs.com/index.php
mailto:sales@necs.com
mailto:tech@necs.com
https://necs.com/training.php
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2 License Agreement
NECS entrée V4 SQL and RELATED ADD-ON MODULES

SOFTWARE END USER LICENSE AGREEMENT

THIS SOFTWARE END USER LICENSE AGREEMENT (“THIS AGREEMENT”) IS A LEGAL AND BINDING
AGREEMENT BETWEEN YOUR COMPANY (LICENSEE) AND NECS, INC., A CONNECTICUT "CLASS C"
CORPORATION WITH ITS OFFICE LOCATED AT 322 EAST MAIN STREET, 3RD FLOOR, BRANFORD, CT
06405 (NECS). 

THIS AGREEMENT GIVES YOU THE RIGHT TO USE entrée V4 SQL (THE “SOFTWARE”). BY
DOWNLOADING, INSTALLING OR OTHERWISE USING THE SOFTWARE, YOU ACCEPT AND AGREE TO
BE BOUND BY ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE
TO THESE TERMS AND CONDITIONS, DO NOT DOWNLOAD, INSTALL OR OTHERWISE USE THE
SOFTWARE. 

1. Grant of License. This Agreement grants you a non-exclusive, nontransferable, non-sub licensable license
to install and use one (1) copy of the specified version of the Software to be installed on your server and
designated workstations based upon the user license count purchased. 

2. Ownership. The Software is licensed and not sold to you. This Agreement grants you only the right to use
the Software, but you do not acquire any rights, express or implied, in the Software other than those
specified in this Agreement. NECS retains all rights, title, and ownership to the Software, including all
patents, copyrights, trade secrets, and other intellectual property rights incorporated therein. The Software
is protected by copyright laws, international treaty provisions, and other intellectual property laws.
Therefore, other than as expressly set forth herein, you may not copy the Software without prior written
authorization of NECS, except that you may make one (1) copy of the Software for your back-up purposes
only. You may not edit any printed or electronic materials accompanying the Software. 

3. License Restrictions. Except as provided otherwise herein, you shall not rent, lease, sublicense, sell,
assign, loan, or otherwise transfer the Software. You shall not, and you shall not permit any third party, to
reverse engineer, decompile, or disassemble the Software. You may not remove or destroy any product
identification, copyright notices, or other proprietary markings or restrictions from the Software. You may
not modify or adapt the Software, merge the Software into another program or create derivative works based
upon the Software. You may not copy the Software onto a greater number of workstations than your
purchased user license count. 

4. Termination. This Agreement shall be effective upon installation or first use of the Software and shall
terminate (i) at the discretion of NECS, due to your failure to comply with any term of this Agreement; (ii)
failure to pay Software Maintenance fees; or (iii) upon destruction of all copies of the Software and related
materials provided to you by NECS hereunder. NECS rights and your obligations shall survive the
termination of this Agreement. 

5. Upgrades. NECS may, at its sole option, make upgrades to the Software available by general posting on a
website or by any other means or methods. Such upgrades may be made available pursuant to the terms of
this Agreement or the release of such upgrades to you may be subject to your acceptance of another
agreement. 

6. Support Services. Your license for the Software does not include any technical or other support ("Support
Services") for the Software. Support Services are provided through a separate, paid agreement known as the
"NECS Software Maintenance Agreement". Your continued use of the Software requires that you both
maintain a current Software Maintenance Agreement with NECS and that you be current on the scheduled
payments which are specified in that Agreement. Per Section 4 above, failure to comply with this
requirement can result in termination of your license to use the Software. 
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7. Limited Software Warranty. The Software, Software maintenance services and Software updates, are
provided "AS IS", without warranty of any kind, expressed or implied, including but not limited to, the
implied warranties of merchantability, or fitness for a particular purpose. NECS does not warrant that the
functions contained in this Software will be uninterrupted or error-free. The entire risk as to the quality and
performance of the Software is with the Licensee. SHOULD THE SOFTWARE PROVIDED BE DEFECTIVE,
YOU (NOT NECS) ASSUME THE ENTIRE COST OF ALL-NECESSARY SERVICING, REPAIR, OR
CORRECTION. WHILE EVERY PRECAUTION HAS BEEN TAKEN IN THE PREPARATION OF THIS
SOFTWARE, NECS ASSUMES NO RESPONSIBILITY FOR ERRORS OR OMISSIONS, OR FOR
DAMAGES RESULTING FROM ITS USE OR MISUSE. IN NO EVENT SHALL NECS BE LIABLE FOR ANY
LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE CAUSED OR ALLEGED TO HAVE BEEN
CAUSED DIRECTLY OR INDIRECTLY BY THIS SOFTWARE. IN NO EVENT WILL NECS BE LIABLE TO
YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE
EVEN IF NECS AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 

8. Notwithstanding the foregoing, NECS IS NOT LIABLE TO LICENSEE FOR ANY DAMAGES, INCLUDING
COMPENSATORY, SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES,
CONNECTED WITH OR RESULTING FROM THIS LICENSE AGREEMENT OR LICENSEE'S USE OF THIS
SOFTWARE. 

9. Licensee agrees to defend and indemnify NECS and hold NECS harmless from all claims, losses, damages,
complaints, or expenses connected with or resulting from Licensee's business operations. 

10. Refund Policy. We have a no refund policy on the Software and related software modules. We do this
because we offer free, fully functional demonstration versions which allow you to use the Software before
your decision to purchase. These demonstration versions allow you to trial test the Software risk-free. Also
our software is provided without any copy restrictions, meaning that once it is installed, NECS has no
means to ensure it is no longer being used. 

11. Governing law. This License Agreement is governed by the law of the State of Connecticut applicable to
Connecticut contracts. 

Updated September 2016

This document covers system features of entrée V4 SQL. No part of this document may be reproduced in any
form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or
information storage and retrieval systems - without the written permission of NECS, Inc. 

Please visit our website at www.necs.com to learn about our other add-on modules, products and services.
Contact our NECS Sales Department at sales@necs.com for more information. 

NECS, Inc. 322 East Main Street Third Floor Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS)   Phone: 475.221.8200   Fax: 203.208.0889

Legal Notices

https://necs.com/index.php
mailto:sales@necs.com
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Information in this document is subject to change without notice. Complying with all applicable copyright laws is the
responsibility of the end user. Without limiting the rights under copyright, no part of this document may be reproduced
without the express written consent of NECS, Inc.

NECS, Inc. may have patents, patent applications, trademarks, or copyrights covering subject matter in this document.
 Except as expressly provided in any written license agreement from NECS, the furnishing of this document does not
give you any license to these patents, trademarks, or copyrights.

©2010 - 2018 NECS, Inc. All Rights Reserved.

entrée and NECS Food Distributing System are trademarks of NECS, Inc. in the United States and/or other countries.
NECS, Inc. may have patents, patent applications, trademarks, or copyrights covering subject matter in this document.
Except as expressly provided in any written license agreement from NECS, the furnishing of this document does not
give you any license to these patents, trademarks, or copyrights. 

Microsoft, Windows, Windows NT, Windows 2000, Windows ME, Windows XP, Windows 7, Windows 8, Windows
Vista and Internet Explorer are either registered trademarks or trademarks of the Microsoft Corporation in the United
States and/or other countries.
Novell and Netware is a registered trademarks of Novell, Inc.
Intel and Pentium are registered trademarks of the Intel Corporation.
Constant Contact is a registered trademark of CONSTANT CONTACT,INC. Corporation.
Facebook images © 2011 Facebook 
Twitter images © 2011 Twitter
Google Chrome is a trademark of Google Inc.
Internet Explorer are either registered trademarks or trademarks of the Microsoft Corporation in the United States
and/or other countries.
Mozilla Firefox is a registered trademark of Mozilla Foundation.

 ©2010 - 2018 NECS, Inc. All Rights Reserved.
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3 Overview / Installation
The entrée.NET system is specialized e-commerce software running on high capacity cloud based servers to
always ensure the system is available and performing at top speed. For security and other issues, it does not
allow a user to directly access your local server. Instead entrée.NET communicates directly with the local
server in your office for such things as accessing inventory information and downloading customer orders. All
the activity such as when a user creates an order is saved on the entrée.NET cloud servers as the order is
built. So if for some reason the user looses Internet access, no data will be lost. The customer or DSR will
simply log back in and continue where they left off.

The entrée.NET system was created primarily for Internet based order entry by your customers and DSRs. It
was designed to speed the user through the order entry process while helping them identify items they should
be ordering but may have missed, locate items in your product catalog and discover your current "specials"
and other items on sale or featured. They can view extensive information about each item including extended
descriptions, images, available pack sizes, etc. Your product catalog can be viewed using "Tags" such as
Kosher, Gluten Free, Fat Free, Peanut Free, etc. Customizable reports can be generated based on up to 13
months of purchase history including exporting to Excel or PDF documents. Customers can view their
accounts receivable status, including open invoices and payments. If you use our entrée.DOC software, they
can view and print their scanned invoices showing their signature.

If you have your own domain name (ex: myfooddistributingcompany.com) and would like a modern and
professional looking site for your business, this can also be accomplished with entrée.NET. NECS can help
you create your website and give you the ability to maintain it yourself. You’ll have the ability to change
images, update the content of your “Welcome,” “About Us,” “Contact,” "Blog" and “Directions” pages. You will
be able to automatically post your inventory list and specials, from your NECS entrée software, directly to your
website, as often as you’d like.

If you currently have a website which you love, entrée.NET provides an option for a public Pop-Up Catalog
which you can easily integrate into your existing site. This will allow the public to see your product catalog
which is automatically updated from your entrée software, so there is never a need to contact a web developer
to keep your product catalog updated.

Resources 
Access our interactive search-able web-based knowledgebases using the links here.

·  entrée.NET KnowledgeBase at http://www.necs.com/net_KB/

·  entrée V4 SQL KnowledgeBase at http://www.necs.com/eV4SQL_KB/

·  entrée V3 KnowledgeBase at  http://www.necs.com/knowledgebase/

entrée.NET Guides
Included with the entrée.NET system are customized guides for the Administrator, Administrator Website
Only guide, Salesperson, User Guide (for Customers) and a guide for the Language Translator. These
guides will answer any questions you, your employees and customers may have in addition to making it easy
for you to manage your new online ordering system, catalog, and website.

The .NET guides are available as PDF files that you can download via the Help tab in entrée.NET or from the
NECS website using these instructions.
 

1.  In your browser go to www.necs.com and click the Support option to access the drop down menu.
2.  Click Customer Login and enter your username and password to access the secure area of the website.

In this area release upgrades are posted along with links to other support services and documentation.
3.  In the menu on the far left click the System Guides option.
4.  Select entrée.NET from the list displayed. 
5.  The entrée.NET Product Guides list will be displayed select the desired guide. The guides can easily be

read or printed using the free Adobe Reader download.

http://www.necs.com/net_KB/
http://www.necs.com/eV4SQL_KB/
http://www.necs.com/knowledgebase/
https://necs.com/index.php
https://get.adobe.com/reader/
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entrée Versions 3 & 4SQL
With the release of entrée version 4 SQL in 2014 and the major differences between the menus and screens
in both entrée versions 3 and 4 we have included instructions for using both versions of entrée in this guide. 

To differentiate topics for each major version of entrée you will see color coded entrée V3 or entrée V4
SQL headers in the impacted topics to direct you to the correct information for your system.

 

entrée.NET System Requirements  
· entrée.NET requires you to have installed either entrée version 3.5.1 or later or entrée version 4.0.

· You will need to upgrade to the proper version of entrée in order to utilize the data import/export utility. 

· entrée.NET works with virtually all computers which support Internet connectivity and a Web browser like
Internet Explorer, Mozilla Firefox, Apple Safari and Google Chrome.

entrée.NET Version
The About tab in your entrée.NET system provides you with the version number and information about the
modules installed with your software. NECS will also provide you with detailed version update notes in the
About tab. With each release you will know what modifications and enhancements have been made to
entrée.NET.

entrée.NET Installation Overview
You will need to make these same changes in the main entrée system whether you have entrée version 3 or
entrée V4 SQL. There are new menu paths using the ribbon menus in entrée V4.

entrée V3 entrée V4 SQL

1. Login and select System > Preferences. 

2. Then click on the System Options tab.

3. Go to the Additional Features drop down
menu on the right and click entrée.NET
options. 

4. Click the Configure button.

1. Login and go to the System ribbon menu and click
on the System Preferences option.

2. Click on the System Options tab.

3. Go to the Additional Features drop down menu on
the right and click entrée.NET options. 

4. Click the Configure button.

5.   The .NET Configuration dialog box will display.
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Next follow the instructions for the entrée version you are running for steps 6 and 7. Then continue
on with steps 8 - 10 for all versions.

entrée V3 .NET Settings
6. General section the entrée.NET Version will default to 3.x.

7. Order Import Options section options:

· Bypass prevent oversell feature when importing
orders - If you have System Option # 126 "Prevent
OVERSELL of items on Sales Orders" checked in
entrée System Preferences you may want to switch it
off for orders imported from entrée.NET by checking this
option.

· Print Loading Sheet for invoice after importing an
order - If you check this box after your orders are
imported from entrée.NET the loading sheets will be
printed automatically.

entrée V4 SQL .NET Settings
6. General section allows update of the entrée.NET Version by using the drop down menu.

7. Order Import Options 

The Order Import Options feature was
added to support these entrée system
options:

§ System Option #80 - "Prevent
OVERSELL of items".

§ System Option #126 - "Prevent
OVERSELL of items on Sales
Orders".

§ System Option #128 - "Prevent
oversell is allowed to reallocate
product". 

Order Import Options:
· Bypass prevent oversell feature when importing orders - Controls the use of systems options for

oversell on orders imported into entrée from entrée.NET. Check the box for to activate the option.

· Print Loading Sheet for invoice after importing an order - Provides the option to print Loading Sheets
when importing the orders from entrée.NET. Check the box for to activate the option.

Once this option has been enabled the Loading Sheet for invoices created from entrée.NET orders will
automatically be printed to your configured "Loading Sheet" printer as part of the order import process.

· Assign invoices to the salesperson that entered the order - This option provides the ability to control
which salesperson gets assigned to orders placed through both entrée.NET and the Electronic Order Pad.
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Activating this option will change the order entry process so that the Salesperson ID of the person entering
the order will be assigned to that order. The normal behavior of the system is to always assign the
salesperson according to the salesperson assigned to the customer in Customer File Maintenance. 

· Automatically set Wgt Shipped to Qty Ordered for LB. items - This option will set the “Weight Shipped”
value for “LB.” items to automatically be set to match the “Quantity Ordered” value during the order import
process.

8.  Check the boxes for the desired options in the entrée version you are running either V3 or V4 SQL.

9.  Click OK in the .NET Configuration dialog box.

10.  Click OK in System Preferences.
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4 Setting entrée Options
Options for entrée.NET and the Electronic Order Pad in the main entrée system are explained in the
sections that follow.

· Automatic Order Import Consolidation Feature 

· entrée Salesperson File Options

· entrée Inventory File Options

· entrée Customer File Options

· entrée System Options Additional Features

4.1 Automatic Order Import Consolidation Feature
NECS has implemented support for automatically merging orders into existing invoices within the entrée.NET
and the Electronic Order Pad order import process in entrée V4. 

 Currently this feature is only active in the order import process for entrée.NET and the Electronic
Order Pad.

Turning it on is easy!

1. The first thing you must do is enable and configure the Automatic Order Import Consolidation feature. 

§ Go to entrée > System ribbon menu > System Preferences > System Options tab > Additional
Features menu > select Order Import Consolidation > click Configure button.

§ Then follow the instructions in the entrée System Options section of this chapter.

.2. Next check and update the entrée.NET Options.

§ Go to the System ribbon menu > System Preferences > System Options tab > click Additional
Features drop down menu > select entrée.NET Options > click Configure button.

§ Then follow the instructions in the entrée System Options section of this chapter and make any
needed changes.

3. Finally update any customers that you want the order import consolidation feature disabled. 

§ Go to the Customer File > Miscellaneous Tab > Options list > Import Options. 
§ Uncheck the Allow automatic order consolidation option to turn off the feature.
§ See the entrée Customer File Options section of this chapter.

For examples of invoices using the order import consolidation feature see see the 

Feature Overview
· This feature allows the order import utility to automatically consolidate multiple orders for the same “Ship

To” Customer and Delivery Date into a single invoice for the date.

· The Automatic Order Import Consolidation feature is OFF by default.

· You must enable the feature and configure your entrée V4 settings using the Order Import Consolidation
configuration dialog accessed in System Preferences before you can use it. See the entrée System
Options section of this chapter for details.
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· The feature can be enabled, disabled, or configured differently for each order source.

· The feature may be disabled on a per-customer basis in the Customer Miscellaneous Tab in the Import
Options area. See the entrée Customer File Options section of this chapter for details.

The Invoice Selection Process
The process for selecting what invoice any new orders get consolidated into provides you with choices that are
defined in the Order Import Consolidation dialog accessed via the entrée > System Preferences > System
Options > Additional Features menu > Order Import Consolidation option. 

The first invoice that passes all of the necessary checks will be used as the target for consolidating an
incoming order. 

If no existing invoice qualifies then a new invoice will be created. Here is a brief overview of the invoice selection
process qualifications.

1. A list of existing invoices matching the “Ship To” Customer and Delivery Date from the incoming order is
compiled.

2. Each invoice is run through at least these 5 checks in the order they were created in the system:

a. If an invoice is locked by an external system (Invoicing, UPC, BFC, etc.) then it will be skipped.
b. If the invoice has been canceled it will be skipped.
c. If the invoice has already been Accepted or Rejected through the Credit Hold Queue (System Option

#169) it will be skipped.
d. Is the invoice printed? If the option to prevent editing of printed invoices is enabled then the invoice is

skipped.
e. Is a customer P.O. number present? The presence of a customer P.O. number requires special

processing rules to be applied.  * See the Handling Customer P.O. Numbers section for details.
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3.  Any additional checks that are specific to the import process may be done next. *See the Additional
Checks for entrée.NET and Electronic Order Pad section that follows.

Handling Customer P.O. Numbers
The following rules are used to best retain Customer P.O. number information when selecting an invoice:
· If a P.O. number is not provided with the incoming order then this order may be consolidated to any qualified

invoice with a ‘Verbal’ P.O. number.
· If a P.O. number is provided with the incoming order then the system may be configured in one of two ways:

§ Allow consolidation to any qualified invoice with the same P.O. number.
§ Require the system to always create a new invoice, even if one exists with the same P.O. number.

Additional Checks for entrée.NET and Electronic Order Pad
In order to ensure no user provided information is lost the entrée.NET and Electronic Order Pad will perform the
following additional checks to determine if a new invoice must be created:

· When a comment is present on the existing invoice we can only consolidate to it when there is no comment
on the incoming order or the "Print on L.S. Only" option is the same.

· When the “Order Giver” information is different we must create a new invoice.
· When we are configured to assign the invoice to the salesperson that created the order in the online system,

we can only consolidate to invoices already assigned to the salesperson for the incoming order. *See the
Related entrée.NET System Configuration Options image.

· When route information in present on the incoming order we can only merge to invoices with a matching
route.

· When route information in present on the incoming order we can only merge to invoices with a matching
route.

Rules for Merging Line Items
The consolidation process can be configured to attempt to consolidate line items from the incoming order to
lines on the existing invoice. 

The base rules which allow for merging to an existing line item are:

· Debit Items: Item number must match.
· Credit Items: Item number and return code must match.

entrée.NET and Electronic Order Pad apply the following additional checks for merging line items:

· When a price has been set for the incoming order we can only consolidate to existing lines for the item with
the same price.

· When item descriptions have been modified, we can only consolidate to existing lines with identical
descriptions for all 4 description lines.

· When a Source Line ID submitted from an external system is present we can only consolidate to existing
lines with the same Source Line ID. (This is currently only used by the City Brew Online integration for
Valley Distributing.)

· When cut instructions are different we can only consolidate to existing lines with the same cut instruction.
(Mod #862: Add a pop-up window in Create/Change Invoice used to enter / edit cutting instructions.)

· When a price change request is present, we can only consolidate to existing lines with the same price
change request information. (Mod #863: Add a pop-up window in Create/Change Invoice which allows for
entry/editing of a "requested price" value.)

Change Invoice & Revisions
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In the Change Invoice screen shown below you can see the Rev column revision letters for items that have
been consolidated.

The Rev. History grid has been updated to include the Source and Order # columns so you can see what
orders numbers were consolidated into the invoice for each revision and their source. In the example here we
expanded it so you can see the three orders with A and B revisions from the NET source and the printed
Invoice and Loading Sheet with the date and time.
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Customer Order Confirmation
Order confirmations sent to the entrée.NET server will now include the invoice revision number. If the revision
number is greater than 0 (‘A’ or later) it will be included with the invoice number in the following places:

§ entrée.NET: Pending Orders listing when logged in as the Distributor.

§ entrée.NET: Pending Orders listing when logged in as a Salesperson .

§ entrée.NET: Pending Orders listing when logged in as a Customer.

§ Electronic Order Pad: Customer's My Account tab in the Orders section.



Setting entrée Options 18

§ Electronic Order Pad: Salesperson's Home tab in the Orders section.
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Email Order Confirmations
Confirmation notice emails informing the customer that their order has been converted to an invoice will show
the invoice number with revision letter when order import consolidation has occurred.

 The customer Invoice (below) and Loading Sheets will show the invoice number with the last
revision letter appended. 

 Order Import Consolidation Rules Review

· Only invoices for the same Ship-To Customer Number and Delivery Date can be consolidated.

· For the invoice to qualify for consolidation you can only add new items or increment quantities on
existing items in the original invoice. No removals or reductions to existing line items are allowed.

· Invoices that qualify will be consolidated into the first invoice number of that day for the customer.

· Each consolidated order will be added to the original invoice with their own Revision letter group. 

· All items on the invoice will be sorted in order by item number with each order consolidation.

· The subsequent orders that get consolidated into the first invoice of the day will be "Canceled". Instead of
showing "Canceled" on the Invoice Register report it will show the revision letter following the invoice
number. See example that follows.
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4.2 entrée Salesperson File Options
entrée V3 Salesperson File Options
In the main entrée system go to Salesperson/Broker File Maintenance (SFM) and update the NET/EOP
section for your DSRs. 

· Once you find the salesperson in the system click the NET/EOP tab and update the options. The options are
explained in the entrée V4 section that follows.

· Once your options have been set click OK to save in entrée.

 In entrée version 3 the Remote Order Entry tab was renamed to DSR. These settings are for
the entrée.DSR add-on module only. 
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entrée V4 SQL Salesperson Mobile Tab
· NET/EOP section - Has the Include data for ALL salespeople and the Include data for listed

salespeople options. Both entrée.NET and the Electronic Order Pad will now include the customers for

the salespeople selected in the Mobile Tab NET/EOP section.

This NET/EOP feature allows you to include
data from an unlimited number of additional
salespeople.

 Buttons:

Green Plus Sign click and add a
salesperson. 

 Trash Can removes a salesperson.

· Include data for ALL salespeople
§ To activate the option it must be checked. This option is not checked by default.

§ When this option is checked the salesperson will receive data for all customer accounts,
regardless of who they are assigned to.

§ When checked this option will override the "Salesperson can view and place orders for all
customers" option set to “No" in entrée.NET Settings > Options > Salespeople section. 

§ When checked this option will deactivate any "Include data for listed salespeople"
assignments. 

· Include data for listed salespeople Option
§ This feature has been enhanced to allow you to link and include data from an unlimited number of

salespeople using the Salesperson Search dialog.

§ This feature will make it easy for you to setup and provide coverage of customer accounts so no
customer is ever forgotten when a salesperson is out of the office.

§ Use the Salesperson Search dialog shown here to add salespeople to the Salesperson Linking list.

· See the Scheduler/Data Export/Order Import chapter for entrée Exclude Item Option for exporting.

4.3 entrée Inventory File Options
entrée V3 Use menu path: File > Inventory File Maintenance > find the item > select the .NET Tab.

entrée V4 SQL  Go to the Inventory ribbon menu > Inventory option > find the item > select the .NET Tab.

· Exclude item from export
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NECS has built into the main entrée system the ability for you to exclude any of your inventory items from
export to your entrée.NET online ordering system. Check the box to activate this option.

· Exclude item from public website catalog
This option can be used to tailor the items listed in your public website catalog since you may not want
every item you sell to be shown.

When this option is checked that specific item will still be listed during order entry for salespeople and for
logged-in customers in entrée.NET and the Electronic Order Pad, but these items will not be listed in your
public website catalog.

· Restricted Item
Define items to be "restricted", as a general rule, from entrée.NET, so that they will not appear to the
customer when they are placing their order online, searching for items, etc.  

What makes this enhancement unique is that if the customer does have the item defined in the Customer
Special Price/Standard Order file, they will still be allowed to purchase it, and it will be displayed to them
when placing an online order. 

You can use this feature for situations such as a special order item, that you purchase for a specific
customer (or group of customers), that your normal customer base is not allowed to order. An item may be
set as restricted by checking the box for "Restricted item". 

· Allow item to be sold at $0.00
Setting this option on the item allows it to be displayed in entrée.NET and added to an order with no price.
For salespeople this will also allow them to change the price for the item to $0.00 even if a valid non-zero
price was calculated by the system.

Support for this feature is enabled by default in entrée.NET and Electronic Order Pad.

In entrée.NET option # 80 Prevent sale of items marked as 'Allow item to be sold at $0.00' option will
disable this feature globally or on a per-user basis in entrée.NET and the Electronic Order Pad.

Order Entry - 

Enable .NET Min / Max Quantity Warning
For your customers placing online orders with entrée.NET, you can now define a "minimum" and "maximum"
item quantity that they are allowed to order. This feature will allow you to enforce minimum order quantities for
specific items and maximum order quantities.

For specific items the minimum and maximum quantity numbers must be defined in entrée by following these
steps.
1. Find the item in the Inventory file.



entrée.NET Administrator's System Guide23

2. Click the .NET tab.

3. Enter the Min Qty and Max Qty values.

4. Next you must enable the min/max feature in entrée.NET and the related system option # 37 Display
min/max quantity warnings. 

Item Tags
The "Item Tags" feature provides an alternative method for grouping items in the entrée.NET system which is
independent of their "Class" values. This feature could be used to identify all Kosher or Gluten-free items
regardless of how they are normally classified in entrée itself. Any item may have multiple tags associated
with it.

Item Tags are assigned to items using the Item Tags search feature pictured above. The tags list works similar
to "Class" where defining a new tag will automatically add it to the list of available tags used in the search.

Click the search icon  then click on an item tag in the list to select it > click OK.

· In the entrée.NET Options General section the # 30 Display item “Tags" option must be set to Yes to
view item tags.

Creating New Item Tags
entrée V3 Use menu path: File > Item Tag Maintenance > List Management dialog box will display.

entrée V4 SQL  Go to the Add-Ons ribbon menu and select the entrée.NET tab Item Tags option. 

4.4 entrée Customer File Options
entrée V3 Use menu path: File > Customer File Maintenance > find the customer > select the
Miscellaneous 1 Tab > Miscellaneous Options list.

entrée V4 SQL  
Go to the Inventory ribbon menu > Inventory option > find the
item > select the Miscellaneous Tab > Invoicing Options list.

Export Options
entrée.NET When you check this option on a customer account
the customer's scanned invoices will be exported to the
entrée.NET server and will appear in the customer file in
entrée.NET or in the Electronic Order Pad.

Import Options
Allow automatic order consolidation - Used for consolidation
of entrée.NET or in the Electronic Order Pad orders when
imported.

The Automatic Order Import Consolidation feature may be
disabled / enabled on a per-customer basis here in the
Customer Miscellaneous Tab. 

· Be sure to click Apply to save the changes.

entrée V3 Exclude from .NET Export
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When you check this option on a customer account the customer's data will not be exported to the
entrée.NET server and will not appear in the customer file in entrée.NET or in the Electronic Order Pad. 

4.5 entrée System Options
There are system options that can be set in the main entrée system that will impact how entrée.NET and
EOP work. These options are listed below.

System Options
· System Option #171 - Use Landed Cost for GP Calculations in Invoicing. This option is automatically

set and maintained based on the system option setting in entrée. 

When this option is checked the calculation of Gross Profit in Invoicing will change to be based off of Landed
Cost rather than Base Cost. This option has been expanded so that it also controls the calculation of the
"Margin %" column on the "Cost/Price" tab of entrée Inventory File Maintenance.

· System Option #180 - Invoicing deducts billback amount when calculating Gross Profit features
introduced in the entrée.NET and the Electronic Order Pad Version 3.4.1.

Support for this option is provided to ensure the correct representation of GP information when viewing
printed invoice information from any of the sales reporting features in the Electronic Order Pad - it has not
been integrated into the GP estimation calculation when placing orders. This option is automatically set and
maintained based on the entrée system options settings. 
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System Options Additional Features
entrée V3 Use menu path: System > System Preferences > System Options tab > click Additional
Features drop down menu > select entrée.NET Options > click Configure button.

entrée V4 SQL Go to the System ribbon menu > System Preferences > System Options tab > click
Additional Features drop down menu > select entrée.NET Options > click Configure button.

.NET Configuration Options

General:
For entrée.NET users you now
have the ability to update the
entrée.NET version number by
clicking on the drop down list when
it is activated.

· Order Import Options support these entrée system options:
§ System Option #80 - "Prevent OVERSELL of items".
§ System Option #126 - "Prevent OVERSELL of items on Sales Orders".
§ System Option #128 - "Prevent oversell is allowed to reallocate product". 

· Bypass prevent oversell feature when importing orders
Controls the use of systems options for oversell on orders imported into entrée from entrée.NET. Check the
box for to activate the option.

 
· Print Loading Sheet for invoice after importing an order  

Provides the option to print Loading Sheets when importing the orders from entrée.NET. Check the box for
to activate the option. Once this option has been enabled the Loading Sheet for invoices created from
entrée.NET orders will automatically be printed to your configured "Loading Sheet" printer as part of the
order import process.

§ Only print Add-On Items when an order has been merged to an existing invoice: This new option
helps control when Loading Sheets are printed for merged orders and whether Add-On Items print.

  The printing process was revised to ensure that only one Loading Sheet is printed per-invoice
during an import batch. This way if the initial invoice and all of the associated revisions are imported in one shot
it will only print one copy of the Loading Sheet.

· Assign invoices to the salesperson that entered the order
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This option provides the ability to control which salesperson gets assigned to orders placed through both
entrée.NET and the Electronic Order Pad.

Activating this option will change the order entry process so that the Salesperson ID of the person entering
the order will be assigned to that order. The normal behavior of the system is to always assign the
salesperson according to the salesperson assigned to the customer in entrée Customer File Maintenance.

· Automatically set Wgt Shipped to Qty Ordered for LB. items  
This option will set the “Weight Shipped” value for “LB.” items to automatically be set to match the “Quantity
Ordered” value during the order import process.

· Immediately export changes to invoices after a print or cancel operation
This new “Sales Update” mode only transfers pending invoice changes. It allows the new export to run
automatically any time an invoice has been printed or canceled. This mode does not require a lock on the
export process to permits it to run while other exports are in process.

Order Import Consolidation
entrée V4 SQL Go to the System ribbon menu > System Preferences > System Options tab > click
Additional Features drop down menu > select Order Import Consolidation > click Configure button.

The Order Import Consolidation Settings dialog will open. Here you will configure how the order import
consolidation will function in your system. 

1. Enable automatic merging of orders to existing invoices: Check this option to turn on the Order Import
Consolidation feature in selected import utility for entrée. 

2. Now select the import utility you want to use with the consolidation features. 

Select import utility to configure: 

§ entrée.NET
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§ Electronic Order Pad

§ Default options for All imports. (only entrée.NET and the Electronic Order Pad app at this time)

· Next you have to make some decisions about how you want order import consolidation to work.

3. Allow merging to printed invoices: Check this option to override the system default and merge a new
invoice with a printed invoice. Once enabled the system can modify an invoice that has already been printed.
The system default has the invoice left in an unprinted state. 

 For printed invoices the default is NO order import consolidation unless this override option
is checked. 

4. When Customer P.O. Number is present: To control how orders with customer provided P.O. numbers
will be handled you have two options.

§ Merge to matching invoice: Consolidate orders for the same customer, delivery date, and customer
provided P.O. number. Any customer invoice WITHOUT a P.O. Number merges by Delivery Date. 

§ Always create a new invoice: Will create a new invoice for any order with a customer provided P.O.
number even if the same P.O. number has been submitted with another order for the same customer
and delivery date.

5. When Merging Items: you have two options for controlling how items from the incoming order are added to
the existing invoice. 

§ Always Create a New Line Item: Will always create a new line item for each line item of the incoming
order, even if another entry for the item with the same price is already on the invoice.

§ Consolidate to Existing Line Item: Checks for a line item with the same item number and price on the
existing invoice. If one is found the quantity from the incoming order for that item will be added to the
existing line item.

6. If you select the Consolidate to Existing Line Item option you will have to make a selection for the When
matched item has user assigned prices option. These options allow you to control line item price
conflicts. It only applies if a price has been manually set in either entrée or the entrée.NET or Electronic
Order Pad remote systems. 

§ Create new line item to keep both prices: Will not merge line items and will instead create a new
line entry to keep the pricing separated. Will result in two entries for the same item with different prices
on one invoice.

§ Merge and use the current invoice price: Will add the quantity from the incoming order to the
matched line item entry on the invoice. It will ignore the incoming price and keep the currently set price
on the invoice.

 
§ Merge and use the incoming order price: Will add the quantity from the incoming order to the

matched line entry and replace the current price with the new price from the incoming order.

7. When Merging Credit Items: If your entrée system is setup to allow credit items to be entered on invoices
an additional option for controlling how credit items from the incoming order are added to the existing invoice
can be controlled by these two options.
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§ Consolidate to Existing Line Item: Will check for a credit line item with the same item number price,
and return code on the existing invoice. If one is found the quantity from the incoming order for that item
will be added to the existing line item.

§ Always Create a New Line Item: Always creates a new line item entry each line item of the incoming
order.

8. Be sure to click Apply then OK to save your settings.



Chapter 5
entrée.NET Settings
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5 entrée.NET Settings
The first task for the System Administrator is to update the Settings tab in entrée.NET for your company.
Sign in to your entrée.NET system and click on the Settings menu tab to proceed with customizing your
system.

The Settings tab has buttons which run along the left side of the screen for these features: General, Options,
Ads, Grids, Email and EOP (Electronic Order Pad). Each of these features will be described in this chapter.
The system options for entrée.NET are displayed in collapsed lists in the image below and are described in
the Options section of this chapter.

 General Settings
Account
Distributors have the ability to change their entrée.NET login password in the Settings tab. 

1. In New Password field type your new password.
2. Click Save Settings.

 Changing your password will require you to do the following before you can import
orders again. 

3.  Login to entrée and run the entree.NET Export Utility. 
4.  Then login to entrée.NET with your new password. 
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Email Notifications
You will need to enter email addresses in 2 boxes. The first box is used to receive entrée.NET order and
systems notifications and in the second box specify your “From” email addresses. You may provide multiple
email addresses for both entries by separating them with a semicolon.

1. Type your email addresses in the Order and System Notification box. 
2. Type your email addresses in the “From” address box. 

3.   Use only a
semicolon between
each email address.

4.   Click the Save
Settings button
above before
continuing your
updates.
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Website Address Settings
Enter the URL website
address to redirect
customers to when they
sign out of entrée.NET. 

This setting is intended for distributors who have a website that is not part of their entrée.NET plan and would
prefer to redirect customers to the website instead of returning them to the entrée.NET login page.

Company Logo
Your company logo will be displayed on all the pages in your entrée.NET system,in your website sign-in page
or your order entry login page and on the Electronic Order Pad sign-in screen. Acceptable image file formats
are JPEG, GIF and PNG. Any size file will be accepted as it will automatically be scaled down to fit.

1. Click the Browse button and locate your logo image file on your computer. 
2. Click on the logo file name in the File Upload window then click Open.

3.   The file will appear in the image box
then click the Upload Logo button.

4.   Your logo will now appear in the
company logo section and in the top
left corner of your entrée.NET page.

5.   Click the Save Settings button.

Theme 
Change your color theme for entrée.NET whenever you like. Just select a color from the Theme drop down list.
Choose from the colors shown below starting from the top row left side; aqua, blue, cream, gray, lavender,
lime, mint, peach, pink, purple and red.

1. Click the down arrow to make a selection from homepage style drop down menu. 

2. Click Save Settings button above. 
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Homepage  
If you purchased the website with all entrée.NET features, you will need to make a selection to control what
your customers see when they visit your entrée.NET system. 

1. Click the down arrow to make a selection from homepage style drop down menu. 

2. Click on either Show the order entry login page or Show my website.  

 The Order Entry Login page and the full website home page with the Customer login area on
the right.

   

Timezone  
Update your Time Zone by selecting
it from the drop down list. 
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5.1 Options

 Options Settings   
The options have assigned numbers to provide a clear way to communicate about the many options available.
The next step requires you to set the system options for entrée.NET. These are similar to the system options
in the main entrée system. 

1. Click on the Options icon in the menu on the left.

2. Option Description and Current Setting columns are displayed for each option.

3. Note that the bottom of the section will display a full explanation of how the selected option will operate.

4. Click in the Current Setting column to select the new setting from the drop down list. 

5. Option changes will update immediately.

 Use the minus  or plus sign  icons next to the section headings to expand or

collapse the lists. 

Configuration – Allows you to let customers control their own page layout.

· #1000 Can change “Standard Order” grid layout. Turning this option on allows the customer to modify
the column visibility and layout of the "Standard Order" grid.

· #1001 Can change “Search” grid layout. Turning this option on allows the customer to modify the column
visibility and layout of the "Standard Order" grid.

· #1002 Can change “Quick Entry” grid layout. Turning this option on allows the customer to modify the
column visibility and layout of the "Quick Entry" grid.

Electronic Order Pad 

EOP is our mobile application based off entrée.NET. It was created primarily as an order entry tool for your
DSRs. All possible options are not displayed in the image above. For more information about this product visit:
https://www.necs.com/orderpad.

· #50 Enable barcode scanning input in "Quick Entry". Setting this option to "YES" will enable UPC
barcode scanning support in "Quick Entry"tab of EOP. This allows for UPC barcodes to be entered into the
"Scanner Input" text field using a HID compatible scanner. This will option will also match against secondary
UPC numbers, if defined in entrée Inventory File maintenance.

· #51 Enable "continuous scanning" for entering quantities in "Quick Entry". Setting this option to
"YES" will allow for quantities to be entered through the barcode scanning feature. When enabled items will
be added to the order with an order quantity of 1 and each additional scan will increment the quantity until a
new item is scanned or manually entered. This feature only applies when first adding an item through "Quick

http://www.necs.com/orderpad
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Entry", changes to an item previously entered must still be done manually. This option also requires that
Enable barcode scanning input in "Quick Entry" to be enabled.

· #52 GP Review - Minimum Gross Profit %. Items with a Gross Profit percentage lower than this value will
be displayed in red on the "GP Review" tab.

· #53 GP Review - Target Gross Profit %. Items with a Gross Profit percentage lower than this value will be
displayed in yellow on the "GP Review" tab.

· #54 Allow Salesperson to enter route information. Setting this option to "Yes" will allow the salesperson
to enter route information to be assigned to the entrée invoice when completing an order.

· #58 Allow Salesperson to edit Description Lines 1 - 4. Setting this option to "Yes" will allow the
salesperson to edit item description lines 1 - 4. When they click on the item description the description edit
dialog will display. Then they can modify any of the four description lines to be displayed on the invoice and
loading sheet (requires entrée 3.6.6).

· #63 Allow Salesperson to email reports - Setting this option to "Yes" will allow the salesperson to email a
PDF or Excel copy of a report.

· #68 Enable "Special Order" guide in Standard Order. Setting this option to "Yes" will add a "Special

Order" guide to the guide drop down menu on the Standard Order tab in EOP.  This new guide will only

display items marked as "Special Order Item" on the "Misc 1" tab of Inventory File Maintenance in entrée

that are already in the customer's standard order.

· #69 Default the quantity ordered to 1 when entering items in Quick Entry. Setting this option to "Yes"
will automatically add items to the order with a quantity of 1 for items entered through the Quick Entry
option.

· #71 Allow Salesperson to View Contact Manager Contact Information. Setting this option to "No" will
remove the Contacts option from the main menu in the Electronic Order Pad. This means the Contact
Manager’s information can not be accessed from the EOP application. 

The default setting for this option is “Yes” so unless you change the setting it will allow access to the
information about the contact person for each customer. The customer name will appear at the top center of
the Contact Information screen.
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· #74 Display Price Change Indicator. Setting this option to "Yes" will display a green down or red up
arrow in front of the unit price if the current unit price is less than or greater than the last sale price to that
customer in the Electronic Order Pad application. If no last sale price is available the price is treated as
equal and no change indicator will be shown.

· #76 Allow Salesperson to Enter Credits on Orders. Setting this option to "Yes" adds a Credits Tab to the
Order Entry section of the Electronic Order Pad app (see the Credits Tab chapter for details) which allows for
the entry of credit items to be included on the invoice when the order is imported into the main entrée
system.

 
· #77 Allow Salesperson to Create Credit Memos. Setting this option to "Yes" will add the Create Credit

Memo option to the main menu of the Electronic Order Pad app (see the Create Credit Memo chapter for
details) which provides a trimmed down version of the current order entry process that only  allows for the
entry of credit items.

The creation, completion, importing, and confirmation of Credit Memos follows the same work flow as orders
except the document generated in entrée will be a Credit Memo rather than an Invoice.

Several existing rules that apply to orders have been adjusted for Credit Memos to more closely match the
rules used by entree as follows:

§ No the delivery date restrictions are applied to the selection of a Credit Memo Date. The only
requirement enforced is that the date is not in the past.

§ Credit Memos may be created for customers on credit hold.

· #78 Display “True” Inventory On Hand Information. Setting this option to "Yes" enables the "OH Qty"
field in the Item Information Panel of the Electronic Order Pad app. It displays both the current On Hand
quantity as well as the True On Hand quantity which is calculated as On Hand + Allocations. 

 Remember to access the Information Panel configuration feature to add the OH Qty field to the
Item Information Panel display.
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· #90 Allow Salesperson to create and edit customer special pricing. Once enabled a new button with a
green price tag icon will be displayed on the left side of the Item Information panel during order entry. Tap
this button to display the current pricing information for the customer for editing, if no pricing is currently
defined the salesperson will be prompted if they would like to create an entry. NOTE: Price changes are
applied to the Ship To location that is being edited.

· #91 Allow Salesperson to edit customer Bid 1 and Bid 2 pricing. Once enabled a new button with a
green price tag icon will be displayed on the left side of the Item Information panel during order entry. Tap
this button to display the current pricing information for the customer for editing, if no pricing is currently
defined the salesperson will be prompted if they would like to create an entry. NOTE: Price changes are
applied to the Ship To location that is being edited.

· #93 Default Price Level for catalog. Allows you to set the price level used for price calculations when
browsing the Catalog from the main menu. Previously the catalog was locked in at price level 1.

· #108 Display Inventory on hand in the Electronic Order Pad. Used to control display of this information.
 Setting this option to "YES" will enable the display of on hand inventory amounts in Electronic Order Pad
(EOP).

· #111 Allow promotions to be edited. This option controls the overall ability for salespeople to edit the
promotion amount passed on to the customer.

· #112 Editable promotions will default to 0. Setting this option to "Yes" will default the editable
promotions to $0.00, instead of to the full promotion amount.

· #113 Allow salesperson to edit promotion amount. This option controls the ability for individual
salespeople. Setting this option to "Yes" enables the ability for salespeople to edit the promotion amount
passed on to the customer.

· #114 Enable offline support during Order Entry. Setting this option to "Yes" will enable support for
switching to a limited order entry mode if network connectivity is lost during Order Entry. Offline support is
only available during Order Entry and requires that an order has already been started. Orders cannot be
started without network connectivity.

· #116 Allow salesperson to access the Customer Falloff feature. Setting this option to "Yes" will allow
the salesperson to access the "Customer Falloff" feature.

· #120 Allow Salesperson to access the Edit Special Pricing feature. Once enabled a new "Special

Pricing" menu option will be available on the main menu in . Then a salesperson may add or remove items

and editing pricing based on the settings of System Option #90 Allow salesperson to create and edit
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customer special pricing and System Option #91 Allow salesperson to edit customer Bid 1 and Bid 2

pricing, (listed above). 

· #123 Allow salespeople to change the originating warehouse for an order. Setting this option to

"Yes" will allow the salesperson to change the originating warehouse for an order. (Requires entrée v4.0.35

or later and the entrée.MW add-on module).

· #124 Allow salesperson to change the shipping warehouse for items. Setting this option to "Yes" will

allow the salesperson to change the shipping warehouse individually for items on the order. (Requires entrée

v4.0.35 or later and the entrée.MW add-on module).

· #125 Block completion of orders when items are not present in the shipping warehouse. Setting this

option to "Yes" will prevent the salesperson from completing orders that contain items that are not setup in

the shipping warehouse assigned to the order. (Requires entrée v4.0.35 or later and the entrée.MW add-on

module).

· #126 Lock items to the active shipping warehouse when added to the order. Normally when the

shipping warehouse is changed for an order all items are updated to ship from the newly selected

warehouse. Setting this option to "Yes" will lock the shipping warehouse for the item to the warehouse that

is selected when the item is added to the order. (Requires entrée v4.0.35 or later and the entrée.MW add-

on module).

· #129 Default customer listing sort column. Allows you to specify the default sort order for customer

listings. Select from: Cust #, Company, City/State, SP# or Last Sale.

· #130 Replace Class tab with a Category. Setting this option to "Yes" the current Class tab will be

replaced with a Category tab. Tapping on a Category from this list will then display a list of Classes from

items in the selected Category. Tapping on a Class will then display all items within that Category and

Class.

General 
· #11 Display Item images. Turning this option off will prevent the display of item images.

· #12 Display A/R information. Turning this option off will hide all A/R panels and reports.

· #13 Display .DOC scanned invoices. When this option is enabled any available entrée.DOC scanned
invoices will be available for viewing.

· #15 Display inventory “On Hand” numbers. Turning this option on will allow for the display of item "On
Hand" values. This will add a "Qty Avail." field to option to the grids.

· #16 Display item “Brand”. Turning this option off will prevent the item "Brand" information from being
displayed in the catalog.

· #17 Display item “Weblink”. Turning this option off will prevent the item "WebLink" information from being
displayed.

· #19 Enforce Credit Hold. When this option is enabled entrée.NET will enforce the credit hold setting from
entree and will prevent new orders from being placed.

· #27 Display Class images. Turning this option off will prevent the display of class images.

· #30 Display item “Tags”. When this option is enabled item tags defined in entrée will be listed in the
"View" drop down on the "Catalog" page. See the Inventory File Maintenance chapter .NET Tab section of
the entrée System Guide or the entrée Knowledgebase for more information about creating Item Tags.

· #59 Display Brand images. Setting this option to "Yes" will allow the Catalog to display brand images. 
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 Prior to turning this option on the Brand Maintenance utility in the main entrée system must be
used to build and load the brand name and image file (requires entrée 3.6.6). Then the brand name and image
file must be exported to entrée.NET using the Data Export Utility. 

· #73 Allow Registration Request on Login Page. Set this option to "Yes" to display the "Register" button
in the  website Home page Customer Login area. The default setting for this option is “No”. 

The Register button will allow customers to access this
online registration form to request an entrée.NET
account.

 This feature does not  automatically create a
user account for the customer to login. You must manually
approve and setup any new customer accounts.

See the Website Settings chapter for more information.

· #87 Disable Reporting. Setting this option to "Yes" will disable and hide all reporting features.

· #99 Use HTML formatting in order notification emails. When this option is set to "Yes" order notification
emails will contain an HTML formatted copy of the order similar in layout to the PDF generated when printing
an order. When set to "No" order information will be formatted using plain text.

· #110 Order confirmation item sort configuration. This option allows you to specifying the sort columns
and order for printed orders and order confirmations. Below you see the default settings on the left. On the
right you see the drop down menu to select the columns to sort by. 
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Then choose Ascending or Descending order. 

Click the X in the Action column for a column to
remove it.

Click Save to set your preferences.

· #114 Enable offline support during Order Entry. This feature provides your salespeople with the ability to
continue placing an order when their network connection is lost by Electronic Order Pad. By default System
Option #114 is set to Yes. If you do not want Offline Mode enabled for your salespeople you must change
the setting of this option to No here in entrée.NET. 

 EOP Offline Order Entry Mode Limitations
· Salespeople can only modify the current order.
· Only items in the customer's Standard Order or Order Guide are available in offline mode.
· Orders cannot be completed in offline mode.

* See the Electronic Order Pad System Guide Offline Order Entry Mode Overview chapter for details.

· #118 Allow customer to edit Account Settings. Setting this option to "No" will prevent the customer from
editing their account settings. This controls access to the "Account Settings" includes the ability to change the
accounts password, confirmation email address, timezone and other various account level options.

· #119 Allow viewing and editing of Order Guides. Setting this option to "No" will prevent the user from
viewing or editing Order Guides.

Order Entry – These options control order entry rules and displays.

· #1 Display price information. Setting this option to "No" will not display any price information. When this
option is set to "NO" the "Min order amount" and "Max order amount" options will NOT be enforced.

· #2 Allow decimals in order quantities. This option requires System Option #15 "Allow decimals in
invoices" to be enabled in entrée. Please refer to the description in entrée for more detailed
information. Turning this option on will allow decimals to be used in order quantities. (Ex: 0.5, 1.0, 1.5,
2.25).

· #3 Display item last purchase information. Turning this option on will make "Last Qty", "Last Price" and
"Last Purchase Date" information available. "Last Price" will not be shown if "Display price
information" is set to "NO".

· #4 Can order any product. The option has been updated to provide a mode which allows for viewing all
items in the distributors catalog but only ordering items from the customers Standard Order. 

There are 3 new choices for the "Can order any product" option:
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1. "Yes" - This setting will display and allow for ordering of all items in the distributors catalog that are not
otherwise excluded due to item restrictions such as the "Restricted" or "Approved" item options.

2. "Restrict to Standard Order". This setting retains the previous behavior when the option was set to
"No". Only items that are present on the customer Standard Order will be displayed and allowed to be
ordered.

3. "Restrict To Standard Order (View All)". This setting will display all items in the distributors catalog
that are not otherwise excluded due to item restrictions such as the "Restricted" or "Approved" item
options when browsing the "Catalog" section. Customers and salespeople will only be allowed to order
items present on the customers Standard Order from the "Standard Order" and "Quick Entry" sections.
Additionally all pricing will be hidden in the "Catalog" section regardless of the "Show prices" system
option setting.

· #5 Max order days. This option sets the number of days in the future a customer is allowed to place an
order for. As an example setting this option to "7" will only allow the customer to request a delivery date up
to 7 days out from the date the order is placed. Setting a value of "0" disables this feature. When the
"Restrict delivery dates to customer route information" option is on only dates which fall within the
"Max order days" window will be available.

· #6 Order cutoff time. The "Order cutoff time" sets the time orders must be placed before to be eligible for
next day or same day delivery. As an example, assuming no route restrictions are in effect, a customer
placing an order on Monday with an "Order cutoff time" set to 4:00 PM will need to place their order before
4:00 PM for the system to allow them to select Tuesday as a requested delivery date. In this same example
if the "Order cutoff time applies to day of delivery" option is on the customer would be allowed to select
Monday as a requested delivery date for orders placed before 4:00 PM.

· #7 Order cutoff time applies to day of delivery. Turning this option on will have the "Order cutoff time"
apply for the day of delivery. As an example, with no route restrictions are in effect, if the "Order cutoff time"
is set to "10:00 AM" then customers will then be allowed to select the current day as a requested delivery
date when placing an order before 10:00 AM.

· # 8 Min order amount. This option sets the minimum dollar amount total an order must meet to be
completed and transmitted for completion. Setting a value of "0" disables this feature. This feature has
no effect when "Display price information" is turned off.

· # 9 Max order amount. This option sets the maximum dollar amount total allowed for an order to be
completed and transmitted for completion. Setting a value of "0" disables this feature. This feature has
no effect when "Display price information" is turned off.

· #10 Restrict delivery dates to customer route information. This option has been changed from a "Yes" /
"No" to allow for applying delivery date restrictions to: "No", "Customers Only", "Salespeople Only" or
"Customers and Salespeople". This allows you to have complete control over how the delivery date
restrictions are applied. It will prevent the Customers and / or Salespeople from selecting a requested
delivery date that does not fall on a route day as defined on the "Routes" tab of "Customer File
Maintenance" in entrée. If no route information or a "Standard" route has been defined in entrée this feature
will have no effect for the customer.
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 The Delivery Date Rule options are also supported in the Electronic Order Pad as of version
3.3.7. The chart below provides a simple overview of the Delivery Date Rules options. 

DELIVERY DATE RULE DESCRIPTION SETTINGS OPTIONS

Max Order Days. Sets the number of days from the
order date that the delivery date must
fall within.

a. Enter a number value.
b. Enter zero to disable rule. 

Max Order Days
enforcement. 

Sets the order entry system
response when the delivery date is
beyond Max Order Days number.

a. Allow for next Delivery Date.
b. Prevent Completion.
c. Block Order Entry.

Order Cutoff Time Sets the daily cutoff time for orders
to be delivered the next day.

Select a time from the drop down
list.

Order Cutoff Time Applies
to Day of Delivery. 

Sets the order cutoff time to apply to
the day of delivery.

Yes / No

Restrict Delivery Dates to
Customer Route
Information. 

Enforces the customer’s defined
route delivery days from the
Customer file Route tab. 

a. No 
b. Customers Only.
c. Salespeople Only.
d. Customers and Salespeople.

· #20 Prompt for “Special Instructions”. Turning this option on will add a text entry box below the
description line for customers to enter special instructions on a per-item basis. This will appear in the items
"Description Line 2" on the invoice.

· #21 Allow customer to specify delivery date. Turning this option off will not allow the customer to set a
delivery date.

 If "Show prices" is enabled the displayed prices will be calculated using the next delivery date
determined by the system.

· #22 Show Item description line 2. Turning this option on will display an items second line of description in
the order entry grid and allow the column on reports.

· #23 Show Item description line 3. Turning this option on will display an items third line of description in
the order entry grid and allow the column on reports.

· #24 Show Item description line 4. Turning this option on will display an items fourth line of description in
the order entry grid and allow the column on reports.

· #36 Standard Order” item grouping method. This option controls how items are grouped in the
"Standard Order" grid. Selecting "None" will turn off all grouping. Selecting "Class"  (default) will group items
by class.
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· #37 Display min/max quantity warnings. Setting this option to "YES" will display a warning message
when ordering quantities above or below the specified values. This feature serves as a warning only and
does not prevent an order from being completed by the customer or salesperson. These entrée
updates are required for the "Display min/max quantity warnings" Order Entry option: The minimum
and maximum quantity numbers must be defined in the main entrée system for the item or customer.
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Defining minimum and maximum for Items in entrée 
entrée V3
1. Go to File > Inventory File Maintenance > find the desired item.

2.  Select the ".NET" tab.

3.  In the Order Entry section
and set your Min Qty and
Max Qty quantities.

4.  Then click Apply.

entrée V4 SQL
1. Go to the Inventory ribbon menu > click the Inventory option > find the desired item.

2. Select the .NET Tab.

3. In the Order Entry section and set your Min Qty and Max Qty quantities.

4. Then click Apply.

Defining minimum and maximum for Customers in entrée
entrée V3
1. Go to File > Customer File Maintenance > Special Pricing Tab.

2. Select the desired item’s special price in the Special Price Information section.

3. Click the   "Edit
miscellaneous ..." button.
The Edit Special Prices
Miscellaneous Parameters
dialog will display. 

4. In the .NET section check
“Enable min/max override” and
enter the Min Qty and Max
Qty quantities.

5.  Then click Apply.

entrée V4 SQL
1. Go to the Customer ribbon menu > click the Customer option > find the desired customer.

2. Select the Special Pricing Tab.

3. Select the desired item’s special price in the Special Price item grid. 

4. Click the Miscellaneous button and the Edit Special Price Miscellaneous Parameters dialog opens.

5. In the .NET section check the Enable min/max override option.

6. Now set your Min Qty and Max Qty quantities.

7. Then click Apply.
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· #39 Show "Case Count" in order entry. Setting this option to
"YES will display "Total Cases:”  with a quantity representing
the sum of quantities entered for an order below the "Estimated
Total" field in the shopping cart. 

 
· #47 Show DOT special order items. Setting this option to "NO" will prevent DOT special order items from

being displayed. (NOTE: This requires the entrée.DOT module.)

· #48 Show DOT drop ship items. Setting this option to "NO" will prevent DOT drop ship items from being
displayed. (NOTE: This requires the entrée.DOT module.)

If you have the entrée.DOT module setting the two DOT options above to "YES" will enable the display of
DOT items in the catalog with row color coding. The orange background color for "Special Order" items and
a brown background color for "Drop Ship" items. This feature is only available for salespeople and will not be
applied to the catalog for customers (see image below). 

 All items purchased from Dot Foods can flow into entrée.NET to provide you with even more
selling opportunities. These options has been added to support entrée.DOT "Special Order" and "Drop
Ship" items. 
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· #49 Display warning for missing order quantity items. Setting this option to "YES" will display a dialog
during the complete order process showing all items with a minimum order quantity defined that are not on
the current order. This is a notification only and does not prevent the order from being completed.

· #55 Enable "Date Filtered Standard Order". Setting this option to "YES" will enable the "Date Filtered
Standard Order" feature. This feature allows DSRs and customers to view a copy of their "Standard Order"
showing only items that have been recently purchased. This guide can be set as their default guide and is
available in the Guide drop down menu (as seen in the image below in a salesperson's entrée.NET
account. 

The number of weeks shown can is set in the "Account Settings" section of Home page after the
salesperson or customer signs into the system. They can choose time spans from 2 to 12 weeks in one
week increments. 

· #60 Min order weight. This option sets the minimum weight
restriction on customer orders. Setting a value of "0" disables this
feature. The customer will be prevented from completing an order if
the estimated order weight is below the minimum amount. A
message will be displayed the yellow message area of the shopping
cart (image on right).

· #61 Max order weight. This option sets the maximum dollar amount total allowed for an order to be
completed and transmitted for completion. Setting a value of "0" disables this feature. The customer will
be prevented from completing an order if the estimated order weight is above the maximum amount. A
message will be displayed the yellow message area of the shopping cart.

For the Min/Max Weight feature to work correctly non-catchweight items must have a constant
weight defined in entrée. The total weight for the order is estimated using the constant weight or the average
weight for catchweight items.

· #64 Display Manufacturer Item # beneath Item description. When set to "Yes" it will display the
manufacturer item number, if defined for an item in Inventory Maintenance in the main entrée system, below
description line 1 in your Catalog (requires entrée version 3.6.7 or later or entrée V4). For information about
Manufacturer Item # please consult the entrée Knowledgebase for your system in our website. 
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· #65 Max order days enforcement. This option allows you to control how access to the creation and
completion of orders is handled when the customers next scheduled delivery date exceeds the "Max order
days" setting above it in the options list. Previously when this condition occurred the system would allow for
entry of an order only on the next scheduled delivery date. 

You now have three choices for the Max order days enforcement option:

1. "Allow for next Delivery Date" - This setting keeps the current behavior the same and allows for entry
of orders but only on the next scheduled delivery date.

 2. "Prevent Completion" - This setting allows the salesperson or customer to view the item catalog and
create an order but will prevent the order from being completed and transmitted to the main entrée
system until the current date is within the allowed completion window determined as Next Delivery Date
- Max Order Days.

 3. "Block Order Entry" - This setting completely blocks all access to the order entry features of
entrée.NET. Customers and salespeople will not be allowed to edit or create orders in the system until
the allowed submission window determined as Next Delivery Date - Max Order Days.

· #67 Display Featured Brand Advertisement in Shopping Cart. Setting this option to "Yes" will display
the featured brand information defined under the "Website - Featured Brands" section at the bottom of the
shopping cart during order entry. When the customer clicks the Shop Now link in the shopping cart area
they will be brought to the Catalog page with a list of all the products for that brand. See Updating Blocks
Content to learn how to set up Featured Brands and see an example of the shopping cart option enabled.

· #72 Require PayPal payment before allowing order to be completed. Setting this option to "Yes" will
require that the customer successfully complete a PayPal payment for the estimated order amount before
allowing the order to be completed.

· #75 Enable four decimal Unit Prices. Setting this option to "Yes" will display and allow for the editing of
Unit Prices with four decimal places.

· #79 Use Future Pricing in Order Entry. If this option to set to "Yes" when creating orders for a future date,
the system will check the future price file to determine if a price change will be in effect for that day. If so, the
system will automatically use the future price rather than the current price. For entrée versions 3.6.17+
this option is set automatically to match System Option #50 - Use Future Pricing in Invoicing on the
System Options tab of System Preferences in entrée.

· #80 Prevent sales of items marked as "Allow item to be sold at $0.00.". Setting this option to set to
"Yes" will override the "Allow item to be sold at $0.00" item setting from entrée. Items which do not have
valid pricing will no longer be displayed and salespeople will no longer be able to sell the item at $0.00.

· #82 Default delivery date to next scheduled delivery day. Setting this option to set to "Yes" will default
the delivery date for new orders to the next scheduled delivery date for the customer based on routing
information defined in on the Routes tab in Customer File Maintenance.
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 This option has no effect when the "Restrict delivery dates to customer route information" option is
enabled.

· #84 Prevent entry of quantities exceeding the defined maximum warning quantity. Setting this
option to "Yes" will change the behavior of the maximum warning quantity defined for an item from a warning
to a strict enforcement. 

This option has no effect on the minimum warning quantity for the item. 
The maximum quantity value can be defined on the ".NET" tab of "Inventory File Maintenance" and also per-
customer through the "Edit Miscellaneous..." dialog of "Special Pricing".

 This option will override the maximum quantity checks for the "Show min/max quantity
warnings" feature.

· #89 Create orders with Standard Order Quantities. Enable this option to automatically build orders with
items that have a non-zero standard order quantity defined for the requested delivery date.

· #101 Use items from Special Price Customer for "Standard Order". When this options is set to "Yes",
and a Special Price Customer is assigned, then items in the customers special price file are replaced with
the items defined for the Special Price Customer.

This changes the effective customer used for all item restriction checks that verify an item
is in a customers special price file to use only items defined for the Special Price Customer. This also
affects the behavior of the standard approved and restricted item features.

For example, if System Option #4 "Can order any product" is set to "Restrict to Standard Order" with
this option enabled the customer will only be able to order items defined on the Special Price
Customers Standard Order.

· #104 Allow customer to delete items from their "Standard Order". Setting this option to "YES" will
allow the customer to mark items for deletion from their "Standard Order". This will remove the entry from the
customer special price file the next time a data export to entree.NET is performed.

· #105 Require Order Giver field before completing order. Setting this option to "YES" will prevent the
user from completing an order if the "Order Giver" field has not been filled in.

· #106 Require PO# field before completing order. Setting this option to "YES" will prevent the user from
completing an order if the "PO #" field has not been filled in.

· #107 Allow customer to edit order comments. Setting this option to "No" will remove the ability for
customers to enter comments on orders.

· #109 Notify customers when an order is completed by the salesperson. Setting this option to "Yes" will
send a copy of the order notification to the email addresses assigned to the customer's entrée.NET account
or the primary email address assigned in entrée Customer File Maintenance, if no online account is
setup.The default behavior of the system does not send a copy of the order notification to customers when it
has been completed by a salesperson. 

· #115 Allow "Bill To" customers to place orders for linked "Ship To" customers. Setting this option to
"Yes" will alter the order entry system to allow "Bill To" customers to view and place orders for all "Ship To"
customers assigned to them.
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 This option allows for the Bill-To Master customers to login to entrée.NET and place orders for any
of their Ship-To customers. All Ship-To customers must be linked to the master Bill-To in Customer File
Maintenance in entrée using the Customer Tab > Bill To Account sub-tab.
  

 Here you see what the entrée.NET customer will see in their My Account Address section with
the Bill To Master feature in use.

· #121 Can only order items available from the originating warehouse. Setting this option to "Yes" will
only allow items from the originating warehouse for the order to be viewed and added to the order. By default
this is the warehouse assigned to the customer through Inventory File Maintenance. (Requires entrée v4.0.35
or later and the entrée.MW add-on module).

· #122 Display on hand information from the originating warehouse. Setting this option to "Yes" will

display the default On Hand and On Hand Weight information using only the inventory numbers from the

active warehouse. When set to "No" the total inventory number for all warehouses will be displayed.

(Requires entrée v4.0.35 or later and the entrée.MW add-on module).
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· #127 Disable promotions for customers receiving Bid Pricing. Use this option to specify if promotions

should be disabled for customers on items that are receiving bid pricing. This option is automatically set by

the export process to the same value set for entrée System Option #200 "Disable promotions for customers

receiving bid pricing".

· #128 Display items with no On Hand inventory. Allows you to control the display of items with no on

hand inventory. Setting this option to "Yes" will show items with NO On Hand inventory in the order entry

screens. Setting this option to "No" will hide items with a zero or negative on hand inventory value.

Promotions – These option control the display and rules for the promotions.

· #41 Disable promotions below Selling Price. If this option is set to "YES", the system will disable an
item promotion (as defined off the Promo window in the inventory file) if the customer's sell price is less than
their normal pricing. 

 Let's assume a case of pizza sauce has a promotion of $1/case an the customer's
normal price is $16.50. If for some reason (salesman gives him a deal on this item) he is invoiced $16.25
instead, he will NOT receive the promo discount if this option is set to YES.

· #42 Disable promotions for customers receiving special or bid pricing. When set to "YES", any
customer already receiving a bid or special price on an item eligible for a promotion, will not receive
promotional pricing for the given item.

· #45 Allow a Promotion to be applied to a Break Price. When set to "YES" the system will allow a
promotion to be applied to a break price. The settings in entrée.NET is automatically based upon the

current settings in system option #172 in entrée.

  Some distributors view BOTH features as being "promotions" and do not want both to be applied
to the same invoice line item. To allow only one “promotion” per item, set this option to “No”. Then for any item
which is currently assigned a Break Price, no Promotions will be applied. 

Prospects – These options control the display and rules for the Prospects feature.

· #31 Enable “Prospects” feature. Setting this option to "YES" will allow salespeople to create and manage
"Prospects".  Three new tabs will be added to your menu once this feature is enabled; Prospects, Manager
Setup and Reports. 

· #33 Create prospects for quote requests from website. Setting this option to "YES" will automatically
create a prospect when a visitor submits a quote request from the website. This option has no effect
when the "Enable Prospects feature" is set to "NO".

· #34 Salesperson assigned to new prospects. Designates a salesperson that will be assigned to
prospects created from website quote requests. This option has no effect when the "Enable Prospects
feature" or "Create prospects for quote requests from website" is set to "NO".
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Salespeople - These options control the display and rules for Salespeople with accounts in entrée.NET.

· #14 Allow salespeople to setup entrée.NET accounts for customers. Turning this option on allows
salespeople to setup entrée.NET accounts for customers. This provides the same account setup feature
available to the distributor and is limited to the customers assigned to the salesperson.

· #18 Display “Gross Profit”. Setting this option to
"YES" will display the GP dollars / percentage values
in the top of the cart while a Salesperson is creating
an order. Applies to Salespeople only.

· #25 Allow salesperson to modify pricing. Turning this option on will allow the salesperson to modify
prices on an order.

· #26 Allow salesperson to enter prices below the “Minimum Sell Price”. Turning this option on will
allow the salesperson to enter prices below the "Minimum Sell Price" defined on the "Cost/Price" tab of
"Inventory File Maintenance" - This option has no effect when "Allow salesperson to modify pricing." is
turned off.

· #28 Email a copy of orders placed by customers to the salesperson. Turning this option on will email a
copy of the order notification to the salesperson assigned to the customer’s account.

· #29 Salesperson can view and place orders for all customers. Turning this option on will allow the
salesperson to view and place orders for all customers. The "Receives data for ALL salespersons" option

in the entrée Salesperson/Broker File Maintenance Remote Order Entry tab will override the
"Salesperson can view and place orders for all customers" option when set to “No". 

* See the Setting entrée Options chapter for a complete explanation of how to use the new  Salesperson /
Broker File Maintenance Remote Order Entry options.

· #32 Allow salesperson to re-assign prospects. Setting this option to "YES" will allow a salesperson to re-
assign a prospect to a different salesperson. This option has no effect when the "Enable Prospects
feature" is set to "NO".
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· #35 Allow salesperson to adjust prices by specifying a percentage over “Base Cost”. Setting this
option to "YES" will provide a "%" column next to the "Price" column allowing the salesperson to adjust
prices by entering a percentage of base cost. The price calculation will follow the rules defined for the
"Customer Special Price Formula" in entrée on the Price Setup tab of System Preferences.

 These calculations are made using the values available to entrée.NET at the time the
order is placed and will only lock the price on the invoice. If any cost changes take place in entrée
as a result of receiving new product or a manual cost change there is no guarantee that the margins
used to create the order in entrée.NET will reflect the final margins of the invoice.

· #38 Allow salesperson to enter prices below "Base Cost". Setting this option to "YES" will allow the the
salesperson to enter prices below Base Cost.
Setting this option to "Display Warning" will display a warning dialog and allow the price to be entered.
Setting this option to "NO" will prevent the price from being accepted.

· #43 Display Commissions. (Electronic Order Pad) Applies to salespeople only. Turning this option on will
enable the display of estimated commissions calculations for orders.

· #46 Allow salesperson to delete items from a customer's "Standard Order". Setting this option to
"YES" will allow the salesperson to mark items for deletion from a customers "Standard Order". This will
remove the entry from the customer special price file the next time a data export to entrée.NET is
performed.

· #56 Enforce credit hold for salespeople. When this option is enabled entrée.NET will enforce the credit
hold setting from entrée and will prevent new orders from being placed by salespeople.

· #81 Display customer Hot Message. Setting this option to set to "Yes" will display the hot message
defined for the customer when selecting a customer.

· #83 Show warning if Unit Price is below Base Cost when adding items. Setting this option to set to
"Yes" will display an alert to the salesperson if the calculated Unit Price is below the Base Cost for the item
when adding an item to an order.

· #92 Prevent selling below Base Cost. Under normal operation the system will never change a price that
has been calculated for a customer even if the price is below the items Base Cost. Setting this option to
"Yes" will modify the below cost checks to prompt the salesperson and force the price to the items Base
Cost. This compliments the "Prevent selling below Base Cost" miscellaneous password option in entrée.

· #94 Allow Salesperson to view Real Cost.

· #95 Allow Salesperson to view Landed Cost.

· #96 Allow Salesperson to view Market Cost.

Each of the three cost viewing options will be enabled
individually as the column is added to the Item
Information Panel in entrée.

Otherwise the cost viewing option will not appear in the
options list. 
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· #97 Calculate Gross Profit using Landed Cost. Setting this option to "Yes" will change the gross profit
calculations from using Base Cost to Landed Cost.

· #98 Invoicing deducts bill back amount when calculating Gross Profit. Setting this option to "Yes" will
change the gross profit calculations to account for vendor bill backs. 

· #100 Show DOT item filter. When this option is set to "Yes" a button with the Dot logo will be added near
the search controls in the Catalog section. This button provides special filtering options to control the display
of Dot items while browsing the catalog. This filter is available on the Order Guide / Product Listing report.

· #102 Allow salesperson to modify prices for customers on Price level 1. When this option is set to
"No" price editing will be disabled in when the customers price level is not set to level 1. 

 The "Allow salesperson to modify pricing." option overrides this setting.

· #103 Allow salesperson to modify prices for customers on Price level 2 - 99. When this option is set to
"No" price editing will be disabled in when the customers price level is not set to a levels 2 through 99. 

 The "Allow salesperson to modify pricing." option overrides this setting.

· #117 Allow Special Pricing to override the Minimum Sell Price. Used to specify if Special Pricing is
allowed to override the Minimum Sell Price. This option is automatically set by the export process to the
same value set for entrée System Option #177 " Special Pricing is allowed to override Minimum Sell Price". 

Website

· #40 Default item sort column. Designates the column to use by default when sorting the item listing in the
website product catalog.

  When "Item #" is selected the catalog will list all items and disable the grouping by class and
brand as it sorts in the selected direction.

· #44 Display Website Blog. Selecting "Yes" will turn this option on and add the Blog link to the website
main menu  in your website. Use the Website tab Blocks section Blog feature to add content to your
Blog.
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· #57 Enable display of banner ads. Selecting "Yes" will turn this option on for your website. See the Ads
section of this chapter to use this feature.

· #62 Display Manufacturer Item Number in Item Catalog. When set to "Yes". It will include the
manufacturer item number, if defined for an item in the main entrée system, below the item description
when browsing the Catalog page of the website.

· #85 Vertical Scrollbar for Popup Catalog. Turning this option on will condense the item areas of your
catalog and implement a scrolling feature, rather than listing down the page.

· #86 Show On Hand Quantity. Turning this option on or off will toggle the display of on hand quantities for
items.
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5.2 Ads

 Banner Ads
The "Advertisement" system allows distributors to upload advertisements with links to related information their
website Home page (outlined in red on the Home page below is the Brand with Tyson  logo selected as the
advertisement with the position set to ‘Bottom of Page’). 

Facts About Ads
Advertisements are managed by the System Administrator in the Settings tab using the Ads button. 

· Ad images can be created using any graphic or photo editing software.
· There are no image size restrictions from the images uploaded for advertisements. This allows you to use

any shape and size image for your ad. Previously ad images were required to be 675w x 90h in pixels
saved as jpg or png image files.

· When the advertisement image is clicked the customer will be brought to the catalog page displaying all
the items with the selected Brand, Class, Specials or Item Tag. 

· Once one or more banner ads have been defined the images for these ads will be displayed in rotation on
the website home page when a page refresh is done.

· An Important Note: Since your current advertisements are randomly selected from the Ads listing for
display on your home page, once an advertisement has expired it must be deleted from your Ads list.
This will prevent expired advertisements from displaying on your website home page.  
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Need Help Creating Ads
If you need help creating your banner advertisements for a small fee, we can create professional looking
graphics for your banner. Please contact the NECS Sales Department at sales@necs.com for assistance. 

First, Enable the Ads Feature 

To use the Ads feature you must first enable it using the Options button:

1. Click the Settings tab. 

2. Click the Options button.

3. Scroll down to the Website section.

4. Set the "Enable display of banner
ads." system option to "Yes".

Second, Post Your Ad 

 Before you begin this post process your ad should have been designed and saved as a
jpg or png image file on your computer. 

1. Once your advertisement is ready to post click the Settings tab. 

2. Click the Ads button and the ads management screen will display any saved ads which are listed by Title
and designated start Date.

3. Use the Edit and Delete tools in the left column to manage your saved ads. 

· To Edit an existing ad: Select the ad from the list and click the edit icon with the pencil. The Post
Advertisement dialog will open, make your changes and click Post. Be sure to check the value of Date, the
"start date" for the ad before re-posting it.

· To Delete an existing ad: Select the ad from the list and click the delete icon  with the red minus sign.
The Delete Ad? confirmation dialog box will display. Click Yes to remove the selected ad from the list.

mailto:sales@necs.com
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4. To post a new ad: Click the
Post Advertisement button to
open the dialog. 

All fields in the Post
Advertisement dialog are
required.

5. Enter a Title. In our example the related holidays and the year were used. 

6. Select a Date using the calendar. This will be the "start date" for your ad. The website will post your ad on
the home page on this date.

7. Position:  Set the position of the advertisement image on your website home page using the this option.
Select to display your advertisement image either at the Top of page (left) or the Bottom of page (right) of
your website home page as seen in the images outlined in red on the Home pages below for a Class of
Produce.

Top of page Bottom of page
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8. Make a selection for the Links To: drop down list. Your options are:  Class, Item Tag, Specials, or Brand.

When Brand is selected you will select your Brand
from the drop down list below as shown in the image
on the right. This Brand list is populated from the
Brands information in the main entrée system in
Brand Maintenance.

· The Specials option
will link the ad to your
website Specials
page. In the example
below Tyson Specials
will be advertised.
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· The Class option will display a secondary drop
down list for you to select the related class. The
class list reflects the classes you have set up in
your main entrée system.

· The Item Tag option will display a secondary drop down
list for you to select the related Item Tag. The item tag
list reflects the item tags you have set up in your main
entrée system.

9. For the Image option click the Browse button to find your saved ad image file on your computer. If you have
Brand images defined you can use those images in your ad. 

10. Click to select the image file in the directory on your computer and then click the Open button.

11. Then in the Post Advertisements dialog click the Upload button . The image will then be loaded and
displayed in the dialog. The "Image Uploaded" message will display in the image selection box to indicate
the upload was successful.

 Only one image per advertisement can be uploaded. Once an advertisement has expired it must
be deleted from the Ads list.

12. Click the Post button at the bottom of the Post Advertisement dialog screen and your new advertisement
will be listed in the ads management screen. Once you create the new advertisement and Post it the ad
will appear on the home page of your website on the designated start date. 



entrée.NET Settings 60

5.3 Grids

  Grid Settings   
 entrée.NET allows you to customize the display of column information in the Standard Order, Search and
Quick Entry Grids.

1. Use the Select Grid drop down menu to choose the grid to
customize.

2. Click and drag column names to reorder and move them to their
new locations.  

3. Click the tools icon  to view the drop down menu to add or
remove columns from the display. Check the box to add a column
and remove the check to delete a column from the grid.

4. If you want to remove all the custom grids your customers and
salespeople have defined, the click the box to “Replace all
customer and salesperson configurations for this grid. “
Leaving this box unchecked will only affect new customers and
salespeople added after you save this configuration.

Warning: It is advised that you NOT CHECK this box if your
entrée.NET system has been in use for a while, as customers
and salespeople will lose the grid settings they took time to
customize.

5. Click the Save Configuration button   to
save your  changes.

This image of the Grids option page in the Settings tab has the “Replace all customer and salesperson
configurations for this grid” option checked.
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5.4 Email

  Email Settings   
 Using email to communicate with your entrée.NET customers could not be easier. We provide you with all the
email templates you need to get you started. Just add a few pieces of information and the template is
customized and ready to serve your business needs. 

Email Templates
You have been provided with all the templates you
will need to support your entrée.NET system.

Special tags have been created to fill in the
essential system information in the emails. 

Use the templates as they are or edit the subject
and body of the email templates to suit your
business style. Just be sure to always incorporate
the special tags associated with that template in
the body of your emails. 

entrée.NET will automatically correspond with
your  customers, salespeople or system
administrator via email messages. 

Email messages are sent for the following situations:
· Customer Account Setup
This email is sent to your customers after an
account has been created for them. Your
customers will receive their username and
password to access online ordering.
Customer account creation will be covered in
the Customer Setup chapter.
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· Customer Order Notification
This email is sent to your customers once
they complete their order and BEFORE you
confirm their order. 

A PDF copy of the order will be included with
this email and is displayed below.

· Distributor Order Notification
This email is sent to you when
an order has been placed. 

The email addresses you
entered for your company in the
Settings tab > General options
> Email Notifications field will
receive these emails.

· Customer Order Confirmation
This email is sent to your
customers after one of their
orders has been imported into
the main entrée system. 
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 This is the Order Notification email that will be sent to the customer. The online order is in
the attached PDF file.
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 This is the customer's online order PDF which is attached to the order confirmation email
sent to the customer. Notice the Bill To and Ship To addresses, the addition of the Order Giver field, Phone
and Fax numbers.

· Salesperson Account Setup  
This email is sent to salespeople
after an account has been
created for them. Salesperson
Account creation will be covered
in the Salesperson Setup
chapter.
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Prospects Feature & Email Templates
The purpose of the “Prospects” feature is to provide the distributor with a set of tools which can be used by the
distributor and your salespeople to manage and prepare quotes for potential customers. 

The Prospects tab is where you will create and maintain your prospects information, guides and eventually
convert your prospects to regular customer accounts. Please review the Prospects Tab chapter of this guide
for more detailed information about this feature. 

New Email Templates supporting Prospects have been created for companies that choose to implement the
Prospects feature. 

· Prospects templates under “Administrative” are used for emails sent to the distributor or prospect
managers.

· Prospects templates under “Customer” are used for emails sent to your customers.
· Prospects templates under “Salesperson” are used for emails sent to your salespeople.

· The Email Templates screen will update once the Prospects feature has been implemented. The main
menu tabs have been updated to include the new Prospects, Reports and Manager Setup tabs as shown in
the image above.
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5.5 EOP

  EOP Settings
The Electronic Order Pad is our first mobile app which interacts with the entrée.NET server via wireless
connections. The Electronic Order Pad (EOP) is an order entry tool for your salespeople that is based off
entrée.NET. This means the Electronic Order Pad communicates directly with a remote entrée.NET secure
server, and not your local server in your office.

An EOP button has been added to the Settings tab to allow you to manage your EOP licenses and iPad
assignments to your salespeople. As your salespeople login to EOP on their iPads the entrée.NET system
EOP feature will be automatically post the license information, User Name and  here. 

· Use the drop down menu on the Last Seen header to control the visible columns on this screen.
· An N/A in the Last Seen column indicates that User Name has not been logged into EOP. 

· Use the key with the red minus tool on the left to revoke EOP licenses by salesperson as required. 

 In this example the Last Seen column indicates the time that the User Name logged into
the EOP application.



Chapter 6
Website Settings
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6 Website Settings
The another task for the System Administrator is to update the Website tab. This chapter is written for the
distributors who purchased the Website Only option featuring a website with just the “Catalog” and “Specials”
pages, and the Website and all entrée.NET features option. 

If you have the Website Only option your customers can only view your website and do not have the other
functions that entrée.NET offers, such as entering orders, but you will still be able to upgrade, at a later date,
and have all the features of entrée.NET.

At this point in time NECS should have already created your initial website and now you have the ability to
make website changes as required for your business. You can change images, update the content on your
“Welcome,” “About Us,” “Contact,” and “Directions” pages. You will be able to automatically post your inventory
list and specials, from your NECS entrée software, directly to your website, as often as you’d like. 

Our latest features allow you to control the names of the page links in your website menu and the web page
descriptions. You also have the power to customize the keywords list used for search engine optimization for
each individual web page in your website.  

 The Website tab in entrée.NET has been enabled for those distributors who did not purchased
the website option for entrée.NET. This access will provide all distributors with the ability to utilize the
"Featured Brands" feature for marketing. All the other website options will still be disabled if you have not
purchased the website option. 

If you would like to designate a Website Manager to assist in updating the entrée.NET website for your
company proceed to the Manager Setup Tab chapter for the details. 

The Website tab is composed of two sections which run along the left side of the screen. These include
Content, Banner and Colors. Each of these will be described next.
  

 Content Overview
 Updating the information in your website is a critical part of keeping your customers current with products,
specials, and services provided by your business. If your customers know you frequently post your specials
then they will make sure to check your website often to find those deals. 

The content of your website is divided into Blocks, Menu and Pages which can contain text, hyperlinks and
images. The image below shows color coded arrows indicating these areas of the web page. 

Blocks are specific sections of various web pages within your website. The Blocks content areas of your
website are:

· Blog –   allows distributors to post multiple articles or news posts on their website. This feature must be
activated in the Settings tab by selecting "Yes" for the "Display Website Blog" option. 

· Featured Vendors – Posted on your website home page this block allows you to highlight multiple vendors
and their products. 

· Latest News – This block is posted on all of your website’s pages in the lower right corner.

· Featured Item – Posted on your website home page this block allows you to highlight specials as “featured
items”.
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The Menu section of your website currently includes:

· Specials – When you check the “Display on website” box for an item in the Specials page, it will display
the item on the Specials web page.

The Pages section of your website can include:

· Home  – The main page of your website and the first page a customer visits.

· About Us – Use this page to tell your customers about your company. 

· Contact – Provides website visitors with contact information for your company including phone numbers for
various department and email links.

· Directions – Written directions to your office and/or business location(s). Google maps can be embedded
into this page.

· Place Order – Customers will use this page to place online order using entrée.NET.

 The Place Order page is not included in the website for distributors who purchased the website
only option.

Website Examples
A "Join Our Email List" option has been added
the website Home page Customer Login sidebar.
Clicking the submit button opens a form for the
website visitor to fill out. 

The information received from this form will help you
generate more leads through your website Home
page.

See the Website Email List  topic to find out how
to set up the connection between your website and
a third party mailing list provider like Constant
Contact.

* Constant Contact is a registered trademark of CONSTANT CONTACT,INC. Corporation.
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This is a website Home page displaying the latest entrée.NET features
§ Company Logo. 

§ Website Banner Feature for photo slide show.

§ Website Background Feature. 

§ Menu with Blog link. 

§ Product Catalog Search Feature.

§ Register Feature (information
follows).

§ Forgot Password Feature.

§ Join Our Email List Feature.

§ Latest News.  

§ Featured Brands block which
supports multiple vendors and
their logos images that link the
customer to the vendor's
products in your catalog.

§ Featured Item block with
photo. 

§ Social Networking links for
Twitter and Facebook.

§ Banner Ads Feature with links to Specials web page, Item Tags, Brand or Class. This content can be
positioned at the top or bottom of the website Home page. In this example the Ad is the image of steak with
the "Ask us about our Fall Steak Deal" text at the bottom of the page. See the Settings Tab for feature
controls.
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How Website Registration Requests Work

The Register button will allow customers to access this online registration form to request an entrée.NET
account.

 This feature does
not  automatically create a user
account for the customer to
login. You must manually
approve and setup any new
customer accounts.

· When the customer clicks the
Register button they will have
an online form to fill out (right). 

· Once the customer fills in the
form, enters the security code
displayed and clicks the Send
Request button the information
collected from the registration
form is sent to you via an
email. 

· The customer will see this confirmation message displayed in your website.
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· Once the email (below) is received from the website Register button you can review and process the
requests for customer accounts. 

More entrée.NET Website Pages

          Blog

6.1 Updating Web Page Contents
The web page update process is basically the same for all your web pages. The information contained in the
individual pages will be changed periodically to match your company requirements. 

1. Click the Website tab, and then click the Content button. 

2. Click on the web page name in the Content list on the left. 

3. The information currently on the page will display when you click the Content tab.

4. Your web page content will initially display with in a Page Mode of Standard. You can choose to edit
your web page content using Advanced Page Mode by selecting it from the Page Mode drop down list.
Both Page Modes provide you with the same editing tools and the Search Engine Optimization tab.  

§ Standard Page Mode – Will display the stock images loaded into the system in the Photo tab. This
mode limits you to selecting or uploading a single image. 
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§ Advanced Page Mode – Does not have a Photo tab. This page mode allows you to insert multiple

images into each web page using the Image  tool in the editing tool bar. No stock photos will be
displayed in this mode. 

Most of the editing tools provided in the Website tab you already have used in other software on your
computer. To find out what the tool does just roll your cursor onto it and a tool description will pop up. An
explanation of each tool can be found later in this chapter.

 
5. Add your new information and images and remove any obsolete content by using the tools in the tool bar.  

6. When your Content tab changes are complete, click the Save button to update. 

 If you do not click the Save button your changes will NOT be saved in your web page.

Website Design Tips:
Tip 1: Plan your web pages on paper before you use entrée.NET to create them. 

Tip 2: Have any images for your website edited and ready to go on your computer.

Tip 3: Pressing the right mouse button while selecting an area of the web page will display a related menu of
options.

Tip 4: If you choose to upload and link to documents created in Word, Publisher or other software, convert the
documents to .PDF format before you upload them. Using .PDF format will guarantee that all your
customers can open and view your documents using the free Adobe Reader software.

Page Mode Editing Tools 
Page Mode editing tools may be very familiar to you if you have used any word processing software. These
tools will be listed below in their order on the tool bar image above with a brief description of their purpose.

· Format – Paragraph format options drop down menu is used for organizing your text and to distinguish
different parts of your text. 
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· Font – Use the drop down menu to make a selection from a short list of the fonts best suited for web
pages.

· Size – Font size drop down menu. 

· Bold – Make the selected text bold.

· Italic – Make the selected test italic.

· Underline – Underline the selected text.

· Strike Through – Inserts a strikethrough line into the selected text. 

· Subscript – Places the index at the bottom of the text like the “2” in B2.

· Superscript – Places the index at the top of the text like the “th” in 4th.

· Text Color – Change the color of the selected text.

· Text Highlight Color – Change the background color behind the selected text.

· Left Justify – Align the selected text to the left.

· Center Justify – Center the selected text.

· Right Justify – Align the selected text to the right. 

· Block Justify – Each line of text will have the same length. 

· Decrease Indent – Moves the selected text left.

· Increase Indent – Moves the selected text right.

· Block Quote – Use block quotes whenever a quote exceeds four lines of text. This can be use to add
direct quotes from your customers into your web page text.

· Link – Make the selected text a hyperlink.

· Unlink – Remove the hyperlink from the selected text.

· Anchor – Create a link to an anchor in the text of your web page. This is used to move web page visitors
directly to a selected topic in a web page. The topic anchors are usually listed at the top of the web page
and link to the topic farther down the web page. 

· Image – Insert an image.

· Numbered List – Start a numbered list.

· Bullet list – Start a bullet list.
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· Table – Create a table with a defined number of columns and rows. Tables are used to organize
information on a web page.

· Insert Horizontal Line – Inserts a divider line (horizontal rule).

· Insert Special Character – Inserts symbols and special characters (accented characters, trademark,
currency symbol, etc.).

· Cut – Cut the highlighted text to the clipboard. (Removes the text from the page and stores it in the
clipboard area.)

· Copy – Copy the highlighted text to the clipboard.

· Paste – Paste the data from your clipboard into the web page.

· Paste as plain text – Paste text without it’s format on fonts, headings, and hyperlinks.

· Paste from Word – Paste content copied from Microsoft Word or similar applications. By using this
option you may paste the text from Word ignoring the Font Face definitions or removing Styles definitions.

· Source – Switch to source edit mode to edit the HTML code.  

· Show Blocks – Display where the blocks are in the web page.

Spotlight on Web Design Tools 
In this next section some of the most commonly used web page design tools will be examined in more detail
including information about working with the Tables, Images, and Special Characters tools.

The Table Properties tool is used to insert a table into your web page. 

Tables can be used to organize lists of products or create columns for text and images in your web page.
Follow these steps to use this tool:

1. Move the cursor to the desired table location in the web page. 

2. Click the Table icon.  The Table Properties pop up box will display.

3. Enter the number of Rows and Columns in your table. 

4. Enter a number for the Width of the table. Select either pixels or percent of the web page from the drop
down list. For example; you can enter 50 for Width and select percent and your table will be one half the
web page’s total width in the browser. 

5. Enter the number of pixels for the Height of the table. 

6. Headers – Are used to add titles on your rows and columns. Select from none, First Row, First Column or
Both. Then type the title in the header area of the table.

7. Cell Spacing – Enter the number of pixels for the space between table cells. 

8. Cell Padding - Enter the number of pixels for the space between the contents of the cell and the cell wall.
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9. Border size – Enter a number here for the width in pixels of the table border. Enter a zero if you want no
visible border line on the table. 

10. Alignment – Select from Left, Center or Right for the alignment of the text in the table.

11. Caption – Enter the caption you would like to appear above the table.

12. Summary – Enter a summary of the information in the table. 

13.  Click OK.

The Table Properties dialog box
used to create the driving
directions table.

The table created using the table
properties in the image on the
left. 

The Caption is displayed above
the table. 

The table has a 1 pixel border with
4 rows and 2 columns. 

Edit an Existing Table:
 You can view and change its properties by right-clicking the table with your mouse. Select Table Properties
from the list. When the Table Properties pop up box displays make your modifications and click OK. 

Delete a Table: 
Right-click on the table with your mouse and select Delete Table.
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 Not all of the options are required to build a table. You have to fill only rows and columns. The
remaining fields are optional and you may use them depending on your needs.
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How to insert an image using the Image Tool:
1. Move the cursor to the location for the image. 

2. Click the Image icon   and the Image
Properties pop up box will display.

3. Click on the Image Info tab.

4. URL - Click the Browse Server button and locate
the image on your server or computer.

5. Alternative Text – Type a name or description of the
image here.

6. Width / Height – Enter a number in pixels to set
these image properties. 

7. Border – If you would like a border line around the
image enter the border width in pixels here.

8. HSpace - Enter a number in pixels to set the
horizontal space between the image and surrounding
text.

9. VSpace - Enter a number in pixels to set the space
above and below the image.

10. Align – Select from Right, Center and Left for the
image alignment.

11. Click OK when done.

How to use an image as a link:
1. Complete the Image Info process above or open

the Image Properties of an existing image. 

2. Select the Link tab in the Image Properties pop
up box.

3. URL - Click the Browse Server button and locate
the web page you would like to link to or type the
URL of the desired website or web page.

4. Target – Choose from the drop down list where
you want this new link to open in the browser.
Select from New Window, Topmost Window, Same
Window, Parent Window or not set.

5. Click OK. 
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How to upload an image to your server:
1. Select the Upload tab in the Image Properties

pop up box.

2. Click the Browse button and locate the image on
your computer. Select the image file.

3. Click Send it to Server.

4. Click OK.

 

How to insert special characters:
The Select Special Characters tool is used to insert characters into your web page text that are not available
on your computer keyboard. Follow these steps to use this tool:

1. Move the cursor to the desired location in the text. 

2. Click the Insert Specials Characters icon.  

3. The Select Special Characters pop up box will
display.

4. Click on the character and it will be inserted in your
web page. 
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6.2 Search Engine Optimization
Make sure that your business is found when people are searching the Internet. A Search Engine Optimization
(SEO) tab has been added to the Website feature to give you control over the keywords used by the major
search engines. The SEO Setup process will be the same for all of your web pages. Only the keywords you
add to each page will change to reflect the web page content. There are 5 areas where you will enter SEO
related information:

· Link Title: The title the link for that page will display in the website menu. If the current Link Title is OK,
then you can bypass this value.

· Page Title: The title of the web page that will display when viewed in a customer’s browser.
· Link Keywords: The text that will display when the mouse rolls over the Link Title in the menu.
· Page Keywords: This is the keyword list search engines will use in reference to your web page. These

keywords help to determine how quickly your web page is found. 
· Page Description: A description of the purpose of the web page and what it offers to the customer.

Below is an example of an SEO Setup for the Place Orders web page. Once you fill in your SEO information,
click Save. You will fill out the SEO Setup information for all of the pages in your website. Be sure to click
Save on each web page once you make your changes.

 Periodically become a customer and visit search engines to input your keywords and
phrases. Then see what page of the search engine results your business is found. If you are not on page 1 or 2
you need to fine tune your SEO Setup information.  

An example of the website menu showing the Link
Title and Link Keywords (displayed on mouse roll
over) from our sample SEO Setup.

 



entrée.NET Administrator's System Guide81

6.3 Adding Photos to Web Pages
To add photos to your website use the Photo tab in Standard Mode to add either a stock images or upload
your own image from your computer.

1. Click the Website tab, and then click the Content button. 

2. Click on the Page name in the Content list on the left. 

3. Click the Photo tab.

4. The Photo tab will display the stock images available to you and the upload dialog.
 
5. Click the desired stock image to select it. The displayed image will update.

6. Or if you would like to upload an image from your computer, the supported image formats are JPG, JPEG,
GIF and PNG.

7. Click the Browse  button and  the Open dialog box will display.

8. Locate the desired image file on your computer, click on the image file to select it.

9. Click the Open  button. 

10. Click the Upload   button.

11. The image file will now be uploaded and display in the image area. 

12. When your selection is complete, click the Save button.

· The Open dialog box used to find images on your computer for upload to a web page.
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· The image is now in the Photo tab page after being uploaded.

· The Home page of the website with the new photo.
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6.4 Updating Blocks Content
The website blocks that are covered in this section of the chapter are: Blog, News, Featured Brands and
Featured Item.

The Blog Block
The Blog feature allow distributors to post multiple articles or news posts on their website. Blog content is
managed by the administrator or by a designated website manager. The content entered into the Blog block
will be displayed in the Blog page of your website. To activate the Blog feature:

1. Click the Settings tab

2. Click the Options icon. 

3. Scroll down to the Website section.

4. Find "Display Website Blog" and select "Yes".

5. The Blog link will now be displayed in the main menu of your website as seen in the image below.

6. Now you are ready to add content to your Blog.

Adding Content to your Blog:
1. Click the Website tab.

2. In the Content menu under the Blocks  section click Blog. 

3. Click the Add New Blog button.
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4. The Blog Edit dialog box will be displayed. 

5. Enter a Title for the blog entry. This title
will be displayed in the Blog page of the
website.

6. Enter a Date for the blog entry. You can
either click the calendar icon (as seen in
the image below) to select a date or type
a date in the text box.

7. Enter a Short Description. This
description text will be displayed in the
blog entry of your the website.

8. Use the website editing tools to add an
image and format the content.

9. The Article section is where you will
enter the complete blog entry. You can
include whatever information you would
like to share with your customers.

 

10. When you have finished editing your blog entry click the Save button. Now it will be added to the Blog
page of your website.
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A Blog article posted in the website.

Managing your Blog Entries 

· Use the Edit button to change the text in an existing blog entry. 
· Use the Delete button to remove a blog entry from the website.

Email Blog Entry to All Customers
1. Click the Website tab.

2. In the Content menu under the Blocks  section click Blog.
 
3. Select the desired blog entry and click the Edit button.
 
4. When the Blog edit dialog box opens click the "Email to Customers" button at the bottom of the window. 

5. The Email Blog to Customers dialog box will display. The default Recipient value is All Customers.
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6. Edit the Email Subject and Email Body text if required.

7. Click the Send button. All your customers with email addresses in their entrée.NET accounts will be sent
the email.
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The News Block
The content entered into the News block will be displayed on all the pages of your website in the Latest News
section. Use the News block to supplement company communications with your customers. Topics
concerning time sensitive ordering dates, product announcements, news about your company can be shared.
Once the News block has been updated it will be displayed in your website instantaneously. To update the
News block follow these steps:

1. Click the Website tab

2. Click on the News block in the Content list on the left. 

3. The information currently in the block will display under the Content tab.

4. Add your new information and remove any obsolete information.

5. Use the tools discussed previously in this chapter to change the text color, font, highlight text, change text
size or whatever you wish. 

6. When your changes are complete, click the Save button to save your changes and update the Latest
News your website.

Back: The News block as it looks in the Content tab when you are editing your news.

Front: The Latest News section as seen on all the web pages in your website. The purple headline has been
highlighted with white to make it more prominent. 
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Updating Featured Brands
The "Featured Brands" website feature (formerly called "Featured Vendors") is located in the entrée.NET
Website tab now allows you to define multiple brands to be highlight in the Featured Brands block of your
website home page in a rotating slide show and in the bottom of the customer's shopping cart if you choose to
enable that option in the Settings tab. You can add text, a picture or logo representing the brand or their
products to the block information.

 The Website tab in entrée.NET is now enabled for those distributors who have not

purchased the website option. This will provide you with access to the Featured Brands editor so you
can use this feature for marketing. All the other Website options will still be disabled. 

 You must first define your Brands in Brand Maintenance in the main entrée system and run the
data export to get the information in entrée.NET.

· Follow these steps to control the content in the Featured Brands block:
1. Click the Website tab. In the Content list click on Featured Brands. 

2. The Featured Brands screen will display all the brands currently in the block. Use the Edit and Delete
buttons to manage your brands.

3. Click the Add New Featured Brand button to open the Featured Brands dialog box.

4.   Select a Brand from the drop down list of from all the

brands defined in your main entrée system. 
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5.  Enter Brand information and
use the following options:

· Show specials only –
Check this option to only
display the brand’s specials
when the brand image is
clicked  on the Home page.
If not checked all the
brand’s products in your
catalog will be listed.

· Image: 

§ Use Browse to select an image file on your computer and Upload a brand image that will be
displayed in the Home page slide show and used as the link.  

§ Upload  – To upload an image follow steps 15 – 22 in Updating the Featured Item Block section
on the last page of this chapter. 

· Description: Enter product or specials information. This text will be used for Website SEO and will not be
displayed.

6. Click the Save button and your website Featured Brands block will be updated. 
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 These are examples of the Featured Brands block as the slides change to show different
brands. 

· When your customers mouse over the Featured
Brands area the slide controls (outlined in red) will
display so they can view all your Featured Brands
at their own pace.

· When the customer clicks the Shop Now link in
the shopping cart area they will be brought to the
Catalog with a list of all the products for that brand.

When a brand logo is clicked in the Featured
Brands block on the Home page the customer is
brought to the Catalog page with a listing of their
products as shown in the image below.
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Displaying Featured Brands in the Shopping Cart
In the Settings tab Options section you have the option to showcase your Featured Brands in the shopping
cart area using the  "Display featured brand advertisements in shopping cart" option. 

· When this option is set to “Yes” the information you define in the
Featured Brands section of the Website tab will be displayed in the
bottom of the shopping cart.  

· When the customer clicks the Shop Now link in the shopping cart
area they will be brought to the Catalog with a list of all the products
for that brand.

· When your customer mouses over the Featured Brands area the
slide controls (outlined in red below) will display so they can view all
your Featured Brands at their own pace.
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Updating the Featured Item Block 
You have the ability to select an item to be your “featured special” in the Featured Item block of the website
home page. You can add text and a picture of the item to the block. Follow these steps to edit the Featured
Item block:

1. Click the Website tab.

2. Click on the Featured Item block in the Content list on the left.

3. The featured item dialog will display with the information currently in the block. 

4. Click the Clear button to remove the current Featured Item content.

5. Click to check the Show featured item box to display it on the Home page of your website.

6. Click Select an item to feature.

7. The Item Search dialog box displays. In the Search drop down list select a search option: Item
Descriptions, Class and Item Number.

8. Enter text in the box and click to search.  
 

9. The Item Search box displays the search results.

10. Find the item and click the Plus icon  to select it.

11. Click the blue Description link to view the Product information. 

12. The item # will now display in the Select an item to feature box.

13. You now have the option to add a comment in the comment text box. 
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14. Use the tools discussed previously in this chapter to change the text color, font, highlight text, and change
text size of the comment. 

15. You have the option to upload an image or alternate image for the item. The supported image formats are
JPG, JPEG, GIF and PNG.

16. To upload an image for the item: Click the Browse   button.

17. The Open dialog box will display.

18. Locate the desired image file on your computer. Click on the image file to select it.

19. Click the Open  button. 

20. Click the Upload   button.

21. The image file will now be uploaded and display in the image area. 

22. Click the Save button and your website will be updated.

The Featured Item block as seen on the
Home page of the website. 
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6.5 Updating Website Colors

 In addition to changing your content, you have the option to change the colors used for the text and
the 4 background areas of your web pages. The color scheme you select here will be applied to all the pages
in your website.  

1. Click the Website tab, and then click the Colors button.   

2. Use the Site Colors section to select colors from the drop down palettes or if you have specific colors that
your company uses, your can enter the RGB values for the colors in the box. The RGB values are
displayed in the color box after you select a color from the palette. 

Or use the "Optional Template Selector" drop down list to select a website color scheme from four pre-
defined styles as shown in the image below.

3. In the Palette the location of the cross hair is the color that is selected. Use the scroll bar on the right to
change the intensity of the current color palette.

4. The Home page will be displayed in the Preview section below. As you change the colors of the various
page elements the display will update and show you the new color scheme.

5. When your color changes are complete, click the Save button to update your website. 
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6.6 Website Specials

Specials Setup
The update process for the Menu content Specials link is not the same as the process for your other web
pages. Currently you must select from two Link Action options; 

· Show Price Level 1 Sale Items – This option will display all the items from your main entrée system
which have been defined in the “Sale Pricing” tab of Inventory File Maintenance.

· Link to Uploaded Document – This option allows you to select a file from your computer to upload for
the Specials link content. 

The uploaded document will be the only information the Specials link opens. Some examples of documents
you can upload are: 

§ A sheet listing your sale items with/without images in PDF file format.
§ A picture of products with file format JPG, JPEG, GIF, or PNG.
§ HTML files.
§ Notepad files.

 To ensure that your customers can view your Specials link document, Word, Publisher and
Excel files need to be converted to PDF file format before uploading. 

PDF files will readily open in a new window of the browser when the customer clicks on the Specials link.
However files from other software packages require the customer to have that software installed on their
computer to view your Specials document.
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Specials Link Setup Process 

1. Click the Website tab, and then click the Content button. 

2. Click on Specials in the Menu folder of the Content list on the left. 

3.  The document currently uploaded to the Specials link is shown in gray text in the Document file name
selection box. 

4. To add new information to the Specials link select a Link Action from the drop down list. Your options are
Show Price Level 1 Sale Items or Link to Uploaded Document.

5. If you select Show Price Level 1 Sale Items go to step 7 to save.

6. If you select Link to Uploaded Document

a. Click the Browse   button.

b. The Choose File to Upload pop up box displays. Select the desired file from your computer. Click

Open .

c. Click the Upload   button. 

d. Once the file has uploaded go to step 7 to save.

7. Click the Save button to save your changes and update the Specials link content in your website.

Back: The Website tab Specials Setup screen Link to Upload Document selected.

Front: When you click the Browse button the Choose File to Upload pop up box displays. Find and select
your file and click Open.
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6.7 Website Banner Editor

  The new "Banner" editor allows distributors to upload up to six images of their own to be used in the
scrolling image banner on the website. Be sure to clear the cache of your internet browser to see the new
banner images in your website instructions follow this section. 

1. Click the Website tab, and then click the Banner button.   

2. Select a Slide Image you want to replace with an uploaded image from your computer, the supported
image formats are JPG, JPEG, GIF and PNG.

3. Click the Browse  button and then the Open dialog box will display.

4. Locate the desired image file on your computer, click on the image file to select it.

5. Click the Open  button. 

6. Click the Update Changes button.

7. The image file will now be uploaded and display in the selected slide image area. 

8. Repeat the process for all the slides where you want to replace the stock images.

 You must have six images loaded into the banner editor. If you have less than six of your own
images and do not want to use the stock images, upload a few of your images twice to fill the empty image
slots.
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Clearing  the Browser Cache after Website Banner Updates
Once you have clicked the Update Changes button and replaced any images in your website banner you
must clear the cache of your internet browser to see the new banner in your website. 

· If your internet browser is Internet Explorer:

a. In the browser menu click Tools > Delete Browsing History.
b. The Delete Browsing History dialog box will display.
c. Check the box next to Temporary Internet Files in the list and click Delete.

· If your internet browser is Mozilla Firefox:

a. In the browser menu click Tools > Options > then the Options dialog box will display.
b. Click the Network tab > go to the Offline Storage section > click Clear Now.
c. When the clear operation is complete click OK.

· If your browser is Google Chrome:

a. Click the customize button .
b. In the menu select Tools.
c. In the next menu select Clear browsing data...

· Now that the temporary files in the cache have been deleted view your website in your browser to see your
banner changes.

* Google Chrome is a trademark of Google Inc.

* Internet Explorer are either registered trademarks or trademarks of the Microsoft Corporation in the United States and/or other

countries.

* Mozilla Firefox is a registered trademark of Mozilla Foundation.
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6.8 Social Networking

   A new "Social" feature has been added to allow you to integrate Twitter and Facebook feeds into
your entrée.NET website home page. The use of social networking is completely optional in your entrée.NET
website. The choice of which social networking options you add to your website are up to your discretion.
Below is an overview of the links and feeds features to get you started with social networking. If you have the
time you can explore more advanced social networking options for your company website in both Twitter and
Facebook. For more information about your options read the Social Networking Feeds section of this
chapter.

This feature supports the automatic creation of a "Follow Us" icon and the ability to pull in a feed for your site
from these two social networking services. To create a "Follow Us" link enter your Twitter page URL into the
"Twitter Link" text box or enter your Facebook page URL into the "Facebook Link" text box. 

                                                                                     

Optionally you may enter a feed code provided by either service into the "Widget Code" text box to display
your tweets and Facebook status updates directly on the website in addition to the "Follow Us" link. 

                           

What is a Username?
A username is usually a name that a person chooses to go by when registering for a website or program, as
an alternative to their real name. It is a unique word that only one person can use. Usernames are usually
assigned passwords for security purposes.

You can customize your Facebook and Twitter accounts by selecting unique usernames for your business
when you first create your account. In Facebook your username will appear in the location bar of your browser
after "http://www.facebook.com/" in the Profile page. In Twitter your username is the text following the “@” at
the top of your Facebook Profile page.
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To access entrée.NET social networking features
1. Login to entrée.NET as the administrator or website manager.

2. Use menu path: Website tab > click the Social button.

3. The Social Networking Links Setup section will be displayed. This is where you will paste the Facebook
or Twitter links and/or widget code.

Adding a Facebook Link to your entrée.NET website 

1. Login to your Facebook account.

2. Click the Profile button in the top toll bar.

3. Go to the Contact Information section.

4. Left click and copy the link information in the Facebook field.  You should see “facebook.com/username”
where username is your Facebook account username.

5. Paste this code into the Facebook Link text box.

6. Now edit the link information in the text box. Click in the beginning of the text box and add “http://www.”
in front of the text you just pasted. This will complete the Facebook link address.

7. When complete it should look like this: http://www.facebook.com/username where username is the
username on your Facebook account. 

8. Click the Save Changes button when done.
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Adding a Twitter Link to your entrée.NET website

1. Login to your Twitter account.

2. Your Twitter Link code is "http://www.twitter.com/username" where "username" is the username on your
Twitter account. 

3. Copy the link above and substitute your Twitter username in the text. Then paste the corrected text in the
Twitter Link field in the Social Networking Links Setup section.

4. Click the Save Changes button when done.

6.8.1 Social Networking Feeds

Once you have created an account in Facebook or Twitter you can use their plugins for your entrée.NET
website home page. You can add as many links as you would like on your website home page in the Social
Networking Links Setup section of the Social button feature in the Website tab of entrée.NET. 

· Options available for the Facebook Widget Code field in entrée.NET
1. If you already have an RSS feed on your company website copy this code and paste it into the Facebook

Widget Code text box.

2. Activity Feed Plugin: The Activity Feed plugin displays the most interesting recent activity taking place
on your site.

Link to the Activity Feed Plugin: http://developers.facebook.com/docs/reference/plugins/activity/

3. Like Button: The Like button lets a user share your content with friends on Facebook. When the user
clicks the Like button on your site, a story appears in the user's friends' News Feed with a link back to
your website.

Link to Like Plugins: http://developers.facebook.com/docs/reference/plugins/like/

4. Badges: The "Find Us on Facebook" badge provides your business a way to promote your Page off of our
website, and help direct your customers to your presence on Facebook. 

How to access Profile Badges  

a. Login to your Facebook account.

b. Click the Profile button in the top menu bar.

c. In the column on the left at the bottom click the Add a Badge to Your Site link. 

http://developers.facebook.com/docs/reference/plugins/like/
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5. Facepile: The Facepile plugin displays the Facebook profile pictures of users who have liked your page or
have signed up for your site. 

Link to the Facepile Plugin: http://developers.facebook.com/docs/reference/plugins/facepile/

Adding your Facebook Widget Code to entrée.NET
1. Login to your Facebook account.

2. Once you have decided which feed to use in Facebook. Use their plugin to generate the source code for
your feed.

3. Copy the source code from Facebook and paste it into the Facebook Widget Code text box. 

4. Click the Save Changes button when done.

Adding your Twitter Widget Code to entrée.NET
1. Login to your Twitter account.

2. To view “FOLLOW US” on Twitter buttons click
the Resources link at the bottom of the
Twitter page.

3. Click the “See all Follow buttons” link.

4. At the bottom of the page click the “Follow me on Twitter” or the “Follow us on Twitter” link to change the
button text you want displayed. Click a button to select the one you want to use in your entrée.NET
website.

5. Click the button and the source code text box will pop up. 

· Here is a sample of the source code:
<a href="http://www.twitter.com/username"><img src="http://twitter-badges.s3.amazonaws.com/follow_us-

a.png" alt="Follow username on Twitter"/></a>

6. Copy the source code from Twitter and paste it into the Twitter Widget Code text box. 

7. Click the Save Changes button when done.

* Facebook Terms and images from Facebook © 2011 http://w w w .facebook.com  

* Tw itter images http://tw itter.com/ © 2011 Tw itter 

http://developers.facebook.com/docs/reference/plugins/facepile/
http://www.facebook.com
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6.9 Website Backgrounds

    The "Website" tab background feature gives you the ability to change your entrée.NET website
background image. The images files types supported in this feature are jpeg, jpg, gif and png. 

Access this Backgrounds feature
1. Login to entrée.NET as the administrator or website manager.

2. Use menu path: Website tab > click the BG button.

How to update your website background
1. Click the "BG" button and the Website Background Editor screen is displayed. You have two options

available to you for selecting background images, our stock images or upload your own images.

2. For stock background images:  

a.  Click the Select button for the desired background image.

b.  Click the Update Changes button to save your website background.

3.  To upload your own background images:

a. Click the Browse  button and the File Upload dialog box will display.

b. Locate the desired image file on your computer, click on the image file to select it.
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c. Click the Open button. 

d. The image file will now be uploaded and display in the Current Background Image area. 

e. Click the Update Changes button to save your new website background.

 Here is a sample of an uploaded image in the BG screen and with the website home page
with a new background. Both the stock and uploaded images will be tiled in the website background.

  

    

 Some images you upload may not work well as website backgrounds. After you update your
website background from images you upload, you should open your web browser to check your website home
page. If it does not look good try another image or use a stock image. Try to keep the images for your
background simple and similar to the stock images provided. 
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6.10 Website Email List

  The "Website" tab Email List feature allows you to add a 3rd party mailing list sign-up widget to
the sidebar of your website. Just add the mailing list "widget" code HTML from your 3rd party mailing list
provider, such as Constant Contact, to enable the feature.

Access the Email List feature
1. Login to entrée.NET as the administrator or website manager.

2. Use menu path: Website tab > click the Email List button.

3. Sign in to your 3rd party mailing list provider, like Constant Contact. Create and customize a Join My List
box. Then copy the  "widget" code HTML they provide for your account and save it in a text file on your
computer.

4. Paste the "widget" code HTML into the Constant Contact Widget Code box as shown above. 

5. Click the Save Changes button.

6. The widget from your 3rd party provider will then be displayed in the right hand sidebar of the website Home
page. 

 A sample of HTML code has been included in the image above. Your code will be copied from
your account with your mailing list provider and may look different. Please visit www.constantcomtact.com
for more information about Constant Contact and creating email marketing campaigns.

* Constant Contact is a registered trademark of CONSTANT CONTACT,INC. Corporation.
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6.11 Contact List
The Contact List feature is used to populate the contact information to be presented on the Contact Us page of
your website. Enter the information about the people in your business who will be the customer contact points.

· Tools: 
§ Add New Contact  
§ Edit Contact   
§ Delete Contact

· Order - Sets the order contacts are displayed in the list. Blank defaults to last.
· Name - Contact's name.
· Title - Contact's job title.
· Phone - Contact's phone number.
· Fax - Contact's fax number.
· Email - Contact's email address.

Creating a Contact List

1. Click the Website tab, and then click the Content button. 

2. Click on Contact Us in the Pages list.

3. In the Page Mode drop down menu select Contact List.

4. The Contact List page will display with your current contact list information. 

5. To add to your contact list click the Add New Contact button.

6. The Contact dialog box will display.
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7. Enter the following information:
a. Name - contact name.
b. Title - contact title.
c. Phone - contact phone number.
d. Fax - contact fax number.
e. Email - contact email address.
f. Add a photo to the contact card if you desire.

Click Browse, select the file then click Upload.
g. Sequence - an assigned numerical value

representing the order of the contact in the list.
h. Bio / Additional Message - Add any information

here to assist with communications with your
customers.

8. Once all the information is entered click Save.

9. Repeat steps 5 - 8 until all your contacts have been
entered into the system.

The Contact List information above as it looks in the website Contact Us page.

Editing a Contact
1. When the Contact List page is displayed click on the desired contact name in the list.
2. Click on the Edit button in the menu bar or click the Edit icon in the tools column on the far left.
3. Click Save in the Contact dialog box when your updates are done. 

Deleting a Contact
1. When the Contact List page is displayed click on the desired contact name in the list.
2. Click on the Delete button in the menu bar or click the Delete icon in the tools column on the far left.
3. Click OK in the delete confirmation dialog box. 
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Contact Email Feature
Emailing your company contacts just got easier for your customers and prospects. When visitors to your
website Contact page click the email address of a company contact an Email our Staff  form will be
displayed. The visitor simply needs to fill out the form, enter the security code displayed and click the Send
Request button. Now the pre-addressed email message is on its way to your contact.

 The website has been modified so email addresses are more difficult for spammers to retrieve by
crawling your web pages. This will help to eliminate junk email from your company email system.



Chapter 7
Scheduler/Data Export/Order

Import
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7 Scheduler/Data Export/Order Import

entrée V4 SQL - Export / Import / Item Tags
In entrée V4 SQL the entrée.NET icon and drop down menu are activated in the Add-Ons ribbon menu for
customers who have purchased the entrée.NET add-on module.
  

entrée V4 SQL entrée.NET Options
· Import Orders

· Import Prospects 

· Export to entrée.NET

· Item Tags

· Import Orders - Processing orders from your entrée.NET system quickly and efficiently is essential for
business growth. The main entrée system has an import utility to take care of this process for you in the
Invoicing menu.
 
There is support for printing Loading Sheets when importing orders from entrée.NET. This feature must be
enabled in the "entrée.NET Options" configuration dialog located in the Additional Features section of the
System Options tab in System Preferences. Refer to the Using the System Menu chapter for details about
updating the configuration in the Additional Features section.
 
When the option is enabled the Loading Sheet for invoices created from entrée.NET orders will automatically
be printed to the configured "Loading Sheet" printer as part of the order import process.

   
· Import Prospects - You have the ability to generate new customer accounts from the entrée.NET

"Prospects" feature. The purpose of the “Prospects” feature is to provide the distributor with a set of tools
which can be used by the distributor and your salespeople to manage and prepare quotes for potential
customers.
 
Prospects which have been flagged for conversion to customers in entrée.NET can be imported by selecting
"Import Prospects ..." from the "entrée.NET" menu.

 
· Export to entrée.NET - Ensuring that the information in entrée.NET is synchronized with the main entrée

system can be a time consuming task. The entrée.NET Scheduler works with the entrée export utility to
automate this process for you.
 
It can be set to update your entrée.NET system as often as every hour. Once the entrée.NET Scheduler is
set up and enabled you can be sure you are providing your customers and salespeople with an updated
catalog, with accurate prices and product information.
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The export process supports sending the correct shipping address for "One Ship" customers. Full support for
a "One Ship" addresses is built into the system.

· Item Tags - The "Item Tags" utility is located in the Add-Ons ribbon menu entrée.NET drop down menu. It
allows you to maintain a list of item tags for use on the .NET Tab in Inventory File Maintenance.

The "Item Tags" feature provides an
alternative method for grouping items in the
entrée.NET system which is independent of
their "Class" values.

 

 This feature could be used
to identify all Kosher or Gluten-free items
regardless of how they are normally classified
in entrée itself. An item may also have
multiple tags associated with it.
 
Use the Add, Edit and Delete buttons to
make changes to your master Item Tag list.

For more information about the Add-Ons
ribbon menu entrée.NET feature go to:
entrée V4 SQL KnowledgeBase the entrée
V4 SQL System Guide KnowledgeBase.

entrée V4 SQL Export to entrée.NET
1. Sign-in to the entrée V4 SQL system.

2. Go to the Add-Ons ribbon menu and click the entrée.NET icon drop down menu.

3. Select Export to entrée.NET and the export will run. 

4. The entrée.NET Version 3 Export Utility dialog box will display. 

5. Enter your username and password to sign-in to your entrée.NET account. 

6. Click Next to continue.

7. The rest of the steps are the same as the entrée V3 manual export process later in this chapter.

http://www.necs.com/eV4SQL_KB/
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entrée V3 - Import / Export
Ensuring that the information in entrée.NET and the Electronic Order Pad are synchronized with the main
entrée system is accomplished using the entrée.NET Scheduler. The Scheduler works with the entrée
export utility to automate the export, update and order import processes for your company. 

The System Administrator will use the entrée.NET Scheduler utility to setup a daily schedule of data exports
from entrée as well as order imports from entrée.NET. This will take care of synchronizing the data in all three
systems. The entrée.NET Scheduler should be run on a computer with Internet access.

entrée.NET Scheduler utility can be set to update your entrée.NET system and the Electronic Order Pad 
as often as every hour. Once the entrée.NET Scheduler is set up and enabled you can be sure you are
providing your customers and salespeople with an updated catalog, with accurate prices and product
information.  

 After you install entrée version 3.5.1 or later the entrée.NET Scheduler is automatically placed
in your Windows Start menu.  

Processing orders from your entrée.NET system quickly and efficiently is essential for business growth. The
main entrée system has an import utility to take care of this process for you in the Invoicing menu.     

 
 

The Export to entrée.NET and Import Orders utility are located in the Invoicing menu in the main entrée
system.
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Support for Matrix Code Pricing
The entrée.NET Export Utility in the main entrée system can export the data required to support Matrix
Code Pricing and update entrée.NET and Electronic Order Pad (requires entrée version 3.6.8 or later). 

Matrix code pricing requires distributors to assign matrix codes to each of their item's and to each of their
customers in the main entrée system. 

Markup percentages are then defined, using the entrée Price Matrix utility. The markup % of the item is
determined by the percentage value found at the point in the matrix where the customer and item matrix code
intersect. The markup % is then applied to item's base cost to determine the unit price. 

· For more information about Matrix Code Pricing please consult the entrée V3 Knowledgebase in our
website. 

http://www.necs.com/knowledgebase/
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entrée - Support for Special Order Items
Special Order Items are items that are not regularly carried in your warehouse. These items must be handled
differently and may require deposits upon order. Additional time is also needed for the item to be delivered to
you and then the customer. A Special Order Items check box on the Misc 1 tab in the Inventory File is where
you designate the item as Special Order. These items will also be exported to entrée.NET and Electronic
Order Pad for display in your product catalog. 

entrée V4 SQL

entrée V3

· When salespeople are logged in and working with Special Order items in entrée.NET and Electronic Order
Pad they will be displayed in your product Catalog tab screen with a red background color.
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After selecting with Special Order items in entrée.NET and Electronic Order Pad they will be displayed in
your product Catalog tab screen using a blue background for the item with a Special Order Item message
below it with a yellow background color as seen here (requires entrée 3.6.7 or later).  

· For more information about Inventory File Maintenance please consult the entrée V3 Knowledgebase in
our website. 

entrée V3 - Export to entrée.NET
This section will detail how to do a manual export of your data from entrée V3 to your remote entrée.NET
server. 

· For entrée V4 instructions see the entrée V4 SQL Export to entrée.NET topic at the beginning of this
chapter.

1.  Sign in to your main entrée
system. 

    Use menu path: Invoicing >
entrée.NET  > Export to
entrée.NET 

2.  The entrée.NET Export Utility
dialog box will display. Enter
your username and password
to sign in to your entrée.NET
account. Click Next to
continue.

http://www.necs.com/knowledgebase/
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3. Check the Resend item and
class images option if you
have updated images for
item/class in entrée.  

 The maximum
image size supported by
entrée.NET has been increased
to 550 x 550 pixels.

Your customers may now click
on item images in the grid or on
the "Item Information" pop-up
window to view a larger version of
the product image. 

· Images can be added to items in the main entrée system via the Misc2 tab in Inventory File
Maintenance. Then you must run a "Standard Update" export and check off the "Resend item and class
images" option to send new images to entrée.NET.

4. Now select the data you wish to transmit to entrée.NET. Use the Export Mode drop down menu to make
your data selection. 

· Standard Update This option will export ALL your customers, items, pricing and sales history
information. Use this option if you are using entrée.NET for order entry.

· Catalog Update This option will only export item information. No pricing information will be transmitted.
Use this option if you are only using the public catalog or need to publish just item updates.

· Sales Update This will only transfer pending invoice changes.

· On Hand / Credit Hold Update
This option will only export item
inventory "On Hand" quantity
and customer credit hold status.

· 13 Month Sales History
Update This option will export
13 months of invoice sales data.
This option only needs to be run
once to provide history for the
online customer report system.
These updates are included with
the "Standard Update" export
option.

5. Click Next. The export utility will now begin exporting and transmitting your data. The progress of your
export will be displayed using the blue bars.
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6. Once the export utility is done the
Completed dialog box will display to
confirm the export. 

 
Click OK.  Your current data is now
loaded in entrée.NET. Your system is
ready for customers to place their
orders.    

entrée.NET Export Utility Advanced Options
The "Advanced Options" button in the export utility allows you to clear out selected sections of the new
change tracking file. 

WARNINGS
1. Do NOT use the Advanced Options unless NECS Tech Support directs

you to use it! 
2. Use of this option will delete the table data that is checked. 

entrée V4 SQL
1. Use menu path: Add-Ons ribbon menu > click the entrée.NET icon drop

down menu > Export to entrée.NET > sign-in > Advanced options button.

2.  Then check the table data in the Advanced Options dialog box shown on
the right. Choose from A/R, Special Prices, Level Prices, Items, Item
Promotions, Brand Promotions, Customers, System Comments and Lot
Detail.

3.  Click the Clear Selected button. It will run. 

4.  Click Close when done. 

5. Now for Export mode select "Standard Update" from the drop down list.

6. Click Next. The export utility will now begin exporting and transmitting your
data. The progress of your export will be  displayed using the blue bars.

7. Once the export utility is done the Completed dialog box will display to
confirm the export. Click OK.  

entrée V3
1.  Use menu path: Invoicing > entrée.NET > Export to entrée.NET > sign-in > Advanced options button.

2.  Then check the table data in the Advanced Options dialog box shown on the right. Choose from A/R,
Special Prices, Level Prices, Items and Customers.

3.  Click Close.

4. Then for Export mode select "Standard Update" from the drop down list.

5. Click Next. The export utility will now begin exporting and transmitting your data. The progress of your
export will be  displayed using the blue bars.

6. Once the export utility is done the Completed dialog box will display to confirm the export. Click OK.  
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entrée V4 SQL - Inventory .NET Tab Options
The options related to the entrée.NET add-on module including Item Tags and the “Exclude item from export” to
.NET check box are located on the Inventory ribbon menu > Inventory option > find the item > .NET Tab.

· Exclude item from export - NECS has built into the main entrée system the ability for you to exclude any
of your inventory items from export to your entrée.NET online ordering system. Check the box to activate this
option. Reference the entrée.NET Administrator's Guide chapter  Scheduler/Data Export/ Order Import / for
detailed information.

· Exclude item from public website catalog - This option has been added to be used to tailor the items
listed in your public website catalog since you may not want every item you sell to be shown. When this
option is checked that specific item will still be listed during order entry for salespeople and for logged-in
customers in entrée.NET and the Electronic Order Pad, but these items will not be listed in your public
website catalog.

· Restricted Item - Define items to be "restricted", as a general rule, from entrée.NET, so that they will not
appear to the customer when they are placing their order online, searching for items, etc.  However, what
makes this enhancement unique is that if the customer does have the item defined in the Customer Special
Price/Standard Order file, they will still be allowed to purchase it, and it will be displayed to them when
placing an online order.  You can use this feature for situations such as a special order item, that you
purchase for a specific customer (or group of customers), that your normal customer base is not allowed to
order. An item may be set as restricted by checking the box for "Restricted item".

· Allow item to be sold at $0.00 - Provides support for selling items at no cost to the customer. This option
has been added to assist distributors with in dealing with manufacturer product giveaways. Checking this
option on an item allows it to be displayed in entrée.NET and added to an order with no price. For
salespeople this will allow them to change the price for the item to $0.00 even if a valid non-zero price was
calculated by the system. 

Order Entry Section
· Enable .NET Min / Max Quantity Warning - For your customers placing online orders with entrée.NET,

you can now define a "minimum" and "maximum" item quantity that they are allowed to order. This feature
will allow you to enforce minimum order quantities for specific items and maximum order quantities. 

For specific items the minimum and maximum quantity numbers must be defined in the entrée V4 system first.
Follow these steps: 

1. Go to the Inventory ribbon menu select Inventory and find the item in the Inventory file.
2. Click the .NET tab.
3. Enter the Min Qty and Max Qty values and click Apply then click OK.
4. Next you must enable the min/max feature in the entrée.NET system settings. See the entrée.NET

Settings Options section of this guide for details.
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Item Tags Section
· Item Tags provide an alternative method for grouping items in the entrée.NET system which is independent

of their "Class" values. Use the  search tool to find the item tags to assigned to the item.
§ This feature could be used to identify all Kosher or Gluten-free items regardless of how they are normally

classified in entrée itself.
§ An item may have multiple tags associated with it.
§ Item Tags are assigned to items using the Item Tags search feature. 
§ The Item Tags list works similar to "Class" where defining a new tag value will automatically add it to the

list of available tags.

entrée V3 - Inventory .NET Tab Options
NECS has built into the main entrée system the ability for you to exclude any of your inventory items from
export to your entrée.NET online ordering system. 

· Follow these steps to perform the items updates in entrée V3
1. Login to your entrée V3 system.
2. Menu path: File > Inventory File Maintenance.
3. Find the desired inventory item.
4. Click on the .NET tab.
5. The options are the same as those described in the entrée V4 Inventory NET Tab Options section above.

Use the  search tool to find the item tags to assigned to the item. 
6. Once your selections are made click Apply then click OK.
7. For both V3 & V4 - Once you have completed marking individual inventory items for exclusion you will need

to export this updated inventory data to entrée.NET.  There are two ways the export to entrée.NET can be
run:

a. The entrée.NET Scheduler will export data at the next scheduled run time. 
b. Or the updates can be done immediately by following the manual directions to Export to

entrée.NET above.
§ In entrée V3 use menu path: Invoicing > entrée.NET > .
§ In entrée V4 SQL use menu path: Add-Ons ribbon menu > entrée.NET option drop down

menu > Export to entrée.NET.
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7.1 Importing Orders / Prospects
entrée V4 SQL - Imports
1. Sign-in to entrée V4 SQL.

2. Go to the Add-Ons ribbon menu and select the entrée.NET option drop down menu.

3. Select either Import Orders or Import prospects. 

4. The rest of the steps from # 3 for V3 that follows will be the same.

entrée V3 - Imports
To process your customer orders from entrée.NET, you need to monitor your order submission emails and
import orders as needed into the main entrée system.

1. Sign-in to the main entrée
V3 system.  

2. Use menu path: Invoicing >
entrée.NET  > select either  
Import Orders or Import
prospects. 

3. An Import progress box will
display while the selected
import automatically runs.

4. When the import is done the
progress box displays “Order
import completed.”. 

 If no new Orders or Prospects are available for import then one of the messages here will be
displayed.
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5. The Order Import Detail report is displayed with the results of the import process. 
    Use the Print Report button to generate a .pdf file to print or save the report. This report can be used to

reconcile any order import problems by checking the Result column.

The .Net Prospect Import Report will automatically bring you to the entrée Re3 report generating system.
Here you can print a hard copy of the report or create a report PDF file to save or email. Below is an
example of the PDF report.

 Refer to the Prospects Tab chapter to learn about the conversion process required for preparing a
Prospect for import into the main entrée system.

6. Once the orders are imported each customer will receive a confirmation email thanking them for their order.
The email also contains the order number, assigned invoice number and a link to view their order. 

Importing New Orders Automatically 
Instructions for this task are located in the entrée.Net Scheduler section which is next in this chapter.
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7.2 entrée.NET Scheduler
entrée V4 SQL 
The entrée.NET Scheduler is automatically placed in your Windows Start menu after you install entrée
version 4. Everything in the scheduler will work the same as documented below for entrée V3. 

entrée V3
The entrée.NET Scheduler is automatically placed in your Windows Start menu after you install entrée
version 3.5.1 or later.

The entrée.NET Scheduler is a utility used to create a daily schedule of automated processes that will export
data from the main entrée system into entrée.NET and the Electronic Order Pad. Implementing the
Scheduler will make maintenance of the data in your entrée.NET and the Electronic Order Pad systems an
effortless process. The scheduler should be run on a computer with Internet access.

· To go to the entrée.NET Scheduler from your computer desktop use menu path: Start > All Programs >
entrée.NET Scheduler.  

 

File Menu
· Disable Scheduler / Enable Scheduler – To stop Scheduler activity select Disable Scheduler in the

File menu. When you want to resume running your Scheduler then click Enable Scheduler in the File
menu.

· Clear Log – Clears the contents displayed in the Log tab of the Scheduler.
· Run at startup – Tells the Scheduler to automatically start

when your computer is booted up.
· Minimize to Tray - The scheduler window will appear in the tray

at the bottom of your computer screen. When the Scheduler is
minimized to your tray the window name displayed is
“netsched”.

· Exit – Closes the Scheduler Utility window.
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Help Menu      
· About – Displays the version of the Scheduler software on your

computer.

 

Schedule Tab

   Add New Task

1. From your computer desk top use menu path: Start > All Programs > NECS > entrée.NET Scheduler

2. The entrée.NET Scheduler dialog window will display.

3. Click on the Schedule tab.

4.   Click the Add Task
button to add a new task
to your Scheduler. 

The Add New Task
dialog box will be
displayed.

     
5.  Select your Company (only if there is more than one) from the drop down list.
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6.  Select the Export Task from the drop down list.  

· Standard Update - This option will export ALL your customers, items, pricing and sales history
information. Use this option if you are using entrée.NET for order entry.

· Catalog Update - This option will only export item information. No pricing information will be
transmitted. Use this option if you are only using the public catalog or need to publish just item
updates.

· On Hand / Credit Hold Update - This option will only export item inventory "On Hand" value and
customer credit hold status.

· Order Import - This option will import orders marked as complete from the entrée.NET server including
orders from the Electronic Order Pad.

7.  Select your Start date by using the arrow to view the drop down calendar.  

8.  In the Repeats section on the far right
use the up and down arrows to set
the Start time for your task.  

a. Click on the hour value and use the up and down arrows to find the desired hour. 
b. Then click on the minute value and use the up/down arrows to set the minutes.  
c. Then click on the AM or PM to set a new value using the arrows.

9.  Set the Repeats every value by highlighting the
current number of times value and type a new
number.

10. Set the Time Period value by using the drop down
list. Select from Hour(s), Day(s) or Week(s).

 
11. Click OK when you are done. The new tasks will be added to the Schedule tab as displayed below.

You can now use the Edit or Delete buttons to modify tasks in the Schedule tab. 

The entrée.NET Scheduler seen below has three tasks in the schedule to run at different intervals and
times.
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Importing New Orders Automatically
1. To enable automatic import of new orders into your main entrée system use menu path: Start > All

Programs > NECS > entrée.NET Scheduler. 

2. The entrée.NET Scheduler dialog window will display.

3. Click on the Schedule tab.

4. Click the Add Task button to add a new task to your Scheduler. The Add New Task dialog box will be
displayed.

5. In the "Export Task" options list select "Order Import".

6. Select a Start date.

7. Fill in the Repeats every options as required for your business. 

8. Click OK. The new task will be added to the Schedule tab.

  When an order has successfully been imported by this feature a notification e-mail will be sent to
the e-mail address(es) that are configured to receive order notifications.
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   Editing Tasks
1. From your computer desk top follow this menu path: Start > All Programs > NECS > entrée.NET

Scheduler
2. The entrée.NET Scheduler dialog window will display.
3. Click on the Schedule tab.
4. Click the Edit Task button to open the Edit Scheduled Task dialog box.
5. Follow steps 5 – 10 from Adding New Tasks procedure to complete the process.
                      

  Deleting Tasks
1.  From your computer desk top follow this menu path: Start > All Programs > NECS > entrée.NET

Scheduler
2. The entrée.NET Scheduler dialog window will display.
3. Click on the Schedule tab.
4. Click the desired task then click the Delete Task button. The task is now removed from the Schedule

tab.

Scheduler Log Tab
The Log tab provides a record of the activity of your entrée.NET Scheduler. Use the Log record to verify the
status of updates from the main entrée system. Information here can be cleared by using the Clear Log
option in the File menu. 

 When you see the status of “Heartbeat”, this means the Scheduler did a check and
communications with the server are working properly.



Chapter 8
Email Account Settings
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8 Email Account Settings
If you are using the entrée.NET option which includes a website for your company, then this chapter will be of
special importance to you.

When you have your own website, such as www.mydistributingcompany.com, you can have email addresses
that use your domain name. So instead of using AOL, MSN, YAHOO, GMAIL, etc. (ex: myname@aol.com) for
your email, you can have your own professional email address. 
An example would be: myname@mydistributingcompany.com.

Included with your entrée.NET website package is the ability to create 10 email accounts for your company. If
you need more email accounts, please contact NECS. 

The goal is that all they key people in your organization will have their own private email addresses, as well as
more general email addresses such as   sales@mydistributingcompany.com or
service@mydistributingcompany.com.
These general types of email addresses can be used by groups of your employees, rather than just one. You
will be using an online web service or “control panel’ called “Plesk” to manage your email accounts.

Before you begin to set up your email accounts in the Parallels Plesk Panel you will need to gather
some information.

1. Make a list of the email accounts you will need to create for your business. You have 10 email accounts at
your disposal. As you create the email accounts write down the passwords you have assigned next to
each for your records.

2. You will need the following information about your ISP (Internet Service Provider):

a. The name of your Outbound Mail Server (SMTP), for example:  “smtp.comcast.net”.

b. The type of mail retrieval server on your ISP, either POP3 or IMAP is acceptable.

3. Your inbound mail server will be: mail.mydistributingcompany.com (where you will substitute
“mydistributingcompany.com” with your actual website domain name.)
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Plesk Control Panel Login 
The person who will function as your System Administrator will have access to the email administration panel
that has been set up in Plesk by NECS. Plesk is used to manage your email accounts. To create and edit the
email addresses you would like to use, you need to login to your “Parallels Plesk Panel”. 

The System Administrator login process is as
follows: 

1. To get to your Plesk control panel type the
following URL into your browser: 
http://cp.mydistributingcompany.com 
(where you will substitute the
“mydistributingcompany.com”  with your actual
website domain name.)

2. Enter your domain name as described in step
1 above for the Login field and the Password
provided by NECS. 

3. Select an Interface language if you desire. The
default setting is U. S. English.

How to Create the Administrator’s Mailbox 
1. Login to your “Parallels Plesk Panel” as

detailed above.

2. You will see your domain name and IP
address displayed on the Home page.

    Use menu path:  Home > Create Mail
Account. 

3. In the Mail Account field your domain name is shown to the right of @ sign, (in the example below
entrée.net is the domain name.) Just enter the desired name for the mailbox here. 

This can be, for example, your first name and last name separated by a dot, a department name, or any
other text in Latin symbols. The name should be short enough to remember. It can comprise
alphanumeric, dash, dot and underscore symbols.

4. Specify a New password and Confirm password that will be used to access your mailbox. 

5. Be sure to check Mailbox.

6. Click Finish. A message confirming the creation of the mailbox is displayed. You are now in the control
panel for that mailbox. 
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Left image: To create your mailbox the only settings required are indicated in red.
Right image: The screen displayed after the mailbox creation process has been successfully completed.      

Creating Mailboxes for Other Users 
1. The System Administrator will login to the “Parallels Plesk Panel” for your domain. Use menu path:

Home > Create Mail Account. 

2. In the Mail Account field the domain name is shown to the right of @ sign, (in the example below
entrée.net is the domain name.) Just enter the desired name for the mailbox here. 

This can be, for example, user's first name and last name separated by a dot, a department name, or any
other text in Latin symbols. The name should be short enough to remember. It can comprise alphanumeric,
dash dot and underscore symbols. Examples of full email addresses:   
                                                                                     

Department mailbox: sales@mydistributingcompany.com  
Employee mailbox: angela.zelos@mydistributingcompany.com  

3. Specify a password that mailbox owner will use for accessing his or her mailbox.

4. Specify the settings related to the appearance of user's control panel, if desired: interface language, theme
(skin), the limit on number of characters that can appear on custom buttons placed into the control panel
by the mailbox owner.

5. Leave the Allow multiple sessions box checked. This will allow the mailbox owner to have several
simultaneous sessions in the control panel. 
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6. Leave the Prevent users from working with the control panel until interface screens are
completely loaded box checked. This will forbid users from submitting data or performing operations until
the control panel is ready to accept them.

7. Make sure to check Mailbox. 

8. If required, limit the amount of disk space that this mailbox and its auto responder attachment files can
use. To do this, under Mailbox quota select the Enter size option and type the desired value in
kilobytes. 

 Mailbox owners should not have access to the Plesk control panel.

9. Click Permissions in the Mail Accounts page to configure and use spam filters, antivirus, protection and
click OK.

How will my Business Access Email?
Your business has two options available for email processing. You can use WebMail accessed via a web
browser or use the mail client software running on your computers. 

What is WebMail?
WebMail is an email service accessed via your web browser. Anywhere there is an internet connection you will
be able to check your WebMail. It is not the same inbox as your mail client software running on your computer
such as Microsoft Outlook.  

Can I use a WebMail service to read and send email online?
Yes, NECS has already enabled WebMail in your domain’s account in Plesk Mail Preferences. A step by step
procedure for WebMail login is documented below.

Accessing Your Mail Using a Web Browser:
You can read your mail and compose new messages even if you are far from your home or office computer.
NECS has already provided access to the WebMail interface that is integrated with your domain. So you can
work with your email from any computer with an Internet connection and Web browser installed, or a WAP-
enabled cellular phone or a handheld computer (PDA).  
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How to Access WebMail 
1. Open an internet browser (or a WAP browser, if you are working from a handheld device).
2. Type the URL: http://webmail.mydistributingcompany.com, where “mydistributingcompany.com” is the

name of your domain. 
3. Press ENTER. The WebMail login page will open. 

4.   Type the Username and Password for your
mailbox and click Log in.

· Username - is the department or employees full
Email Address.  

      

An email address:
angela.zelos@mydistributingcompany.com

· Password - is the password for the email
account. 

· Now that the mailboxes for your business have been created on the NECS server, you will need to
set up your email client program to receive and send email through your new mailboxes.   

 

Microsoft Outlook and Mozilla Thunderbird are two of the most common email client programs used for this
purpose. You may already have one of these programs running on your business computers. Consult your
email client documentation and Help topics to get the correct update process for the software used by your
business. An example of the process to setup an Outlook email client program follows.

How to Setup Email Accounts in Microsoft Outlook 
After you've created your email accounts in Plesk, you can add this account to your preferred Mail Client, or
you can read your email using the WebMail service which is part of every hosting account. 

1. Run Microsoft Outlook on the user’s computer.
2. Go to the Tools > E-mail Accounts.
3. In the E-mail Accounts dialog box select Add a new e-mail account.
4. Click Next.
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5. The Server Type dialog box will display. 
6. Select POP3 or IMAP for your Server Type. This information comes from your Internet Service Provider

(ISP).
7. Click Next.

8. In the E-mail Account dialog box you will provide User, Logon and Server account information:

In this email account setup example the email address would actually be
angela.zelos@mydistributingcompany.com. 

The info@yourdomain.com email address was used for testing purposes only.
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E-mail Account User Information:

· Your name – Enter your first and last name
· E-mail Address - The full email address, including the domain name, of the account you created in Plesk.

E.g. angela.zelos@mydistributingcompany.com
· Mail Account represents the person’s name or a department, whatever the System Administrator

assigned. Substitute the “mydistributingcompany.com” with your actual website domain name.

Logon Information:

· Username – Is the full Email Address in User Information box above. 
· Password - Is the password you entered when you created the account in Plesk. 

Server Information:

· Incoming Mail server (POP3) - mail.mydistributingcompany.com where “mydistributingcompany.com”
is your actual website domain name.

· Outgoing Mail Server (SMTP) - Your Outgoing Mail Server (SMTP) is the same as your ISP's outgoing
mail server. Use the same setting provided by your ISP to avoid problems delivering email. 

 Most Virus and SPAM conscious ISPs now require you to use their outgoing Mail server to help
reduce the proliferation of viruses and eliminate SPAM. 

9. Now click the Test Account Settings button. An analysis of your settings will be run. Any errors will be
displayed in the Errors tab. Review and resolve any errors to continue.

 
10.  If all tests were completed successfully, then click Close. 
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11. A test email has been sent to your email account as a part of the account testing process. An example of
the email you will receive is displayed below.

12. Now you will be brought back to the E-mail Accounts Internet E-mail Settings (POP3) dialog box in step
8 above. Click Next.

13. The E-mail Accounts Congratulations dialog box displays. Click Finish.
 

 This Microsoft Outlook setup process must be repeated for each user on their business computer
for all your new Plesk email accounts. 

* Source: www.parallels.com ©Parallels Holdings, Ltd. 



Chapter 9
Customer Setup
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9 Customer Setup
When you click on the Customer Setup tab your entrée customer file is displayed. You can sort the
customer file using any of the underlined column headings in ascending or descending order. In the image
below the customer file was sorted by Login Name to view all the customers that have access to
entrée.NET.

· Click the tools icon  to view the drop down menu to add or remove columns from your display. Check
the box to add a column and remove the check to delete a column from the grid. 

· Column width can be modified by clicking and dragging the right or left column border in the headings
section.

· Search for a specific customer by typing a word or letters in the Search box. Then select your Search

Mode either Match or Contains. Click the search icon  to get your search results.

· Click the edit customer icon  to view the customer’s account information. 

· To add new customers or update existing customer information use Customer File Maintenance in the
main entrée system. Follow the menu path for your version of entrée. Then the next export to
entrée.NET will update the customer information.

entrée V4 SQL - Go to the Customer ribbon menu > select the Customer option > click Add and enter

your new customer's information.

entrée V3 - Go to the File menu > select Customer File Maintenance > click Add and enter your new

customer's information.

· Support for "One Ship" Customer Configurations - Addresses for customers setup with a "One Ship"
address on the "Bill To / Ship" tab of Customer File Maintenance will now show the correct shipping
address in entrée.NET. This feature requires entrée version 3.6.9 or later. 
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"One Ship" Customer
The two images here the entrée.NET Customer Setup tab shows the same central office used for the
Billing Address for their multiple businesses and locations in the Shipping Address. This information is
maintained in Customer File Maintenance and exported from the main entrée system.

Creating a Customer Account
When a customer requests access to your entrée.NET system you will need to create an account and assign
a username and initial password. Once they have this information your customers can sign in and submit
orders at their convenience. Follow these simple steps to create your customer accounts:

1. Click on the Customer Setup tab.

2. Use the Search tool to find the customer requesting an entrée.NET account. 

3. Click the edit customer icon  to view the customer’s account information.

4. Click the Create Account button. 

 The Customer Information and Configuration sections are view only in entrée.NET. This
information must be edited in your main entrée system.

5. The Account Creation Wizard displays the Customer Account Setup dialog box.
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6.  Enter a Username and Password for your
customer in the Account section.

7. Email Address section

· Enter the email addresses where your
customer wants to receive their account setup
information and order confirmation emails.

· Send welcome email with login
instructions

Leave this option unchecked if you do not want
an email sent to the customer.

Salespeople must have Settings tab,
Salespeople Option #14, Allow Salespeople to
setup entree.NET accounts for customers,
checked to be able to use this feature.

8.  Click the second Create Account button. 

9.  Now a Customer Account Setup email will be sent, if the Send welcome email option was checked, to
your customer’s email address. Multiple email addresses can be entered for the customer by separating
the email addresses with a semi colon (;).

10. The customer’s entrée.NET
Account section will look like
the image below with a blank
Password field after account
creation.

Resend Customer Info Email
The Resend Customer Info Email button has been added to Customer Setup page. This feature gives
distributors the ability to re-send a customer their account  information including their username and password
via email.

Forgotten Password
Your customers will have the ability to use an automated process to reset their password through your
website.  The customer will go to your website or login screen and enter their username in the password reset
section. 

This action will trigger an email sent to their account email address. This email will contain a temporary
password and link to the password reset page. 
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The customer will enter their username, temporary password and their new password here. If all the information
has been entered correctly, their password will be reset in the entrée.NET system.

Website customer login area 
and Forgot Password link.

 Login screen for distributors who do not have the
entrée.NET website module with the "Forgot
Password" button.

Password Automatic Reset Process
For distributors who do not have the entree.NET website module a "Forgot Password" button has been added
to the login screen which allows customers and salespeople to initiate an automatic password reset procedure.
See the Login screen image above on the right.

1. The user will enter their username in
the password reset dialog box and
click the Reset Password button. 

2. This action will trigger the Password Reset confirmation dialog box,  click OK. 

3. Now an email will be sent to their account email address. This email will contain a temporary password and
link to the password reset page. The customer will enter their username, temporary password and their new
password here. If all the information has been entered correctly, their password will be reset in the
entrée.NET system.

Sample email message text:
You have requested to reset your account password. In order to do so we have provided you with temporary
password for your account.
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Your temporary password is: rm4zuth2
Please follow the link below to complete the password reset: http://yourNET.com.

Viewing / Resetting a Customer Password 
There will be occasions when your customer has lost their password and the password reset procedure did
not work for them for some reason.

 The new password storage system installed
with entrée.NET release 3.2.1 will allow you to
view customer and salesperson account
passwords. 

The new system uses a key based encryption
system to maintain a level of security but still

allow for viewing the passwords. 

A  process has been put in place to convert the passwords as customers and sales people login. So there will
be some delay before all passwords are viewable.

· To create a new temporary password follow these steps:
1. Click on the Customer Setup tab.

2. Use the Search tool to find your customer.

3. Click the edit customer icon  to view the customer’s account information.

4. Go to the entrée.NET Account section. Once you have created the customer’s account the Password
field will be blank.

5. Type a new password in the blank Password field.

6. Click the Update Account button. 

7. Now contact your customer by email or phone with their new temporary password. 

http://yourNET.com
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Customer Configuration Settings

 The General screen contains
the Billing Address and Shipping Address
information. 

The customer's account Configuration
information from the main entrée system
can be found below the Billing Address
area.

Configuration information includes:

§ Bill To

§ Spec. Price Cust

§ Salesperson

§ Terms

§ Use Promotions

§ Industry Code

§ Use Break Pricing

 Here is a new customer
without some of the configuration set up yet in
the main entrée system.

When the Customer file is updated with Terms 
in entrée and the export to .NET is run you see
the results on the right.
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 Setting Options for Customers
The next step in account creation requires you to set the system options for your customer in entrée.NET.
These are similar to the system options in the main entrée system. For information about all the Options see
the entrée.NET Settings chapter in this guide.

1. Click on the Options icon in the menu on the left.

2. Option Descriptions and Current Setting columns are displayed for each option.

3. Click in the Current Setting column to select the new setting from the drop down list. 

4. Option changes will update automatically.

Customer Options 
See the entree.NET Settings chapter Options section of this guide for the current Promotions and Order
Entry options lists.

  Grids
entrée.NET allows you to customize the display of column information in the Standard Order, Search and
Quick Entry Grids for your customers. 
Columns available for customer grids include: 
Item, Description, Class, Brand, Pack Size, Unit,
Weight, Qty Avail., Category, Seq., Ext. Amt,

Image, Last Price, Last Qty and Last Date. 

1. Use the Select Grid drop down menu to
choose the grid to customize.

2. Click and drag column names to reorder and
move columns to their new locations.

3. Click the tools icon  to view the drop down
menu to add or remove columns from the
display. 

4. Check the box to add a column and remove
the check to delete a column from the grid.

5. If you want to remove all the custom grids your
customers and salespeople have defined, the
click the box to “Replace all customer and
salesperson configurations for this grid. “
Leaving this box unchecked will only affect new
customers and salespeople added after you
save this configuration.
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 It is advised that you NOT CHECK this box if your entrée.NET system has been in use for a
while, as customers and salespeople will lose the grid settings they took time to customize.

6. When all your changes are complete click the Save Configuration button to save your changes.

Updating the grid configuration for a specific customer. 

Customer Registration
If you have a website or the order entry login page on the internet for entrée.NET there will be a Register link
in the customer login area. This link can be used by existing customers who would like to begin ordering online
or for new customers wanting to place orders with you. 

· Customers click the Register link and will be
presented with an online registration form. 

· Current customers will just fill in their customer number
and Salesperson name, if applicable. 

· New customers will provide all the contact information
required for you to create their new account. 
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· When the customer hits Send
Request an email is generated and
sent to you containing all their
registration information. 

· Examples of a new customer request
and a current customer request emails
follow.

· Since current customers are already in the main entrée system, just follow the steps in the Creating a
Customer Account section of this chapter to complete their request. As soon as they receive the
automatically generated welcome email with their username and password they can begin ordering in
entrée.NET.

· New customers need to have an account created in the main entrée system in Customer File
Maintenance first. Then when you export to entrée.NET the new customer record will be listed in the
Customer Setup tab. Finally follow the steps in the Creating a Customer Account section of this chapter
to finish the process.
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Email message samples

A new customer requesting an account. 
  

Current customer requesting an account.
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Disabling a Customer Account
System Administrators have the ability to disable access to their entrée.NET system. Once an account has
been disabled the Customer will no longer be able to login to entrée.NET.
  
1. Click on the Customer Setup tab.

2. Use the Search tool to find the customer.

3. Click the edit customer icon  to view the
customer’s account.

4. Click in the Disable Account check box. 

5. Click the Update Account button.

6. A "This account has been disabled" pop-up
message will display when a customer with a
disabled account tries to login.

Removing Account Disable
Once an account has been disabled to allow access to entrée.NET again:

1. Remove the check mark from the Disable Account check box.

2. Click the Update Account button.

3. Now your customer will be able to login to entrée.NET and place orders again.

9.1 Restricted Items Feature
You can now define items to be "restricted" from entrée.NET,  so that they will not appear to the customer
when they are placing their order online, searching for items, etc.  

You can also use this feature for situations such as a special order item, that you purchase for a specific
customer (or group of customers), that your normal customer base is not allowed to order.

What makes this enhancement unique is that if the customer does have the item defined in the Customer
Special Price/Standard Order file, they will still be allowed to purchase it, and it will be displayed to them when
placing an online order.  

entrée V4 SQL
1. Sign-in to entrée V4 SQL.

2. Go to the Inventory ribbon menu > Inventory option > find the item > select the .NET Tab.

3. Check the box for the "Restricted item" then click Apply.
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entrée V3
1. Login to your main entrée system.

2. Use menu path: File > "Inventory
Maintenance" > Then find the
desired item.

3. Click the ".NET" tab for the item. 

4. Check the box for "Restricted item"
click Apply.   

9.2 Item Promotions Feature

Setting up Item Promotions in entrée
The price calculation process has been updated to include support for item based promotions; "Class" based
and volume discount promotions are still not supported. 

This feature will also display the "BUY n GET n FREE" promotion if defined in the main entrée system - like
entrée this is informational only in entrée.NET and does not adjust quantities on the order. 

Support for entrée system option #86 - "Disable promotions below Selling Price" and system option #170 -
"Disable promotions for customers receiving special or bid pricing" has been included and the current settings
from entrée will automatically be applied in entrée.NET. (Requires entrée version 3.5.14+)

There is a three step process to enable the promotions for items and customers. First, promotions must be
turned on / off  for customers in the main entrée system. Customers can be updated as often as your
business requires. 

entrée V3 

· View / Update Promotions for a specific Customer
1. Use menu path: File > Customer Maintenance. 
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2. Find the desired customer > then click the
Miscellaneous 1 tab. 

3. Scroll down the Options List to find “Promotion”.
Check the box to allow promotions for that customer.
To turn off promotions remove the check. 

4. Click Apply.

5. Repeat this process for all customers requiring an update for promotions.

· The second step in this process is to define the promotions for the desired items. See the Inventory File
Maintenance Promotions Tab section of the entrée KnowledgeBase at 
http://www.necs.com/knowledgebase/ for detailed information about setting up and using promotions and
the "BUY n GET n FREE" promotion. 

 This is an entrée V3 system Promotions Tab for eggs.

· The third and final step in this process is performed once your promotions are defined and the desired
customers are updated for promotions in the main entrée V3 system. You must now export to entrée.NET
to update the system. Use menu path: Invoicing > entrée.NET > Export to entrée.NET > run a Standard
Update to export updates to entrée.NET. 

entrée V4 SQL
1. Sign-in to entrée V4 SQL.

2. Go to the Customer ribbon menu > Customer option > find the customer > select the Miscellaneous
Tab.

3. Go to the Invoicing Options list on the right side. 

http://www.necs.com/knowledgebase/
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· The second step in this process is to define the promotions for the desired items. Go to the Inventory
ribbon Inventory option > find the item > click the Promotions Tab. For more detailed information about
setting up promotions in entrée see the entrée V4 SQL Knowledgebase at
http://www.necs.com/eV4SQL_KB/.

· For step 3 in the export process for entrée V4 SQL.  Go to the Add-Ons ribbon menu > entrée.NET option
drop down menu > select Export to entrée.NET. See the entrée.NET Scheduler chapter for more detailed
information about the export/import/update process.

entrée.NET Item Promotions Overview
Information about an item’s promotional pricing will be displayed beneath the item in the order entry grids in the
same way that "Break Pricing" and "Sale Pricing" are currently shown. Here is an example of what your
customer with promotions turned on will see in entrée.NET for a promotion item. The red tag indicates there
is a special or promotion applied to the item.

To view Promotions settings for a specific customer in entrée.NET:

1. Click the Customer Setup tab > find the specific customer > click the edit icon  for the customer.
 
2. When the customer’s information is displayed click on the Options button.

3. Scroll down to the Promotions section of the page. You will see the promotions options settings listed.  
 

http://www.necs.com/eV4SQL_KB/
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The entrée.NET promotions settings for customers are taken directly from entrée Customer
Maintenance and are reset in entrée.NET whenever the Export to entrée.NET is run.  



Chapter 10
Salesperson Setup
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10 Salesperson Setup
Your sales force can take full advantage of entrée.NET when managing their customer orders. They can
access entrée.NET anywhere an Internet connection is available, whether from the office, at home or on the
road.

Once a salesperson logs on, they are greeted with a bar graph that shows the breakdown of their sales on
either a daily, weekly or yearly basis. If they are allowed access to Gross Profit information, this will be
displayed on the graph as well. NECS plans to expand our “dashboard” tools and graphs to provide your sales
force additional tools to monitor and drive sales. 

· When you click on the Salesperson Setup tab your entrée salesperson file is displayed. You can sort
the salesperson file using any of the underlined column headings in ascending or descending order. In the
image below the salesperson file was sorted by Login Name to view all the salespersons that have
access to entrée.NET.

· Click the tools icon  to view the drop down menu to add or remove columns from your display. Check
the box to add a column and remove the check to delete a column from the grid. 

· Column width can be modified by clicking and dragging the right or left column border in the headings
section.

· Search for a specific salesperson by typing a word or letters in the Search box. Then select your Search

Mode either Match or Contains. Click the search icon  to get your search results.

· Click the edit salesperson icon    to view the salesperson’s account information. 

· To add new salespeople or update existing information use Salesperson File Maintenance in the main
entrée system.

Creating a Salesperson Account
To give your sales force access to the entrée.NET system you will need to create accounts for each
salesperson assigning them a username and initial password. Once they have this information your
salespersons can sign in and manage their customer accounts. Follow these simple steps to create your
salesperson accounts:

1. Click on the Salesperson Setup tab.

2. Use the Search tool to find the specific salesperson you need to give access to entrée.NET.

3. Click the edit salesperson icon   to view the salesperson’s account information.
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4. Click the Create Account button. 

 

 a. The Salesperson Information section is view only in entrée.NET. 
b. The account setup process will allow you to change an account Username. This authorization

has also been provided to salespeople who have been given the ability to create accounts for
customers.

5. The Account Creation Wizard displays
the Salesperson Account Setup
dialog box.

6. Enter a Username and Password for
your salesperson in the Account
section.

7. In the Email Address section enter the
email address where your salesperson
wants to receive their account setup
information and emails.

8. Click the second Create Account
button. 

9. Now your Salesperson Account Setup email will be automatically sent to your salesperson’s email
address. 
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Forgotten Password
Your salespeople will have the ability to use an automated process to reset their password through your
website.  They will go to your website or login screen and enter their username in the password reset section. 

This action will trigger an email sent to their account email address. This email will contain a temporary
password and link to the password reset page. 

They will enter their username, temporary password and their new password here. If all the information has
been entered correctly, their password will be reset in the entrée.NET system.

Website customer login area 
and Forgot Password link.

 Login screen for distributors who do not 
have the entree.NET website module with
the "Forgot Password" button.
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Viewing / Resetting a Salesperson Password 
There will be occasions when a salesperson has lost their password and the password reset procedure did not
work for them for some reason. A new password storage system installed with entrée.NET release 3.2.1 will
allow you to view customer and salesperson account passwords. The new system uses a key based

encryption system to maintain a level of security but still allow for viewing the passwords. 

  Passwords will NOT be visible until they have been converted to the new storage format. A 

process has been put in place to convert the passwords as customers and salespeople login. So there will be
some delay before all passwords are viewable.

 Salespeople Options
 The next step in account creation requires you to set the system options for your salespeople in entrée.NET.
Your salespeople can view and enter orders for their assigned customers. They will see a list of their
customers, and simply need to click on the customer they would like to work with. 

§ A feature of entrée.NET is the ability for a Salesperson to enable a new customer account. In the
past, only the “Admin” (System Administrator) was allowed to create new customer accounts. Now
your salespeople can setup their own customers with Usernames and Passwords, freeing your
System Administrator to focus on other tasks. See the Settings chapter of this guide for complete
information on this topic. 

§ Other pricing options include: modifying prices on customer orders and entering prices below minimum
sell price.

§ The new Prospects feature will give Salespeople the ability to provide prospective customers with price
quotes on orders that can easily be converted to regular customer accounts later. 

§ The option to Display “Gross Profit” is used to control salesperson access to this information.

Updating Salespeople Options
1. Click the Settings tab

2. Click the Options icon in the menu on the left.

3. Option Descriptions and Current Settings columns are displayed for each option.

4. Click in the Current Setting column to select the new setting from the drop down list. 

5. At the bottom of the page is the Salespeople option section (shown in the image below).

6. Changes to Options will update automatically.

Set Options for Salespeople
· See the entree.NET Settings chapter Options section of this guide for the current options list and

explanations.
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· See the entrée Options section for a complete explanation of how to use the new  Salesperson / Broker
File Maintenance Remote Order Entry options for salespeople.
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Disabling an Account
System Administrators have the ability to disable access to their entrée.NET system. Once an account has
been disabled the Salesperson will no longer be able to login to entrée.NET.  

1. Click on the Salesperson Setup tab.
2. Use the Search tool to find the salesperson.

3. Click the edit salesperson icon  to view the
salesperson’s account.

4. Click in the Disable Account check box. 
5. Click the Update Account button. 
6. This pop-up message box will display when a 
     salesperson with a disabled account tries to

login.

Turning On a Disabled Account
Once an account has been disabled to allow access to entrée.NET again:

1. Click on the Salesperson Setup tab.

2. Use the Search tool to find the salesperson with the disabled account.

3. Click the edit salesperson icon   to view the salesperson’s account.

4. Remove the check mark from the Disable Account check box.

5. Click the Update Account button. 
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The Salesperson Price Modification Option
When a salesperson has the Allow salesperson to modify pricing option turned on they have the ability to
view the item’s pricing information in addition to making price changes in an order. This is how it works:

   
1. The Salesperson must have the Allow salesperson to modify pricing option set to Yes. 
2. Items must be in an open order or in the shopping cart to modify their prices and view the Item Price

Information. 

3. The Salesperson clicks once on the Unit Price field and the edit price dialog box displays in the Unit
Price field. A green dollar sign and the edit price dialog box will be displayed with the current price.

4. Clicking on the green dollar sign triggers the display of the Item Price Information. All the pricing
information your salespeople need for that item will be presented so they can make an informed pricing
decision.

5. Salespeople can then edit the item’s price and click off the price field to exit the edit price dialog. 
6. The price change will automatically be saved in the open order and in the shopping cart. The price will now

be displayed in green indicating that the price has been changed.
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Price Modifications Using % and Base Cost
If you have the “Allow salesperson to adjust prices by specifying a percentage over “Base Cost” option
set to “Yes”, then you will see the % and Base Cost columns in your item details as shown in the image
below. You can adjust prices by entering a percentage of base cost. The price calculation will follow the rules
defined for the "Customer Special Price Formula" in the Pricing Setup tab. In entrée V3 go to System >
Preferences and in entrée V4 SQL  go to the System ribbon menu > select the System Preferences
option.

 These calculations are made using the values available to entrée.NET at the time the order is
placed and will only lock the price on the invoice. If any cost changes take place in entrée as a result of
receiving new product or a manual cost change there is no guarantee that the margins used to create the order
in entrée.NET will reflect the final margins of the invoice.
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Editing Prices Using % Column
1. Items must be in an open order and in the shopping cart to modify their prices using %.

2. Click in the % column for the desired item and the edit percentage dialog box displays.

3.  Enter a new number for the percentage value and hit the Enter key. 

4.  The Unit Price column will update and turn green displaying the new price in the shopping cart and item

details.
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10.1 Call List Setup
Setting up the entrée.NET Salesperson Call List in entrée 
Manage the daily call lists displayed when members of your sales force login to entrée.NET. The Call List
feature will display a list of customers and scheduled call times for the day. Follow these  steps to setup your
salesperson call lists in the Customer File in entrée:

entrée V3
1. Go to the File menu into Customer File Maintenance and find the customer. 
2. Then on the Customer tab assign a salesperson to the customer using the Salesperson drop down

menu. 

3. Then in the Routes tab enter the Call Time for the desired day. 

4. Click Add then OK to save the changes in Customer File Maintenance. Update all the customers you want
added to DSR call lists.

5. The updated customer information will be sent to entrée.NET the next time the entrée.NET Scheduler
runs the Export to entrée.NET or you can manually run the Export to entrée.NET through the Invoicing
menu in entrée.   
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6. When a salesperson logs into entrée.NET they will find their customer Call List for that day on the Home
tab. 

entrée V4 SQL 
The Customer Call List Tab is used to predefine the customer's call schedule and assigned an Order Taker.

1. Go to the Customer ribbon menu and select the Customer option.

2. Find the desired customer and click the Call List Tab.

3. Click in the Call Time box for the desired days and use the time menu to set your call time. 

§ Select the best time to call the customer, for each day of the week that they are normally called
for an order.

§ The call time information is primarily used with the Call Sheet Report and the Order Taker Call List
feature of the entrée V4 Invoicing system.

4. Click in the Order Taker box for that same day and enter the order taker code assigned. 

§ The Order Taker code field is used in conjunction with the Call List button in the Create Invoice
screen of  entrée V4.

§ Enter the 2-digit code representing the order taker responsible for this customer in this field.

§ Only enter the order taker codes for the days of the week that a call time has also been defined.

5. Click in the Number of Worksheets box and adjust the number.

6. Click Add to save your call list entries for the customer.

Company Call List Grid
On the right side of the Call List Tab is the Company Call List Grid. This grid shows the company call list and
order takers for each day of the week when you select the day in the Day of the Week menu above.

· Click the Day of the Week drop down menu and select a day of the week to view all the calls by Order
Taker code for that day of the week. 

Override Options
· Enable Call Days Override - Check this option to enable the Call List Days option.
 
· Call List Days - When the Enable Call Days Override option is checked you can set the number of call list

days for the customer.
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Using the Call List Feature 

Manage your customer calls using the Call List feature. The System Administrator will update customer files
to assign salespeople to customers and set call times. See the Call List Setup section earlier in this chapter
for information.

The .NET Salesperson's View: 
When a salesperson logs into entrée.NET they will find their customer Call List for that day on the Home
tab. 

Load Customer icon  is used to view the customer’s account information.

Call Time column shows the scheduled call time from the customer file in entrée.

Last Order column shows date of the last order.

Cust # column shows the Customer number from entrée.

Company Name column shows company name.

Address 1 City column shows the street address.

Phone column shows the phone number.



Chapter 11
Message Setup
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11 Message Setup
Staying in close contact with your customers and salespeople is important in today’s fast paced business
world.  With the messaging system built into entrée.NET, you can easily stay in touch with messages that
will appear on the user’s home page as soon as they log in to the system. Messages can optionally be
emailed to recipients using the email addresses from your customer and sales account information. 

· Click on the Messages tab.

· Your previously posted messages are listed here starting with the Edit Message  and Delete

Message  tools, followed by Subject, Message text and Posted date and time. 

Posting New Messages & Emails
1. Click on the Messages tab. 

2. Click the  button and the Post Message dialog box displays.

3. Recipient: Click the button to select the recipients of the new message. 

4. Use the drop down lists for each Recipient category to select individual businesses and salespeople to
receive your message.

5. Multiple recipient options are available including Industry Codes and Territory. If you have this data set up
in your main entrée system these recipient options will be available to you here.

The Recipient Customer drop down list is used to select
a specific customer for the message.

The Recipient Salesperson drop down list is used to
select individual salespeople for the message.
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6. Email: Use the email drop down list to make your
selection. The default email option is “Do not email
recipient”. 

Your other option is “Email a copy of this message
to the recipient(s)”. This option will send two
communications to your recipients a system
message and an email.

7. Subject: Type a short description about the subject of your email. 

8. Message: Below the Subject is the area where you will type your email message.

9. Once your message has been entered, click the Post button  to send your message to the
recipients.

10. If you decide not to send the message, click the Cancel button. 

11. The message has been sent and will post on your customer’s My Account page. When the customer logs
in to the system your message is the first thing they see. 

Left image: The Post Message dialog box before you post the message.
Right image: The customer’s message posted on their My Account page after they log in.
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Managing Posted Messages 

· Delete Message  tool click this to remove unwanted messages from the posted messages list. The
Delete Message? dialog box displays then click Yes.

· Edit Message   tool is used to edit previously posted messages. There may be some messages that
you frequently send to your customers. You can save time by editing and reposting these frequently used
messages from your posted messages list. An example would be messages relating to holiday hours and
order cut off times.  

How the Edit Message tool Works with Posted Messages

1. Select a message from the posted messages list and click Edit Message. 

2. The Post Message dialog box displays
the details of that message.

3. Modify the information in the old
message to create your new message.
Be sure to change recipients, dates and
times in the message to fit the new
message’s details. 

4. Click the Post button to send your new
edited message to the recipients.

5. The Email Message? pop-up box will
display: 

      
     “Will no longer be able to edit this

message once it has been emailed. 
Save and Email?”

6. Click Yes to save and email the new message.

7. The newly posted message has now replaced the posted email message you edited in the list.

8. The new posted message has now replaced the previous message in the posted messages list. 



Chapter 12
Translation Tab
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12 Translation Tab

What is the entrée.NET Language Translator Service? 
Our new Language Translator Service will automatically translate all your Class Names, Item  Description
line 1, Item Description line 2  and Item Notes into your choice of over 50 of the most popular languages.
Having language translations in entrée.NET allows customers entering orders online to view your catalog in
their native language. 

Activating the Language Translator Service
Once you run the activation process the Language Translator license allows you to select two languages for
use in entrée.NET. You will be billed $50 monthly for the service as long as it is activated. To view examples
of the translated catalog visit the Translation Examples section of this chapter.

Translation Data Refresh
Periodically the translation process will have to be rerun for the languages you have selected to add any new
items from your catalog and update item Descriptions, Classes and Notes. This topic is covered in detail in a
section of this chapter.

 The translation process will not be perfect and some English words may not be changed on the
screen.

Translator Service Cancellation
You can easily cancel the Language Translator Service whenever you like. An email will be sent to cancel your
service and entrée.NET will automatically deactivate the language translator features.

Reminder: You can re-activate the Language Translator Service at any time.



entrée.NET Administrator's System Guide171

12.1 Activating the Language Translator Service
1. To activate the Language Translator Service the System Administrator must login to entrée.NET. 

2. Click the new Translation tab that will be in the entrée.NET main menu.  

3. When you first click the Translation tab a message box will display explaining the Language Translator
Service and the monthly fee. Click OK to close the Information box. 

4. Click the Activate Service button on the Translation tab to begin the activation process.

5. The Activate Service? dialog box will display. Respond Yes to activate the Language Translator service.  

NECS will immediately have the Language Translator service available in entrée.NET. An email
notification will be sent to you to confirm activation of the Language Translator service and the
monthly fees involved. 
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6. Next click the Language button on the left to open the language selection screen which lists the available
languages.

 

7. Check the box for the one or two languages to select them. Your Translator Service license limits you to
two languages.

8. Now click the General button. The languages you selected are listed in the selected languages box in the
center of the screen with a status of  “Not applied yet”. 

9. Now you will check the boxes for the fields you would like to be translated into your chosen languages. In
this section the number of records that will be translated for each field in your database is displayed.

Fields to select from are:
· Description Line 1
· Description Line 2
· Class Name  
· Notes

 The information in these fields comes from the main entrée system. So when the information in
entrée changes and is exported to entrée.NET you will need to run this translation process again for your
selected languages to convert the new data.
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10. Once your fields are selected you will run the translation process by clicking the 
 Add Task to Translation button.  

11. Once you click the Add Task to Translation button the Server answer message box will  be displayed. 

12. Click OK to run the language translation process. Translating and loading the fields you have selected
should take about 5 minutes or less depending on how much data must be translated.

13. While the language translation process is running look in the Translation Summary section of the screen
and you will see that the value of the Last Updated field for the selected languages will be Pending. 

The number of Descriptions, Classes and Notes that need to be translated will be shown in the Need to
Translate area in red text.
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14. Once the process has completed the Translation Summary section Translated area will show how
many fields were successfully translated for each language in green text. The Last Updated field will
display the date of the translation.

15. When the translation of your fields is done the Inventory’s descriptions available for the following
languages section at the top of  the screen will list the languages available. In our example we have
Chinese (Simplified) and Spanish. (see image above). 
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12.2 Translation Data Refresh
Periodically the translation process will have to be rerun for the languages you have selected to refresh new
data. Any new items, modifications to item notes, descriptions or classes that are imported from the main
entrée system will need to be translated. The process to update the translations in your catalog for this newly
imported data follows.  

 You are not allowed to change the languages you previously selected for translation. 

§ If you have only one language selected, you can add your second language at this time. 

§ If you have two languages you must refresh the data using those same two languages.

The Translation Data Refresh Process
1. When you first open the Translation tab you will see: 

· The languages available listed in your system in the Inventory’s descriptions available for the
following languages section at the top. 

· The Translation Summary section Translated area will show in green text how many fields were
translated for each language the last time the translation was run. 

· The Last Updated field displays the date of the last translation of your data.
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2. Click the Language button on the left to open the language selection screen. You must un-check then re-
check the same languages you translated before to re-select them. 

Reminder: You must choose the same languages or you can add a second at this time. 

3. Click the General button and you will see:

· Inventory’s descriptions available for the following languages section at the top says "No
available languages".

· Your languages are listed in the selected languages box in the center of the screen with a status of 
“Not applied yet”.

· The Add Task to Translation button has been activated.
· The number of new Descriptions, Classes and Notes to be translated during the refresh process are

shown in the Need to Translate area in red text.
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4. Now check the boxes to select the fields to be translated in the Please select fields which should be
translated for selected languages section. 

5. Click the Add Task to Translation button to start the data translation process.

6. The Server answer message box will  be displayed. Click OK to run the language translation process.
Since most of your data has already been translated before this should be very quick.

As you can see in the background screen all your fields have been listed with the languages in the selection
area.
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7. When the translation data refresh is done you will see:

· The Inventory’s descriptions available for the following languages section at the top of  the
screen will list your languages as available again.

· The Add Task to Translation button has been deactivated.
· The Last Updated field will now change and display the date of the latest translation of your data

from this refresh data process.
· The Translation Summary section Translated area will update the values to show in green text

how many fields are translated. 
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12.3 Translation Examples

· What Your Customers will see in entrée.NET 

Language Tab / Menu:  
If your customer has an account when they login there will be a new Language drop down menu. They will
use it to select from English and any of the two other languages you choose for translation. 

Once a customer makes a language selection from the Language drop down menu (above) they will see the
following changes in entrée.NET:

Catalog 
When view By Class (right) is selected the Class information will be displayed in the selected language. The
language here is Italian. 
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When view All Items (below) is selected the Description and Classes will be displayed in the selected
language. 

 

Standard Order and Shopping Cart 
The Description column and Class will be displayed in the selected language. 

In the 3 Standard Order screen examples following we have English, Italian and Chinese (Traditional)
translations for the same items in the order screen and the Shopping Cart. The Language tab displays the
current language.
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Italian 

· In the Italian screen above that “ROAST BEEF“ was not translated. Remember this is not a perfect process
but most words will be translated.

Chinese

Quick Entry & Specials 
When the item number is entered the Description and Class information will be displayed in the selected
language.  
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Product Information  
When the blue Description column link in your product catalog is clicked the Product Information box

opens. 

The item’s Description and Class information will be shown in the selected language, if those fields were
selected for translation.



entrée.NET Administrator's System Guide183

12.4 Translator Service Cancellation
You can cancel the Language Translator Service whenever you like. An email will be sent to NECS to cancel
your service. entrée.NET will automatically deactivate the language translator features when the Cancel
Service? confirmation has completed.

1. Click the Cancel Service button in the General screen of the Translation tab.

2. The Cancel Service confirmation dialog box will display. Click Yes to confirm or No to cancel deactivation
of the Language Translator Service.

3. An email will be sent to NECS to cancel your service and entrée.NET will deactivate the Language
Translator Service features automatically.

 
Reminder: You can re-activate the Language Translator Service at any time.



Chapter 13
Specials Setup
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13 Specials Setup
Everyone loves a special and entrée.NET makes it easy for you to highlight them for your customers. The
Specials tab allows you to easily manage and display weekly featured items. 

You can control whether specials will appear on your company’s website Specials page, add an image and a
description (with an NECS designed site). 

Your customers will view an informative list of all your specials, as well as see specials as they enter their
orders and receive emails that are sent automatically. Sale and break pricing information will be displayed to
customers for products that qualify while ordering.

Specials Tab   
Click on the Specials tab to view the Specials screen. entrée.NET will then display all the items from your
main entrée system that have been defined in the “Sale Pricing” tab of Inventory File Maintenance.

· Edit Extended Info button:  displays the Edit Special dialog box for the selected
item. Functions the same as the Edit Extended Info icon.

· Email Customer Specials button:  runs the dialog used to email information
about all your specials to your customers. 

· Edit Special icon: Click  to edit the special. The Edit Special dialog box will be displayed. You can
add an image and a note to the special.

· Website: Check this box if you want the special to be displayed on the Specials page of your website.

· Item #: The item number from your main entrée system.

· Description: The product description from the main entrée system.

· Note: Comes from the message you enter in the Edit Special dialog.

· Start: The start date for the item special taken from the main entrée system data.

· End: The end date for the item special taken from the main entrée system data.



Specials Setup 186

Editing Specials

1. Click on the Specials tab. 
2. Click the Edit Special icon for the item you would like to

edit.  

3. The Edit Special dialog box will display with  the item’s
information from the Specials tab.  

4. Display on website: You can also change  this setting
here.

5. You may select an alternative image to use for this item

when it is displayed on the specials. 

Adding an image to the Special item
1. Click the Browse button. 

2. The File Upload window will now open.

3. Find C:\necs\images your entrée images folder on your computer.

4. Double click to open your images folder. 

5. In the tool bar set the View(s) so you can see the images. Some browsers use “thumbnails” or “icons” in
their View(s) menu to display images. Find the desired image and click on it to select it.

6.   Click the Open button and the image will be loaded and displayed in the Edit Special dialog box. 

7.   You may enter an additional message to be displayed with the item below. Enter a message or information
about the special or the product in the message box. Use the tools above to control the font, color and
format of your message.
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8.   Once you have completed editing your Special click the Post button.

9.   Your special is now updated. It will appear in your customers Specials tab and be posted on your website
Home page and Specials page, if you checked the Display on website option. 

What will your customers see after you post your Specials?
· This is an example of what your customer would see in their entrée.NET Specials tab. 
· The “View Specials By” drop down menu allows your customers to select “Featured”, “All”, or any class

defined with specials.

 Website Specials page where your customers will find all the featured specials with the
Display on website option checked. Customers also have the option to print your product catalog from
your website.
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Emailing Customer Specials 
1. Click on the Specials tab. 
2.
3. Click the Email Customer Specials button. 

4. The Email Customer Specials dialog box displays.

5. Effective date: Use the calendar tool to select an effective date for the specials in your email. 

6. Recipient: Select from the drop down who should receive this email. Your options are: Promotion
Customers, Promotion Customers by Industry Code and Promotion Customers by Territory Code or All
Customers in the lower drop down list.

6. You may enter an additional message to be included on the first page of the PDF below:  Enter
the message you want to appear in the first page of the Sale Items Report you are emailing. 

7. Email Subject: Specials is automatically entered. You can edit the subject if you like.

8. Email Body: Enter the message you would like to send with this email.

9. Click the Preview button to see the specials PDF document that will be emailed to your customers. A
new browser page will open displaying a box with the title “Sale Items Report Preview” If you do not have
the Adobe Reader installed on your computer use the link provided to get this free software. Click on Click
the link to download the preview. In the next window click Open to view the preview.pdf file. 

10. Click the Send button to send the email to your customers.

11. Click Cancel to stop the email process.



entrée.NET Administrator's System Guide189

 Sale Items email sent to a customer.



Chapter 14
Home Tab
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14 Home Tab
When you first login to entrée.NET version 3 you will land on the Home tab. This area provides you with
important information related to customer call lists, online orders that have been placed, along with some
simple graphs to give you a visual picture of your top salespeople and customers.

Viewing Sales Graphs 

These sales graphs can access up to 13 months of sales history, from both sales recorded on your main
entrée software and on the sales from entrée.NET. 

The Home tab gives you the option to run and view one of two bar graph reports, the Top 10 Customers Sales
and Top 10 Salesperson Sales. 

How to Generate a Graph
1. Select a either “Top 10 Customer Sales” or “Top 10 Salesperson Sales.”

2. Use the calendar tool   to select the desired Start Date and End Date.

3. Choose your data Source from the drop down list.
· All – The report will use data from the entrée system and entrée.NET.
· entrée.NET- This report will only use data from your online ordering system.

4. Click the Update button to generate the graph. The new graph will now display on your screen.

 entrée.NET distributor’s Top 10 Customer Sales report.
· When you hover over a column with your mouse the customer’s name and total sales will be displayed.

 entrée.NET distributor’s Top 10 Salesperson Sales report.
· When you hover over a column with your mouse the salesperson’s name and total sales is displayed.
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Orders 
New online orders are the growth area for your business. Tracking the status of online orders could not be an
easier task. Every time you log in the Home tab presents you with a list of all your online orders. You can view
individual orders, all their information and order dates.  

View Order icon used to view the order details. 

Cust # column shows the entrée system customer number for the account.

Status column
The Status column will show you the current status of your customer’s orders:

 
· “Pending”:  The order has been completed by the customer, and is waiting to be    picked up by the

main entrée system. The .NET Order # has been assigned to this order in your entrée.NET online

system.

· “Transmitted”:  The order has sent to you, but it has not yet been confirmed.

· “Received”:  The order has been officially received into your main entrée system, and has been

assigned an invoice number.

Delivery Date column
Shows the customer’s requested delivery date. Once the order is in the “Received” status, the actual
delivery date will be posted here.  

Total column

        This column will show the total amount due on that order. Note that until the order has been officially
“Received”, the total shown will only be estimated, designated with “(Est)” next to the amount.  

        Once you have received the order, the entrée system will calculate the actual invoice total and show it in
this column.  Many factors can affect the invoice total including catch weights, sale items expiring,
inventory shortages on our side, item substitutions, fuel and delivery surcharges, etc.

.NET Order # column

        This column will show the order number that your .NET online system has assigned to this order. This
order number is only used to track online orders.  

         The “invoice number”, which corresponds to the unique number on the invoice document
sent to the customer when you make your delivery, gets assigned after the order has been “Received”.
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Invoice # column

Shows the number assigned by your main entrée system to this order. It is the same number that will
appear on the customer’s invoice document.

P.O. # column

        If you assign a Purchase Order (P.O.) number to your orders, it will be displayed here. This number you
provide, to track your purchases.

Salesperson column

Displays the name of the salesperson assigned to that customer account.

Created column

        Shows the date and time the order was created by the customer. 
 
Completed column

        Shows the date and time the order was completed. 

Confirmed column

        Shows the date and time the order was confirmed by the main entrée system.

 Open Order Purge Feature
When you have abandoned open orders that you need to remove from the system go to the Home tab Orders
area. You have the ability to purge these orders one at a time using the Purge Open Order button or By Date
using the Options menu. 

Purge an Open Order
1. In the Home tab Orders area select the open order you need to remove.

2. Click on the Purge Open Order button.(Outlined in the image below)

 

3. The Delete Open Order? dialog box will open. 

4. Click Yes to proceed with the removal of the open order. Click No to cancel the removal.

Purge Open Orders By Date
1. In the Home tab Orders area click on the Options drop down arrow.(Outlined in the image below)
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2. Click the Purge Open Orders Created Before option.

3. In Created Before use the calendar
tool to select your date. All open orders
before this date will be removed from
the system.

4. Click the Purge drop down menu arrow
and select from Invoices only, Credit
memo only or Invoices and Credit
Memos.

5. Click the Purge button to complete the
removal process.



Chapter 15
Prospects Tab
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15 Prospects Tab
The purpose of the “Prospects” feature is to provide the distributor with a set of tools which can be used by the
distributor and your salespeople to manage and prepare quotes for potential customers. Three new tabs have
been added to your menu to support this feature; Prospects, Manager Setup and Reports. The Prospects
tab is where you will create and maintain your prospects information, guides and eventually convert your
prospects to regular customer accounts. The Manager Setup tab is used to provide administrative access to
managers or salespeople for managing prospects of your website. The Reports tab contains two new reports
created to support prospect management, the “Prospect Listing” and “Prospect Guide”. 

  Orders cannot be placed for prospects and they are not included in your customer listing. Each
prospect has a “Status” associated with them to indicate their current position in the prospect to customer
conversion chain. These statuses are:

Active Initial state indicating that this is an active prospect.

Pending Indicates that this prospect is ready to be converted into a customer.

In Process
Indicates that the conversion to a customer is in process and pending confirmation
from the main system.

Converted Indicates that the prospect has been converted to a customer.

Quote Sent Indicates that the prospect has been sent a quote.

Enabling the Prospects Feature 
First Perform Settings Tab Updates

1. Click the Settings tab.

2. Click the Options button on the left.

3. Go to the General section.

4. Click in the “Current Settings” column to set these options to Yes.

a. Enable “Prospects” feature. Turning this option on will display the “Prospects” and “Reports” tab for
the distributor and designated salespeople in the system.

b. Create prospects for quote requests from the website. Set this option only if you have the website
option and prospects will automatically be created in the system. 

5. Go to the Salesperson assigned to new prospects option.

6. Select a salesperson from the drop down list. This option allows you to assign a default salesperson to
manage the prospects generated from your website. This option is not required for the prospects feature to
work. 
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The General section of Options in the Settings tab.
The current settings and drop down list have been set to enable the Prospects feature.

7. Go to the Salespeople section.

8. Set the Allow salesperson to re-assign prospects option to Yes.

This option controls if a salesperson has permission to transfer a prospect to a different salesperson.
Generally this functionality is only provided to the distributor or a prospect manager. Designating an
employee as a prospect manager will be covered later in this chapter.

 This option has no effect when the “Enable Prospects feature” is set to “No”.

9. Once the modifications to the Settings tab are completed the system will automatically update.

10.  The new Manager Setup, Prospects and Reports tabs will appear in your menu. 

 11. Now the Prospects feature has been enabled in your entrée.NET system.
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15.1 Designating a Prospect Manager
The Manager Setup tab has been added to the distributor’s menu with the Prospects feature to allow for the
creation and maintenance of manager accounts. These manager accounts can be assigned specific
administrative roles in the entrée.NET system. Currently the two roles supported are:

Manage
Website

Allows the account to access and modify content in the “Website” section.

Manage
Prospects

Allows the account to access and modify content related to the “Prospects” feature.

If you would like to create a Prospect Manager to assist with or oversee the processing of prospects for your

company proceed to the Manager Setup Tab chapter for the details. 

Prospects Tab Overview
The Prospects tab is where prospect accounts are created, edited, deleted and converted to customer
accounts by the designated prospects manager or salespeople. If you have the website option prospect
accounts will be created automatically via the website when a potential customer uses the “Request Quote”
feature in the Catalog page. 

The rules for editing a prospect account are slightly different for the managers. The salesperson is allowed to
edit one “guide” for a prospect to use for quoting prices. 
The prospect guide is very similar to the Order Guide feature provided in the system for customers. The prices
in the prospect guide can be edited as required by your salespeople. 

When a prospect is ready to become a real customer the salesperson will check the “Ready to Convert” check
box and the status of the prospect will be set to the “Pending”.
Salespeople will not be allowed to make any additional changes to the prospect at this time. Only the
prospects manager can continue to change the prospect information and prospect guide until it has been
converted to a customer.

Prospects Tab Screen Details 
· Create Customer button - Click to initiate the conversion of the prospect account to a customer account.

· Create Prospect button – Click to create a new prospect account.

· Edit / View Prospect button – Click to edit or view a prospect account.

· Delete Prospect button – Click to delete a selected prospect account.

· Filter – A drop down list of the status values or “All” used to filter the prospect accounts list. 

· Search Mode - Select either “Match” or “Contains”. 
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· Search box - Type a word or letters here then click the search icon  to get your results.

· First column – contains the icons for Edit / View Prospect,    Delete Prospect    and View

Prospect Guide  functions.

· Prospect # – The prospect number assigned by the system when the account is created. 

· Status – The current status of the prospect account. 
      Possible values are: “Active”, “Pending”, “In Process” or “Converted”. 
      This value is controlled by the system. 

· Sales # - The number of the salesperson assigned to the prospect.

· Company – The name of the prospect seeking price quotes.

· Contact – The prospect contact person’s name.

· Address 1 - The street address information for the company.

· Address 2 – The 2nd line of the street address information for the company.

· City - The city where the prospects office is located.

· State - The state information for the prospect.

· Phone - The prospects phone number.

· Fax - The prospects fax number.
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15.2 Adding New Prospects to entrée.NET
There are two ways prospects are added to entrée.NET: manually by using the Prospects tab.  Or if you have
the website option prospects are automatically created in the system by turning on the “Create prospects for
quote requests from the website.” option. To manually create a new prospect account in the Prospects tab:

1. Click the Prospects tab. 

2. Click the Create Prospect button.

3. The Create New Prospect dialog box will display.

4. Fill in your prospect’s Address information.

5. Fill in the Contact information.

6. In the Options section make selections for:

a. Price Level from the drop down list.
b. Salesperson from the drop down list.
c. Ready to Convert will only be checked when the prospect is ready to be converted to a customer 

account.

7. Notes – Enter any notes about the prospect in the section provided to assist in your work with them.

8. Click Save.

 The Creation and Updated fields in the upper right corner are undefined.
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New Prospect Accounts from your entrée.NET Website
When the website creates a prospect account automatically from the Request Quote process emails are sent
to you. The Request Quote process will send out email notifications as documented in the chapter on that
topic in this guide. As a part of the Prospects feature a “new prospect notification” email will also be sent as a
part of the Request Quote process. Examples of the emails notification and the list of accounts in the
Prospects tab after the website has processed the quote request are shown below.

  It is important to regularly monitor your emails for notifications from your website. 

Once the prospect account is listed in the Prospects tab follow steps 6 – 8 in the Adding New Prospects to
entrée.NET procedure above. You will need to update Price Level and Salesperson. The Notes section will
contain the notes from the email notification as shown below. 
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15.3 Edit / View Prospects
Once the prospect account has been created to manage the prospect use the tools in the Prospects tab.
During the process of working with your prospects you will need to view, update their information, provide
additional notes or create a prospect guide. The process to create prospect guides will be covered next in this
chapter. To update your prospect accounts follow this procedure:

1. Click the Prospects tab. 

2. Select and highlight the prospect account in the list.
3. Click the Edit / View Prospect button or the Edit / View   icon. 

4. The Prospect dialog box will display with the Company name and their assigned Prospect # in the upper
left corner of the dialog box.

5. Edit the prospect’s Address information as required.

6. Edit the Contact information as required.

7. In the Options section make modifications as required for:
a. Price Level from the drop down list.
b. Salesperson from the drop down list.
c. Ready to Convert will only be checked when the prospect is ready to be converted to a customer

account.

8. Notes – Enter any additional notes about the prospect account to assist in your work with them.

9. Click Save.

 The Creation and Updated fields in the upper right corner will be updated when the prospect
account has been changed.
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15.4 Deleting Prospects
To remove prospect accounts from the Prospects tab follow these steps:

1. Click the Prospects tab.
 
2. Select and highlight the prospect account in the list.

3. In the left column click the Delete icon  or click the Delete Prospect button in the menu bar. 

4. The Delete Prospect confirmation dialog box will be displayed. 

5. Click Yes.

15.5 Prospect Guides
Prospect Guides are similar to the Order Guides you can create for customers. When you want to provide a
price quote to a prospect you can create a prospect guide in the Prospects tab. A salesperson is allowed to
edit one “guide” per prospect. The prices in the prospect guide can be edited by using the same method
currently used for customer orders in the shopping cart and in the other screens used to add items to orders. 

 Prices in the prospect guide are calculated using the price level assigned to the prospect. The
price level is set during the process of creating the prospect. Price levels can be adjusted in the Edit / View
Prospect dialog by selecting a new price level from the drop down list. 

Prospects Guide screen details:

§ Add Item button - Click to add a new item to the guide list.
§ Remove Selected button - Click to delete the selected item.
§ Add Category button - Click to create a new category for the guide list.
§ Re-Apply Sort button - Click to re-apply the previous sort.
§ Save Guide button - Click to save the current information in the prospect’s guide.
§ Cancel button - Click to delete the current prospect guide.
§ Company and Prospect #
§ Green plus tool column
§ Seq – The system Sequence number.
§ Category – The product category.
§ Unit Price – The unit price is an editable field in the prospect guide.
§ Item # - The item number from the product catalog.
§ Description –Click the blue description link to view the product information.
§ Class – The item class.
§ Brand – The item brand.
§ Pack Size – The pack size for the item.
§ Unit - The unit the item is sold by.
§ Weight – The weight of the item.  

 Item weight with a red asterisk * is the average weight. 



Prospects Tab 204

Creating a Prospect Guide
1. Click the Prospects tab. 

2. Select and highlight the prospect account who will receive the prospect guide.
3. Click the View Prospect Guide   icon.

4. The Prospect Guide screen will display with the Company name and their assigned Prospect # in the
upper right section of the menu.

The blue Unit Price is an editable field in the Prospect Guide screen.

5. Click the Add Item button to search for and add items to the prospect guide. 

6. The Item Search dialog box will display.

7. Make a selection from the Search drop down list. You
can search by Item Description, Class or Item
Number.

8. Type a word, class or item number in the search box.

9. Click the Search button. 

10.  When the search results are displayed, click the blue Description link to view the product information.

11.  Click the green plus icon to add the item to your prospect guide list.

12.  Continue the search and add item process until all the desired items are in the prospect guide.

13.  Now you can edit the Unit Price for the selected items. 

14.  Click the Save Guide button. 

 You should save your guide after making any changes.
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Above: A search of Item Descriptions for “beef”. 
Below:  A beef item added to the Prospect Guide screen.

Working with Prospect Guides
Once you have created your Prospect Guide if you need to make changes. These functions are available
when you are in the Prospect Guide screen:

· Remove Selected 
1. Select and highlight the item to be removed from the Prospect Guide.
2. Click the Remove Selected button. The Remove Item confirmation box will display using the Item

Number not the Description field. 
3. Click Yes. 

· Add Category
1. Click the Add Category button to add a new Category to the current Prospect Guide.
2. The Add New Category dialog box will display. 
3. Type the name for the new category in the box and click OK.
4. Now you can add items to this new category in your prospect guide.

· Re-Apply Sort
Some column heading can be used to sort items within category in your prospect guide list in ascending
or descending order. These columns are: Item #, Description, Class, Brand, Pack Size, and Unit. 

1. Click the column heading and a sort direction arrow will appear.
2. Click the arrow again to change the direction of the sort.
3. Click the Re-Apply Sort button to re-apply the previous sort.

· Cancel
1. Click the Cancel button.
2. The current Prospect Guide will be deleted. 
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15.6 Converting Prospects into Customers
1. Click the Prospects tab. 

2. Select and highlight the prospect account who will be converted to a new customer account.

3. Click the Create Customer button.

4. The Create Customer From Prospect dialog box will display. 

5. Displayed in the first line is “Create customer from “Company”” with the selected prospect company
name. If this is not the correct prospect account click Cancel here.

6. In the box for Customer = you will assign the new customer’s entrée Customer #. 

7. Click the check boxes to select these options: 
a. Create “Standard Order” in entrée from items in the prospects order guide.
b. Import prices from prospects order guide as the customers “Special price”.

1. Click the Convert
button.

9.  Now the Prospects tab will display a Status of “In Process” for prospect account.

10.  Click Sign Out to close entrée.NET. Next Login to your main entrée system.

11.  To start the import of prospects and the creation of your new customer accounts follow these instructions
for your version of entrée.

entrée V3  - Go to Invoicing > select the
entrée.NEToption > select Import prospects.  

entrée V4SQL - Go to the Add-Ons ribbon
menu > select the entrée.NET drop down
menu > select Import prospects. 
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12. The Prospect Import progress bar displays. When the import is completed you will be prompted to print or
save a report. This is an example of the report. 

15.7 Prospects Email Templates
New email templates have been added to support the Prospects feature. These new templates can be
accessed and updated for your company once you have implemented the Prospects feature. 

Go to the Settings tab > Email button and select the templates you wish to customize.  Please review the
entrée.NET Settings chapter of this guide for more detailed information about email templates.

Templates under “Administrative” are used for emails sent
to distributor or prospect managers.

Templates under “Customer” are used for emails sent to
customers.

Templates under “Salesperson” are used for emails sent to
your salespeople.



Chapter 16
Request Quote
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16 Request Quote
The new Request Quote feature in entrée.NET has provided an easy way for visitors to your website to
communicate with you for product quotes. There are occasions when a current customer or a prospective
customer would like to get a quote on items in your catalog. Once the visitor to your website completes this
simple process to request a quote, an email will be sent to you with all the customer information and a list of
the items where quotes have been requested.

How to Request a Quote
1. Click on the Catalog link in the website menu.

2. In the Browsing Product Classes section of the page select a Product Class.

3. In the Browsing Product Class: class page the item numbers, a Description link, Brand, Pack Size and
Unit Meas. are listed for each item in the selected class.

4. Click the Request Quote button to add the item to your quote request cart.
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5. The item will be added to the Request Quote cart. All the items in this cart will be displayed on the
Request Quote cart page. Each item in the list has an Update Item and Remove Item button. 

a. Enter information in the Current Price Paid and Estimated Weekly Qty fields.

b. To request a quote on another item click the Go Back To The Catalog button at the bottom of the page
and repeat the process for the next item. 

c. Once you have added an item to the Request Quote cart use the Edit/Submit Quote button under the
Catalog header to return to the cart.

d. If all the items requiring quotes are in the cart then click the Submit Quote Now button and proceed to
the Request Quote email form.
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6. Fill in the Request Quote email
form. 

7. If you are not a current customer
skip the Customer Number field.

8. In the text box labeled “Enter the
code shown above” at the
bottom of the form type the code.

9. Click Send Request. An email
will be sent to the email address
you provided to confirm your
request. 

The distributor will be sent an
email with the Request Quote
information the customer
provided. 

10.  The Request Quote process is completed when the thank you message is displayed on the website.
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· This is an example of the email that will be sent from the Request Quote process.



Chapter 17
Manager Setup Tab
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17 Manager Setup Tab

Designating Prospect / Website Managers 
The Manager Setup tab has been added to the distributor’s menu to allow for the creation and maintenance of
manager accounts. These manager accounts can be assigned specific administrative roles in the entrée.NET
system. The process of approving a prospect to be converted into a customer can only be performed by the
distributor or a prospects manager. Currently the two roles supported are:

Manage
Website

Allows the account to access and modify content in the “Website” section.

Manage
Prospects

Allows the account to access and modify content related to the “Prospects” feature.

 The account setup process will allow you to change an account Username. This authorization

has also been provided to salespeople who have been given the ability to create accounts for customers.

The Manager Setup tab with a new manager account.

Manager Setup Screen Details

· Create Account - Click to create a new manager account.

· Edit Account – Click to edit an existing manager account.

· Delete Account – Click to delete a selected manager account.

· Search Mode - Select either “Match” or “Contains”. 

· Search box - Type a word or letters here then click the search icon  to get your results.

· First column – contains the icons for the Edit and Delete functions.

· Username – The username assigned when the account was created.

· Status – Values are “Enabled” or “Disabled”. This value is controlled by the System Administrator. 

· Email – The account contact person’s email address.
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Creating Manager Accounts
If you decide to designate an employee as a “Prospects Manager” or “Website Manager” you will need to
create a manager account for them in the Manager Setup tab.  Follow these steps to create the new manager
account:

1. Click the Manager Setup tab.

2. Click the Create Account button. 

3. The Create New Manager Account dialog box will display.

4. Enter information for: 

a. Username – create a new username for the
manager.

b. Password – create a password.

c. Email – current email address.

d. Disabled – Can be used later to disable the
account if needed.

5. For the Select roles for this account: section check boxes to designate the role for the new manager
account.

a. Manage Website

b. Manage Prospects

6. Click Save.

7. The new manager account will now be listed in the Manager Setup screen
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Edit / Disable / Delete Manager Accounts
Now that you have designated a “Prospects Manager” and / or a “Website Manager” if you need to make
changes or remove the account completely you will use the Manager Setup tab.  

· Editing a manager account – 

1. Click and highlight the manager account in the list to select it. 

2. Click the Edit Account button or the Edit Account icon in the leftmost column.

3. Make your changes in the Edit Manager Account dialog box.

4. This Disabled check box for the manager account can be updated here. 

5. Click Save.

· Deleting a Manager Account 
1. Click and highlight the manager account in the list to select it. 

2. Click the Delete Account button or the Delete Account icon in the leftmost column.

3. Click Yes in the Delete Accounts? confirmation dialog box.
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18 Reports Tab
The easy to use Reports tab allows you to obtain important information about the status and numbers of
prospects, salesperson assignments and prospect guides for price quotes in entrée.NET. You have complete
control to customize and save the style of reports you prefer. You can access your reports via the main reports
page link list or use the Select a report  drop down menu. This drop down menu is available to you in all of
your report generating and configuration pages.

The reports currently provided are:
· Prospect Listing  
· Prospect Guide
· Customer Account Listing
  

You select which columns you would like to see and in what order, choose filters, and select how the reports
sort, subtotal and group. 

When you select the Reports tab you will  be presented with a list of the available reports and a short
description. You can access your reports via the main reports page link list or use the Select a report  drop
down menu. This drop down menu is available to you in all of your report generating and configuration pages.

Customizing Your Reports
The information displayed in your reports can be customized to suit your business requirements. You can
create and save custom report configurations geared to your reporting style to make running periodic reports
your way an easy and convenient process. 

About Custom Report Generation 
· Select a report using the drop down list and a saved custom report style from the Configuration drop

down list.

· For the Prospect Guide report in the
General section use the Prospect drop
down list to select the desired prospect.

· Select your Prospect from the drop down
list to run the Prospect Guide report.



entrée.NET Administrator's System Guide219

· Each report has an Available Columns list and Active Columns list.  Move columns to the Active
Columns list to be   used in the final report. Use the tool, filters and sort options described below to further
customize your report.

The Prospect List report Available Columns list and Active Columns list is shown below. 

Customer Account Listing Report Options
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· Tools for column selection and customization
Up and Down arrows to move a field and reorder the Active Columns list. 
Click the field in the list and click the up or down arrow until the location is set.

Plus and Minus buttons to add or delete fields from the Active Columns list.
Click on a field then click the plus or minus button to update your list.
You can also drag and drop report columns using your mouse.

Prospect Guide report Available Columns list and Active Columns list. 

· Filters: 
Reports can be filtered by Prospect # or by the Salesperson assigned to the prospect. The Prospect
Selection and Salesperson Selection dialog boxes will display the current options when you  click the

search icon.   Examples are shown below.
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Prospect List report Filters. 

·  Sort, Subtotal and Grouping Options:

§ Primary Sort and/or Secondary
Sort fields

§ Direction - Sort in ascending or
descending order. 

§ Group - Check the box to group
by the Primary Sort field.

Prospect Guide report’s Sort, Subtotal and Grouping
Options.
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How to Save a Custom Report Configuration
1. Create your customized report configuration using the column manipulation information detailed above.

2. Then type a name in the box next to Save Configuration at the bottom of the screen.

3. Click the Save Configuration button. 

4. The configuration name will now appear in the Configuration drop down list for that report in your Reports
page.

Format Options
You can specify how your report should be generated using the
“Format” drop down list in the bottom right section of the
Reports screen.

· When report format Browser Window is selected a new
browser window will open to display the report. If you would
like to print the browser report, right click in the report page
and select print from the browser menu.

· When report format PDF (portrait or landscape) is selected a new tab will open in   your browser to display
the PDF report. Use the icons in the Adobe Reader tool bar of the window to save a copy on your
computer, print or email the report.

· When report format Excel (97 or 2007) is selected a new tab will open in your browser.

§ If you do not have the Excel software loaded on your computer you will need the Excel Reader.
Click the link provided on the page to download the Excel Reader before proceeding.

§ The Excel report link will appear in the lower right corner of your browser window. 

§ Click the link and the report will open in the Excel Reader.

§ Use the Excel menu to print the report and save a copy on your computer.

· Once the report configuration and format is set, click Run Report.  
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18.1 Report Samples

Reports to Manage Prospects
· Prospect Listing Report
Displayed is an example of the Prospect Listing in the Browser report format. This example of a Prospect
Listing report is sorted by Prospect No. and includes the City and State for each prospect. This report was
generated by using the saved report configuration “City-State”. 

 By checking the Converted Date column you see that some prospects have not been converted
to customers yet.

· Prospect Guide Report
When you create prospect guides you can print each prospect’s guide individually using this report. This
example of a Prospect Guide report is sorted by Item Number and includes Unit Price.

· Customer Account Listing Report
In this report you can configure it so you can see the last date and time the account was logged into.
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19 Tips for Obtaining Product Images

Sources for Product Images in entrée.NET
Customers like to see what they are buying and using images in your catalog will make it more visually
appealing to customers visiting your website. If you would like to add images to your inventory items in the
main entrée system that will display in your entrée.NET product catalog and specials you have a few options.
Images can be found in your entrée system, using search engines and websites on the internet, in product
manufacturer’s websites or take your own pictures of products in your warehouse.

entrée V4 SQL 
In the entrée V4 SQL system you have the ability to assign an image to an item, class, brand and customers.
Images of the products that are being sold can be viewed while invoicing or displayed on a price list report that
is sent to one of your customers.

Here you see the images section of the Inventory screen with the item image right-click menu options.
 

· Use the Brand, Manufacturer and Class options in the Inventory ribbon menu to manage those images.
· Use the Customer option in the Customer ribbon menu to manage their images.
 
The imaging system in entrée V4 stores the actual images within database files. Images that are assigned to
customers, brands, manufacturers and items can be uploaded to entrée.NET.

Although images of any resolution are supported, it is recommended to use 640x480 resolution to save hard
disk space and the amount of time it takes to upload the images to the entrée.NET.

· To assign an image to an item when the image is not assigned yet.
 
1. Right-click in the item image box to open the Right-Click for Options menu.
2. Make a selection from these options to add or replace an image: Import Image from File, Search the

Web and Use an existing image. Follow the steps for each process below.
3. Run the Export to entrée.NET and the item will display the images in the website.
 

· Import Image from file

1. If you select Import Image from File the dialog will open.
2. On your computer or network find the image file and select the saved image.
3. Click Open.  
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4. The Image Preview screen will display where you can confirm the import of the image for the item, brand,
class, or customer. 5. Click the OK button to confirm the image assignment.
6. Click Apply in the Inventory screen to save the image on the item.
7. Run the Export to entrée.NET

· Search the Web

Use the Search the Web option when you choose to search the Internet for images that can be associated
with your inventory items. You can search by Brand and/or Description and/or UPC or use the “Limit search to”
option.

1. When you select the Search the Web option the Internet Image Search dialog will run an initial internet
search using the item's Brand and Description. These search results will be displayed when the dialog
opens for the first time.

2. Search results are displayed so you can page through using the Next and Previous buttons.

3. If no desired images are found or you encounter a message like "This image could not be downloaded
from the source server. Please try another image." make another image selection or search again using
different search options.

4. Click the image to selected it and the Image Preview dialog box will display.

5. Click the Select button in  the Image Preview dialog to download the image.

6. Click the Apply button. 

7. Run the Export to entrée.NET

· Use an existing image

In the event that you already have an image saved in the system that you want to use for the items, like when
you create case and piece items for a product, you can use this option.

1. When you right-click on the item image area and select the Use an existing image option the
ImageSelectFrom dialog opens.
2. Scroll through the database of existing images and select an image. The selected image will display in the
Preview Area on the right.
3. Click the OK button and the item image will update.
4. Click the Apply button to save the image. 
5. Run the Export to entrée.NET

·  For more information about image assignment go to the entrée V4 SQL KnowledgeBase Inventory File
Item Information area topic.

http://www.necs.com/eV4SQL_KB/
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entrée V3 
Wherever you find your product images you will be saving these image files in a folder on your computer. Then
by using the Inventory Maintenance Misc2 tab in the main entrée V3 system you will assign images to
inventory items. For more information about image file installation and image assignment see the “Installing the
Image Files” and “Assigning Images” chapters in the entrée V3 Knowledgebase in our website.

Assigning V3 System Images
Your first option is to use the stock item images installed with your entrée V3 system. These image files are
ready for you to assign to your inventory items. Note that these images are not specific to a manufacturer,
brand or product line. If you want am image of a particular brand item you will have to use one of the other
sources described later in this chapter for those images. The stock images are located in the C:\necs\images
folder on your computer and were installed with your entrée V3 system software. 

· Follow these steps to assign images for items in the Inventory File Maintenance Misc2 tab in entrée
V3. 

1. Log in to the main entrée system and use menu path: File > Inventory Maintenance.

2. Click the magnifying glass to find the item.

3. Click the “Click to define Item Image” link (outlined in red in the image below).

4. The Select Image dialog box will display. 

a. If you installed the image files during your entrée system installation process you will be able to scroll
through the stock images list to find an image. Select the image and click OK. Then click OK in the
Misc2 tab.

b. If you have images you found on the Internet or created with a camera and saved in a folder on your
computer follow this procedure to import images:

i. In Select Image click the Import button.

http://www.necs.com/knowledgebase/
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ii. The Import Image dialog box displays. Select Item from Image Type, and then click the
“Click to define” link. 

iii. The Load Image dialog box displays. Now locate the folder and select the desired image file
and click Open.

iv. The image will display in the Import Image dialog box. 

v. In the Select Image dialog box click OK. 

5. Then you will return to the Misc2 tab click OK. 

6. The next time you run the Export to entrée.NET the item will have the image for display.

7. If you want item images to display in entrée.NET check that option in the Settings tab > Options >
General section that “Display item images” is set to Yes. 
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19.1 Finding Product Images
In the previous example a generic image of ketchup was used for the item image. In the event that you would
like to show the actual product image and brand label you will have to 
explore one of these other options; using a search engine on the internet to find an image that does not violate
a copyright, visit the product manufacturer’s website or take your own pictures of the product. We have
included a section at the end of this chapter on Copyright Law Basics with a link to more information about the
topic. 

Please refer to these links before you search for your product images:  
 

§ Google Features Usage Rights -  http://www.google.com/support/websearch/bin/answer.py?
hl=en&answer=29508

§ Google Advances Image Search - http://images.google.com/advanced_image_search 

§ Find Creative Commons images with Google Image Search -
     http://googleblog.blogspot.com/2009/07/find-creative-commons-images-with-image.html

§ Creative Commons.org – Use this site to find licensed works http://creativecommons.org/ 

Using Google Images Advanced Search
· Google Images Copyright and Image use Permissions 
The images displayed in a Google Image Search may be protected by copyright, so we can't grant you the
right to use them for any purpose other than viewing them on the web. If you'd like to use images from an
image search, we suggest contacting the site's webmaster to obtain permission and use the Usage Rights
filtering feature in an Advanced Image Search. 

· How to find product images using Google Images
1. Use your Internet browser and go to images.google.com. 

2. Type what product you are searching for in the Search Images text box. 

For this example we used Heinz ketchup to find a brand name image instead of the stock ketchup image used
previously in this chapter. As you can see in the image below a list of possible search topics will be presented.
You can make a selection from this list. 

3. Click the Advanced Image Search link on the right. The advanced image search page will be displayed.
For better search results try these options in Advanced Image Search: 

§ Find results - This field will be populated with the search text entered above.

http://www.google.com/support/websearch/bin/answer.py?hl=en&answer=29508
http://www.google.com/support/websearch/bin/answer.py?hl=en&answer=29508
http://images.google.com/advanced_image_search
http://googleblog.blogspot.com/2009/07/find-creative-commons-images-with-image.html
http://creativecommons.org/
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§ Content types – Select photo content.
§ Size – You can select any size you like but the final image used must be edited to 640 x 480 or less for

upload.
§ Coloration – Select full color.
§ Usage Rights - Select one of the following options from the drop down list:

· Labeled for commercial reuse  
· Labeled for commercial reuse with modification  

 
4. Click the Google Search button to get your search results.

Search results for images of Heinz ketchup.
Top: Usage Rights set to Labeled for commercial reuse. 
Bottom: Usage Rights set to Labeled for commercial reuse with modification.

5. Click on the desired image format link. For example the Heinz ketchup 57 varieties jpg link. Note the
image’s size because you will need to resize any large images to 640 x 480 for use in your system. The
image will open in your browser. 

6. Right click on the image and select Save Picture As from the options list.
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7. The Save Picture dialog box displays. Select the folder on your computer where you will store your product
image files. 

8.  Click Save. 

9.  Then follow the instructions in step 4 of the Assigning entrée System Images section above to import
and assign the image to an item in entrée.

Source: http://w w w .google.com/support/w ebsearch

Visiting the Product Manufacturer’s Website for Images
Frequently major manufacturers have images available in their websites for the media and businesses to use
without any cost. There are usually restrictions about how the images are used and modifications of these
images are typically not allowed. Follow these tips to find those manufacturer’s images.

1. Select a product check the label for the website information or use a search engine to find the website.

2. Once in the web site look for these keywords like these in their website menu; Press Room, Public
Relations, Media, Images, Media Downloads, Image Library, Multimedia Assets.

3.   In our ketchup
example we went
the manufacturer’s
website and found
their Press Room
Media Assets page
with a collection of
images.   

4. Follow any download instructions on the website. Be sure to take note any information about copyright and
instructions on the reuse of these images.

If there are no instructions on the website:

§ Click on the desired image format link. For example the Ketchup Bottle jpg link in the center of the
Heinz ketchup image. The image will open in the browser. 

§ Right click on the image and select Save Picture As from the options list.
§ The Save Picture dialog box displays.
§ Select the folder on your computer where you will store your product image files. 
§ Click Save. 

5. Then follow the instructions in step 4 of the Assigning entrée System Images section above to import and
assign the image to an item in entrée.

 It is your responsibility to make sure you do not violate the manufacturer’s
copyright.
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19.2 Taking Your Own Pictures
Using a digital camera you can take pictures of the products in your warehouse that can be imported into the
entrée system. When you take your own pictures you own the images and can control what is in the picture
uploaded for a product.  

 Although images of any resolution are supported, it is recommended to use 640 x 480 resolution to save hard
disk space and cut down on the amount of time it takes to upload the images to your entrée.NET system.

1. Create a folder on your computer called “Product Images”.

2. Once you have taken product pictures with your digital camera drag and drop or copy the image files from
your camera SD card to your Product Images folder. 

3. Now you need to edit the images in whatever photo editing software you have on your computer. Try to crop
the picture so only the product is in the image. Be sure to resize images to 640x480.

4. Save the edited image files with a descriptive name, for example; Heinz ketchup bottle or Heinz ketchup
packets. This way it will be easy to match the images with your items.

5. Then follow the instructions in step 4 of the Assigning entrée System Images section above to import and
assign the images to an item in entrée.

6. The next time you run the Export to entrée.NET the item will have an image for display.

If you want item images to display in entrée.NET check that in the .NET system the Settings
tab > Options > General section that “Display item images” is set to Yes.



Index 234

Index
- A -
About Tab     8

Administrator    

About Tab     8

Advanced Options     110

Customer Restricted Items Feature in entrée V3 &
V4     147

Enabling Customer Promotions     148

entrée.Net Scheduler in entrée V3 & V4     122

Exclude item option     110

Export mode     110

Help Tab     8

Importing Orders / Prospects in entrée V3 & V4    
120

Installing entrée.NET     8

Item Promotions Feature in entrée V3 & V4     148

Password Change     30

Scheduler/ Data Export / Order Import     110

Support for Matrix Code Pricing     110

Support for Special Order Items in entrée V3 & V4
    110

User Mail Accounts     128

Webmail     128

Administrator Ads Settings    

Banner Ads     55

Posting Advertisements     55

Administrator Customer Password    

automatic password reset process     137

Forgotten Password     137

Reset Password     137

View Password     137

Administrator Customer Setup Tab    

Accounts     137

email     137

Login     137

Options     137

Passwords     137

Registration     137

Resend Customer Info Email     137

Administrator Email Accounts     128

Administrator Email Settings    

Administrative emails     61

Customer emails     61

Email Templates     61

Salesperson emails     61

Administrator entrée V3 & V4 Options    

Automatic Order Import Consolidation Feature    
13

Customer File Options     13

Inventory File Options     13

Option to Include data from Salesperson.     13

Option to Receives data for ALL Salespersons.    
13

Salesperson File options     13

System Options Additional Features     13

Administrator EOP Button    

Electronic Order Pad licenses     66

Administrator General Settings    

Account     30

Company Logo     30

email Notifications     30

Home Page     30

Theme     30

Timezone     30

Website Address Settings     30

Administrator Grids Settings    

Quick Entry     60

Replace Grid Configurations     60

Standard Order     60

Administrator Home Tab    

Generating Sales Graphs     191

Open Order Purge     191

Orders listing with Status     191

Purge Open Orders By Date     191

Administrator Images    

Advanced Searches     226

Assigning images in entrée V3 & V4     226

Finding Product Images     230

Google Advanced Image Search     230

Manufacturer's websites     230

Sources for product images     226

Taking your own pictures     233

Administrator Manager Setup Tab    

Create Manager Account     214

Delete Manager Account     214

Designating Prospect Managers     214

Designating Website Managers     214

Administrator Messages Tab    

Managing Messages     166

Posting New Messages     166

Administrator Options Settings    

Configuration     34



entrée.NET Administrator's System Guide235

Administrator Options Settings    

Defining minimum and maximum for Customers in
entrée V3 & V4     34

Defining minimum and maximum for Items in
entrée V3 & V4     34

DOT     34

EOP     34

General     34

Order Entry     34

Promotions     34

Prospects     34

Salespeople     34

Website     34

Administrator Prospect Guides    

Adding Items     203

Create Guide     203

Edit Guide     203

Sorting Guides     203

Administrator Prospects    

Conversion to Customers     206

Designating a Prospect Manager     198

Email Templates     207

Import into entrée     206

Administrator Prospects Tab    

Adding New Prospects     200

Delete     203

Edit     202

Enabling the Prospects Feature     196

View     202

Administrator Reports    

Customer Account Listing Report     223

Prospect Guide Report     223

Prospect Listing Report     223

Administrator Reports Tab    

Columns     218

Customizing Reports     218

Filters     218

Report  Samples     218

Sorting     218

Administrator Request Quote    

How Customers Request a Quote     209

Administrator Salesperson Setup    

Call List Feature set up in entrée V3 & V4     162

Salesperson's View     162

Using the Call List Feature     162

Administrator Salesperson Setup Tab    

Accounts     153

Call List     153

email     153

Forgotten Password     153

Login     153

Options     153

Password     153

Price Modification Option     153

Administrator Settings Tab     30

Administrator Specials Tab    

Editing     185

Emailing specials     185

Images     185

What customers see     185

Administrator Website Tab    

Adding Images     81

Adding Social Network Feeds     101

Adding Social Network links     99

Banner Editor     97

BG button     103

Blog Feature     83

Clearing the Browser Cache in IE, Chrome,
Mozilla     97

Contact List     106

Email List button     105

Facebook     101

Featured Brands     83

Featured Item     83

Link to Uploaded Document     95

News Block     83

Search Engine Optimization     80

Settings     68

Show Price Level 1 Sale Items     95

Social Button     99, 101

Specials Options     95

Twitter     101

Updating Block Content     83

Updating Website Content     72

website backgrounds     103

Website Colors     94

What is a username     99

Ads Options     55

Automatic Order Import Consolidation Feature    

Change Invoice & Revisions     13

Customer File  Miscellaneous Tab - Allow
automatic order consolidation option     23

Customer Order Confirmation     13

entrée Additional Features Order Import
Consolidation configuration     24

Examples     13

Handling Customer P.O. Numbers     13

Invoice Selection Process     13



Index 236

Automatic Order Import Consolidation Feature    

Order Consolidation Rules     13

Overview and how to     13

Rules for Merging Line Items     13

- B -
Blog Feature    

Add new blog entry     83

Delete     83

Edit     83

Email blog entry to customers     83

- C -
Call List Feature    

Set up in entrée V3 & V4     162

Using the Call List Feature     162

Customer    

Billing Address     137

Configuration     137

Grids     137

Options     137

Passwords     137

Register link     137

Setup     137

Shipping Address     137

Customer File    

Exclude from .NET Export     23

Export Scanned Invoices to .NET     23

Miscellaneous Tab - Allow automatic order
consolidation option     23

- E -
Edit Special Pricing feature    

Electronic Order Pad - #120 Edit Special Pricing
feature option.     34

Electronic Order Pad    

#120 Edit Special Pricing feature option     34

EOP licenses     66

System options for EOP     34

Email Accounts     128

Email List    

Using third party mailing lists with your website    
105

Email Options     61

entrée    

Additional Features entrée.NET Options
Configuration     24

Additional Features Order Import Consolidation
configuration     24

Allow item to be sold at $0.00     13, 21

Automatic Order Import Consolidation Feature    
13

Customer File Options     13

Customer File Options Miscellaneous Tab - Allow
automatic order consolidation     23

Enable .NET Min / Max Quantity Warning     13,
21

Exclude from .NET Export     23

Exclude item from export     13, 21

Exclude item from public website catalog     13,
21

Export Scanned Invoices to .NET     23

Inventory .NET Tab Options     13

Inventory File Options     13, 21

Item Tags     13, 21

Option to Include data from Salesperson.     20

Option to Receives data for ALL Salespersons.    
20

Restricted Item     13, 21

Salesperson File NET/EOP options     20

Salesperson/Broker File options     13

Setting entrée Options     13

System Options Additional Features     13

System Options impacting entrée.NET /EOP    
24

entrée Options    

Exclude / Restrict Item options in entrée V3 & V4
    110

Item Tags & Order Entry options in entrée V3 &
V4     110

entrée.MW    

There are system options for entrée.MW only:
options #121 - 126.     34

entrée.NET    

Installation     8

Internet Browsers     8

KnowledgeBase     8

System Requirements     8

entrée.NET Options    

Offline Order Entry Mode options     34

entrée.NET Scheduler     122

entrée.NET Settings     30

Export Options    

entrée Customer File Miscellaneous Tab     23



entrée.NET Administrator's System Guide237

- F -
Featured Brands     83

Featured Item     83

- G -
Grids Options     60

- H -
Home Tab    

Open Order Purge     191

Purge Open Orders By Date     191

- I -
Import Options    

entrée Customer File Miscellaneous Tab     23

Importing Orders / Prospects     120

Installation     8

Inventory File    

Allow item to be sold at $0.00     21

Enable .NET Min / Max Quantity Warning     21

Exclude item from export     21

Exclude item from public website catalog     21

Item Tags     21

Restricted Item     21

Item Promotions Feature     148

- L -
Language Translator Service    

Activating the Language Translator Service     170,
171

Cancel Service     170, 183

Catalog     179

Chinese     179

Class     179

Description     179

Italian     179

Language drop down menu     179

Overview     170

Product Information     179

Quick Entry     179

Shopping Cart     179

Spanish     179

Standard Order     179

Translation Data Refresh     170, 175

Translation Examples     170, 179

- M -
Message Setup     166

- N -
News Block     83

- O -
Offline Order Entry Mode    

options     34

Order Import Consolidation    

System Options Additional Features - Automatic
Order Import Consolidation     13

Outlook     128

- P -
Plesk     128

Product Images    

Assigning images in entrée V3 & V4     226

Sources for product images     226

Prospects     196

Purge    

Open Order Purge     191

Purge Open Orders By Date     191

- R -
Report Samples    

Customer Account Listing Report     223

Prospect Guide Report     223

Prospect Listing Report     223

Reports Tab    

Customer Account Listing Report     218

Prospect Guide Report     218

Prospect Listing Report     218

Request Quote     209

Restricted Items Feature     147



Index 238

- S -
Salesperson File    

NET/EOP options     20

Salesperson Setup     153

Scheduler    

entrée.Net Scheduler in entrée V3 & V4     122

Scheduler/Data Export/Order Import     110

Specials Setup     185

System Guide Resources    

Link for entrée.NET KnowledgeBase     8

Links for entrée V3 & V4 KnowledgeBases     8

System Options    

Additional Features - Automatic Order Import
Consolidation     13

entrée Additional Features entrée.NET Options
Configuration     24

entrée Additional Features Order Import
Consolidation configuration     24

System Option #171     24

System Option #180     24

System Options impacting entrée.NET /EOP    
24

- T -
Translation Tab    

Activating the Language Translator Service     171

Cancel Service     183

Overview     170

Translation Data Refresh     175

- W -
Website    

How Website Registration Requests Work     68

Join Our Email List Feature     68

Registration Requests     68

Settings     68

View web page examples     68



©2010 - 2018 NECS, Inc. All Rights Reserved.


	Contact NECS
	License Agreement
	Overview / Installation
	Setting entrée Options
	Automatic Order Import Consolidation Feature
	entrée Salesperson File Options
	entrée Inventory File Options
	entrée Customer File Options
	entrée System Options

	entrée.NET Settings
	Options
	Ads
	Grids
	Email
	EOP

	Website Settings
	Updating Web Page Contents
	Search Engine Optimization
	Adding Photos to Web Pages
	Updating Blocks Content
	Updating Website Colors
	Website Specials
	Website Banner Editor
	Social Networking
	Social Networking Feeds

	Website Backgrounds
	Website Email List
	Contact List

	Scheduler/Data Export/Order Import
	Importing Orders / Prospects
	entrée.NET Scheduler

	Email Account Settings
	Customer Setup
	Restricted Items Feature
	Item Promotions Feature

	Salesperson Setup
	Call List Setup

	Message Setup
	Translation Tab
	Activating the Language Translator Service
	Translation Data Refresh
	Translation Examples
	Translator Service Cancellation

	Specials Setup
	Home Tab
	Prospects Tab
	Designating a Prospect Manager
	Adding New Prospects to entrée.NET
	Edit / View Prospects
	Deleting Prospects
	Prospect Guides
	Converting Prospects into Customers
	Prospects Email Templates

	Request Quote
	Manager Setup Tab
	Reports Tab
	Report Samples

	Tips for Obtaining Product Images
	Finding Product Images
	Taking Your Own Pictures


